Parallels and Parallels logo are registered trademarks; Coherence, Compressor, SmartSelect and Transporter are trademarks of Parallels Software International, Inc.

This product is based on a technology that is the subject matter of a number of pending patent applications.

Distribution of this work or derivative of this work in any form is prohibited unless prior written permission is obtained from the copyright holder.

Microsoft, Windows, Windows Server, Windows NT, Windows Vista, and MS-DOS are registered trademarks of Microsoft Corporation.

Linux is a registered trademark of Linus Torvalds.

Apple, Bonjour, Finder, Mac, Macintosh and Mac OS are trademarks of Apple Inc.

Solaris is a registered trademark of Sun Microsystems, Inc.

eComStation is a trademark of Serenity Systems International. FreeBSD is a registered trademark of The FreeBSD Foundation.

Intel and Intel Core are trademarks or registered trademarks of Intel Corporation.

OS/2 Warp is a registered trademark of International Business Machines Corporation

VMware is a registered trademark of VMware, Inc.

All other marks and names mentioned herein may be trademarks of their respective owners.
Contents

Introduction

     About Parallels Desktop ...............................................................................................................................8
     What's New in This Version ...........................................................................................................................9
     Opening Parallels Desktop Help ...................................................................................................................11
     About This Guide .......................................................................................................................................11

Parallels Desktop Virtual Machine

     Virtual Machine Technology Overview .....................................................................................................13
     Intel Virtualization Technology (VT-x) Support ........................................................................................14
     Virtual Machine Hardware ............................................................................................................................14
     Supported Guest Operating Systems ..........................................................................................................15
     Virtual Machine Files ................................................................................................................................17
     Support of Virtual and Real Disks .................................................................................................................18
     Supported Types of Hard Disks .....................................................................................................................19
     Virtual Hard Disks .........................................................................................................................................19
     Boot Camp Option ......................................................................................................................................20
     CD/DVD Discs and Their Images .................................................................................................................20
     Floppy Disk Images ....................................................................................................................................21

Installing Parallels Desktop

     System Requirements ................................................................................................................................22
     Hardware Requirements .................................................................................................................................23
     Software Requirements .................................................................................................................................23
     Installing Parallels Desktop ..........................................................................................................................24
     Upgrading to Parallels Desktop 3.0 ...............................................................................................................29
     Starting Parallels Desktop ............................................................................................................................29
     Activating Parallels Desktop .........................................................................................................................30
     Updating Parallels Desktop ..........................................................................................................................32
     Automatic Updating ......................................................................................................................................33
     Manual Updating .........................................................................................................................................35
     Uninstalling Parallels Desktop ......................................................................................................................37

Interface Basics

     Main Window ...............................................................................................................................................40
     Select Virtual Machine Dialog ....................................................................................................................41
     Configuration Page .......................................................................................................................................42
     Guest OS Window .........................................................................................................................................44
     Toolbar .........................................................................................................................................................45
     Status Bar .....................................................................................................................................................47
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Editor</td>
<td>48</td>
</tr>
<tr>
<td>Menu</td>
<td>49</td>
</tr>
<tr>
<td>About Parallels Desktop Dialog</td>
<td>50</td>
</tr>
<tr>
<td>More Information</td>
<td>51</td>
</tr>
<tr>
<td>Making Screen Shots</td>
<td>52</td>
</tr>
<tr>
<td>Creating a Virtual Machine</td>
<td>53</td>
</tr>
<tr>
<td>Overview</td>
<td>53</td>
</tr>
<tr>
<td>Typical Configurations</td>
<td>55</td>
</tr>
<tr>
<td>OS Installation Assistant</td>
<td>56</td>
</tr>
<tr>
<td>Installing Guest OS</td>
<td>74</td>
</tr>
<tr>
<td>Installing a Guest Operating System</td>
<td>75</td>
</tr>
<tr>
<td>Upgrading Windows XP to Vista</td>
<td>77</td>
</tr>
<tr>
<td>Installing Windows 98 as a Guest OS</td>
<td>78</td>
</tr>
<tr>
<td>Configuring X Window System in FreeBSD Guest OS</td>
<td>81</td>
</tr>
<tr>
<td>Capturing and Releasing the Keyboard and Mouse Input</td>
<td>83</td>
</tr>
<tr>
<td>Installing Parallels Tools</td>
<td>84</td>
</tr>
<tr>
<td>Parallels Tools Overview</td>
<td>85</td>
</tr>
<tr>
<td>Parallels Tools Available for Different Guest OSes</td>
<td>88</td>
</tr>
<tr>
<td>Installing Parallels Tools in Windows</td>
<td>89</td>
</tr>
<tr>
<td>Installing Parallels Tools in Linux</td>
<td>90</td>
</tr>
<tr>
<td>Windows 98 Tools Installation</td>
<td>90</td>
</tr>
<tr>
<td>Windows NT Tools Installation</td>
<td>92</td>
</tr>
<tr>
<td>OS/2 and eComStation Tools Installation</td>
<td>93</td>
</tr>
<tr>
<td>Solaris Network Driver Installation</td>
<td>95</td>
</tr>
<tr>
<td>Uninstalling Parallels Tools in Windows</td>
<td>96</td>
</tr>
<tr>
<td>Uninstalling Parallels Tools in Linux</td>
<td>97</td>
</tr>
<tr>
<td>Updating Parallels Tools</td>
<td>97</td>
</tr>
<tr>
<td>Running Virtual Machine</td>
<td>99</td>
</tr>
<tr>
<td>Overview</td>
<td>99</td>
</tr>
<tr>
<td>Selecting and Opening a Virtual Machine</td>
<td>100</td>
</tr>
<tr>
<td>Selecting from the Select virtual machine dialog</td>
<td>100</td>
</tr>
<tr>
<td>Using Aliases for Virtual Machines</td>
<td>101</td>
</tr>
<tr>
<td>Starting Favorite Windows Applications from Mac OS X</td>
<td>101</td>
</tr>
<tr>
<td>Opening a Virtual Machine When Another VM Is Running</td>
<td>102</td>
</tr>
<tr>
<td>Starting and Stopping Virtual Machine</td>
<td>102</td>
</tr>
<tr>
<td>Starting a Virtual Machine</td>
<td>102</td>
</tr>
<tr>
<td>Stopping and Resetting a Virtual Machine</td>
<td>104</td>
</tr>
<tr>
<td>Suspending and Resuming a Virtual Machine</td>
<td>105</td>
</tr>
<tr>
<td>Pausing a Virtual Machine</td>
<td>106</td>
</tr>
<tr>
<td>Switching to Full Screen</td>
<td>107</td>
</tr>
<tr>
<td>Switching to Coherence</td>
<td>108</td>
</tr>
<tr>
<td>Running Windows Guest OS</td>
<td>109</td>
</tr>
<tr>
<td>Accelerated 3D-Graphics Support</td>
<td>111</td>
</tr>
<tr>
<td>Customizing View</td>
<td>111</td>
</tr>
<tr>
<td>Main Window Options</td>
<td>112</td>
</tr>
<tr>
<td>Adding New Icon Set for Toolbar Buttons</td>
<td>112</td>
</tr>
<tr>
<td>Coherence View Options</td>
<td>113</td>
</tr>
<tr>
<td>Parallels Tools Center</td>
<td>115</td>
</tr>
<tr>
<td>Stopping and Restarting Parallels Tools Center</td>
<td>115</td>
</tr>
<tr>
<td>Clipboard Synchronization Tool Options</td>
<td>116</td>
</tr>
</tbody>
</table>
## Working with Snapshots and Undo Disks

- Overview of Snapshots ......................................................... 145
- Making a Snapshot ................................................................. 146
- Snapshot Manager ................................................................. 147
- Reverting to the Last Snapshot ............................................ 149
- Working with Undo Disks ....................................................... 150

## Configuring Virtual Machine

- Using Mouse in a Virtual Machine ........................................ 151
- Networking in a Virtual Machine ........................................... 152
  - Shared Networking (NAT) .................................................. 153
  - Bridged Ethernet Networking ........................................... 153
  - Host-Only Networking ...................................................... 154
- Editing Virtual Machine Configuration ................................... 155
  - General Options ............................................................... 156
  - Booting Options ............................................................... 157
  - Advanced Options ........................................................... 158
  - Security Options ............................................................. 160
  - Coherence Options .......................................................... 161
  - Shared Folders Options .................................................... 161
  - Video Options ................................................................. 163
  - Memory Options .............................................................. 165
  - Floppy Options ............................................................... 166
  - Hard Disk Options ........................................................... 168
  - Hard Disk Advanced Options .......................................... 170
  - CD/DVD-ROM Options .................................................... 173

## Working in Coherence Mode

- Overview .................................................................................. 139
- Coherence Mode Options ........................................................ 142

## Contents

- Networking in a Virtual Machine ........................................... 152
- Using Mouse in a Virtual Machine ........................................... 151
- Networking in a Virtual Machine ........................................... 152
- Shared Networking (NAT) ...................................................... 153
- Bridged Ethernet Networking ................................................ 153
- Host-Only Networking ........................................................... 154
- Editing Virtual Machine Configuration .................................... 155
- Coherence Mode Options ........................................................ 142
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compression in Automatic Mode</td>
<td>241</td>
</tr>
<tr>
<td>Parallels Compressor Wizard</td>
<td>244</td>
</tr>
<tr>
<td>Further Reducing the Disk</td>
<td>249</td>
</tr>
<tr>
<td><strong>Using Boot Camp Windows Partition</strong></td>
<td>250</td>
</tr>
<tr>
<td>Overview</td>
<td>251</td>
</tr>
<tr>
<td>Creating a Virtual Machine for Boot Camp</td>
<td>252</td>
</tr>
<tr>
<td>Booting via Parallels Virtual Machine</td>
<td>254</td>
</tr>
<tr>
<td>Booting via Boot Camp</td>
<td>255</td>
</tr>
<tr>
<td><strong>Using Parallels Transporter</strong></td>
<td>256</td>
</tr>
<tr>
<td>Migration Scenarios</td>
<td>257</td>
</tr>
<tr>
<td>Setting up the Environment</td>
<td>258</td>
</tr>
<tr>
<td><strong>Troubleshooting and Limitations</strong></td>
<td>259</td>
</tr>
<tr>
<td>Getting Technical Support</td>
<td>259</td>
</tr>
<tr>
<td>Reporting a Problem to Parallels Team</td>
<td>260</td>
</tr>
<tr>
<td>Installing Ubuntu Linux 6.0.6 Server</td>
<td>261</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>263</td>
</tr>
</tbody>
</table>
CHAPTER 1

Introduction

This chapter provides general information on technologies used by Parallels® Desktop and presents the basic characteristics of a virtual machine created by Parallels Desktop.

In This Chapter

About Parallels Desktop .......................................................................................................................... 8
What's New in This Version .................................................................................................................... 9
Opening Parallels Desktop Help ............................................................................................................ 11
About This Guide .................................................................................................................................. 11

About Parallels Desktop

Parallels® Desktop is a powerful, easy-to-use software that lets you run Windows® and other operating systems together with their applications in fast and secure virtual machines side-by-side with Mac OS® X on Intel®-based Macintosh® computers.

Parallels Desktop is powered by a lightweight hypervisor, a thin layer of software that "works" between the host computer’s hardware and Mac OS X. This results in dramatically more stable, more secure, and higher-performing virtual machines.

Parallels Desktop fully supports Intel virtualization technology (VT-x). See the Intel Virtualization Technology (VT-x) Support (page 14) topic.

To enhance your experience of running more than one operating system on your Macintosh computer, Parallels Desktop for Mac includes several utilities: Parallels Transporter™, Parallels Explorer and Parallels Compressor™.

Parallels Desktop has a set of special tools (utilities and drivers) that will help you use your virtual machines efficiently: mouse synchronization tool, clipboard synchronization tool, Coherence tools and other tools. See the Parallels Tools Overview (page 85) topic for the full list of tools and their descriptions.

Key terms used in this Guide

Primary operating system (primary OS) designates the operating system that controls the input /output devices on the computer and that is loaded when the physical computer is turned on. Actually, it's Mac OS X.

Guest operating system (guest OS) designates an operating system that runs under virtual machine control. One primary OS and multiple guest OSes can run at the same time on a single computer.
What's New in This Version

**Improved Coherence**

Now Coherence Tools integrate guest OS and Mac OS X applications even more deeply:

- Windows file systems are accessible from Mac OS X and vice versa.
- Transparent file associations in both systems let you open Windows files in Mac OS X applications and Mac OS X files in Windows applications.
- The same default browser and email client can be used in both systems.
- Dock integration: the Dock displays both Windows and Mac OS X applications icons.

Coherence is available only for Windows 2000/2003/XP/Vista guest operating systems.

**3D Graphics**

3D graphics (OpenGL + DirectX) is now available in Windows guest OSes. Run your favorite 3D-graphics applications.

**Parallels Tools for Linux**

Linux users also got Parallels Tools that control mouse and provide dynamic screen resolution changing when you resize Parallels Desktop window.

**More Powerful Parallels Transporter**

Use Parallels Transporter to migrate from PCs with one of the Windows operating systems to Parallels virtual machine. In this version, third-party entire virtual machines can be converted into Parallels virtual machines with the same configuration. Refer to Using Parallels Transporter (page 256) chapter and to Parallels Transporter User Guide.

**Parallels Explorer**

A new helpful Parallels utility that allows you to view the contents of Parallels or third-party virtual machine without running the virtual machine. Just open the virtual machine in Parallels Explorer and see what is inside it. Drag files from one virtual machine to another or copy files to Mac OS X. Parallels Explorer is installed along with Parallels Desktop. See the Using Parallels Explorer (page 218) topic and Parallels Explorer User Guide for details.

**Shared Windows disks**

The current version of Parallels Desktop allows mounting Windows disks to Mac OS X desktop and browsing them in the Finder. For details refer to Shared Folders Options (page 163).

**Smart Select**
Transparent file extensions association feature allows using the same applications for files (with supported by application extensions) in both Windows guest OS and in Mac OS X. Right-click any file and choose one of applications from the combined list of Windows and Mac OS X application both when in the virtual machine or when in Mac OS X.

**Extended Boot Camp Support**

If you already have Boot Camp with Windows XP or Windows Vista partition, you don't have to re-install Windows in a virtual machine. A virtual machine that will use the Boot Camp partition will be created automatically during Parallels Desktop installation. You can use the Boot Camp partition both from this virtual machine and the Boot Camp. For details see Using Boot Camp Windows Partition (page 250).

**Undo Hard Disk**

If you'd like to experiment with your virtual machine, this may be the feature for you. In Configuration Editor select the Undo disks option for the virtual machine and choose an action to perform on shutdown: Discard Changes, Apply Changes, or Ask what to do. Start up the virtual machine and install untested software, browse potentially harmful web sites. No changes to the virtual disks will be saved if you select so. For more information, see Working with Undo Disks (page 150).

**Snapshot Manager**

Snapshot Manager allows creating a set of snapshots (saved states) for the virtual machine. You can revert the virtual machine to last snapshot at any time or you can go to any of the previous snapshots and create a new branch of snapshots. For more information see Working with Snapshots (page 144).

**Toolbar New Look**

You have a choice of several new pre-defined button sets for the Parallels Desktop toolbar. Also, you can add your own set of icons for toolbar buttons. See Adding New Icon Set for Toolbar Buttons (page 112).

**Shared Printers**

Printers that connected to your Macintosh computer now can be available for the virtual machine. Such printers can be connected via the virtual machine parallel port.
Opening Parallels Desktop Help

To open Parallels Desktop Online Help, select Parallels Desktop Help from the Help menu. You can find the .pdf version of this guide in the folder where Parallels Desktop is installed.

Context-Sensitive Help

To access the help topic that is directly related to the Parallels Desktop window you are currently working with, press F1.

Other Guides

There is one more guide in Parallels Desktop package, Parallels Desktop Quick Start Guide, a small guide that describes how to create your very first virtual machine. It is available via Help -> Quick Start Guide menu command.

About This Guide

This Guide is aimed at a wide range of users who want to use Parallels Desktop to create, configure and run Parallels virtual machines.

Notation Conventions

The table below presents the conventions used in this Guide.

<table>
<thead>
<tr>
<th>Fonts</th>
<th>This font</th>
<th>Used for buttons, options, menus and menu commands, windows, and dialog boxes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>This font</td>
<td></td>
<td>Used for keys, paths, and folder names.</td>
</tr>
<tr>
<td>This font</td>
<td></td>
<td>Used for console commands in Linux and Windows.</td>
</tr>
<tr>
<td>This font</td>
<td></td>
<td>Used for tips, glossary items and options or modes mentioned in the text.</td>
</tr>
<tr>
<td>Fonts</td>
<td>Note.</td>
<td>Used to emphasize the message.</td>
</tr>
<tr>
<td>Type Styles</td>
<td>Warning.</td>
<td>Used to warn you about possible data loss.</td>
</tr>
<tr>
<td>Key Combinations</td>
<td>&lt;key&gt;-click</td>
<td>Used to direct you to press the key and click the mouse button.</td>
</tr>
<tr>
<td></td>
<td>&lt;key&gt;+&lt;key&gt;</td>
<td>Used to direct you to press the keys simultaneously.</td>
</tr>
</tbody>
</table>
Abbreviations used in text

In the present guide the following abbreviations are used:

- *OS* is used instead of *operating system* in some long sentences where using it will not change the meaning of the sentence.
- *VM* is used instead of *virtual machine* in some long sentences where using it will not change the meaning of the sentence.

Definitions

*Primary operating system* (primary OS): In this Guide this term is used to refer to the operating system that controls the I/O devices of the computer and that is loaded when the physical computer is turned on, that is, Mac OS X.

*Guest operating system* (guest OS): The term is used to refer to an operating system that runs under the virtual machine control.
CHAPTER 2

Parallels Desktop Virtual Machine

This chapter provides a brief description of Parallels virtual machines, their specifications and underlying technologies. The chapter also includes the list of supported guest operating systems.

In This Chapter

Virtual Machine Technology Overview ................................................................. 13
Intel Virtualization Technology (VT-x) Support .................................................... 14
Virtual Machine Hardware ..................................................................................... 14
Supported Guest Operating Systems ................................................................. 15
Virtual Machine Files ........................................................................................... 17
Support of Virtual and Real Disks ......................................................................... 18

-----------------------------

Virtual Machine Technology
Overview

Virtual machine technology allows users to:

- Create one or several virtual machines, each with a set of standard virtual hardware.
- Install any operating system in the virtual machine no matter what operating system is installed on your physical computer. The guest operating system and its applications are isolated inside the virtual machine and share physical hardware resources with the primary operating system.
- Run multiple guest operating systems (OSes) and their applications simultaneously running on a single physical computer. Switching between the operating systems does not require rebooting.
- Consolidate and virtualize the computing environment, reduce hardware costs, lower operating expenses, and increase productivity.
Intel Virtualization Technology (VT-x) Support

Intel Virtualization Technology (VT-x) implemented in the architecture of the newest Intel processors was specially developed for platforms running multiple operating systems. VT-enabled processors allow more precise virtual processor simulation. To learn more about Virtualization Technology see the Intel web site (http://www.intel.com/technology/virtualization/index.htm).

Parallels Desktop fully supports Intel Virtualization Technology. If Parallels Desktop detects a VT-enabled CPU, it automatically turns on VT-x support. Make sure the Enable Intel VT-x support option is selected in the Configuration Editor: on the Advanced tab of General Options. If you run a guest OS with VT-x enabled, the Virtualization Mode flag in the Parallels Desktop -> About Parallels Desktop -> More Options dialog shows Intel VT-x.

Virtual Machine Hardware

As we mentioned earlier, a virtual machine works like a stand-alone computer. Each VM has the following hardware:

- CPU Intel Pentium.
- A generic motherboard compatible with Intel i815 chipset.
- RAM up to 1500 MB.
- VGA and SVGA with VESA 3.0 support.
- 1.44 MB floppy disk drive mapped to an image file.
- Up to four IDE devices; each device may be either a virtual hard disk drive (from 20 MB up to 128 GB each mapped to an image file or Boot Camp partition), or a CD/DVD-ROM drive (mapped to a physical drive or to an image file).
- Up to 5 network virtual interfaces, including Ethernet virtual network card compatible with RTL8029.
- Up to four serial (COM) ports (mapped to a socket or to an output file).
- Up to three parallel (LPT) ports (mapped to output file or to a printer connected to the Macintosh computer).
- 8-port USB 2.0 and 2-port USB 1.1 controller.
- AC’97-compatible sound card. Sound recording is supported.
- A generic PC keyboard.
- A PS/2 wheel mouse.
Supported Guest Operating Systems

The current version of Parallels Desktop officially supports the following guest operating systems:

**Microsoft® Windows:**
- Windows Vista™ Ultimate, Enterprise, Business
- Windows Server® 2003 Standard Edition SP0, SP1
- Windows Server 2003 Enterprise Edition SP0, SP1
- Windows Server 2003 Web Edition SP0, SP1
- Windows XP Professional SP0, SP1, SP2
- Windows XP Home SP0, SP1, SP2
- Windows 2000 Professional Edition SP4
- Windows 2000 Server SP4
- Windows 2000 Advanced Server SP4
- Windows NT® Workstation 4.0 SP6
- Windows NT Server 4.0 SP6
- Windows ME
- Windows 98
- Windows 95
- Windows 3.11
- Windows 3.1

Windows 2008 (Longhorn) is supported experimentally.

**Linux:**
- Red Hat® Enterprise Linux 5, 4, 3
- Red Hat Linux 9, 8, 7.3
- Debian® Linux 4.0, 3.1
- Fedora™ Core Linux 6, 5, 4, 3
- SUSE® Linux 10.2, 10.1, 9.3, 9.2, 9.1, 9.0
- Mandrake™ Linux 10.1, 10, 9.2
- Mandriva 2007
- Ubuntu® Linux 7.04, 6.10, 6.06, 5.0.4
- Xandros Business 4.0
- CentOS 5

**FreeBSD® Guest Operating Systems:**
- FreeBSD 5.4, 5.3, 4.5, 4.1
OS/2® and eComStation™ Guest Operating Systems:
- OS/2 Warp 4.5, 4
- eComStation 1.2, 1.1

Sun Solaris® Guest Operating Systems:
- Solaris 10, 9

MS-DOS® Guest Operating Systems:
- MS-DOS 6.22
Virtual Machine Files

By default, the files of a virtual machine created with OS Installation Assistant, are placed to the folder:

<UserName>/Documents/Parallels/<VM Name>/, where <VM Name> is the name of the particular virtual machine.

Hardware configuration for each virtual machine is defined in a special configuration file having the .pvs extension. It contains all the information about virtual devices used by the virtual machine and files connected to those devices. A virtual machine has at least two files: a configuration file and a hard disk image file. Generally, there may be more files: a file for each additional virtual hard disk and output files for virtual ports. If the virtual machine has snapshots, they are represented by a number of files. As an exception, a virtual machine may have only one file, the configuration file - such a virtual machine can be started from a Live CD.

The following table describes the types of files that a virtual machine may have:

<table>
<thead>
<tr>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.pvs</td>
<td>This is a virtual machine configuration file. One configuration file defines one virtual machine. Configuration file is generated when OS Installation Assistant (page 57) creates a new VM. One instance of Parallels Desktop can run only one configuration file, that is only one virtual machine. To run several virtual machines, you should launch several instances of Parallels Desktop.</td>
</tr>
<tr>
<td>.sav</td>
<td>This file is created when you suspend a virtual machine or pause it. It contains a state of the virtual machine and its applications at the moment the suspend was invoked.</td>
</tr>
<tr>
<td>.mem</td>
<td>This file contains memory dump for the suspended virtual machine. For the running virtual machine it is a temporary virtual memory file.</td>
</tr>
<tr>
<td>.hdd</td>
<td>This package (or bundle) represents a virtual hard disk of a Parallels Desktop virtual machine. When you create a new virtual machine, you can create it with a new virtual disk or you can use an existing virtual disk. You may also attach the same virtual disk to several virtual machines. More information can be found in the Virtual Hard Disks (page 19).</td>
</tr>
<tr>
<td>.iso</td>
<td>This is an image file of a CD or DVD. ISO images are treated by the virtual machines as real CD/DVD discs. More information about .iso images can be found in the CD/DVD Discs and Their Images (page 20) topic.</td>
</tr>
<tr>
<td>.fdd</td>
<td>This is a floppy disk image file. .fdd image files are treated by the virtual machine as real floppy disks. More information about .fdd images is given in the Floppy Disk Images (page 21) topic.</td>
</tr>
<tr>
<td>.txt</td>
<td>Serial and parallel ports can be emulated via output .txt files. See Serial Port Options (page 179) and Parallel Port Options. (page 178)</td>
</tr>
</tbody>
</table>

The unattendant.fdd file appears in the virtual machine folder when you create the virtual machine and install the guest OS with the help of OS Installation Assistant using Windows Express mode. The file contains the task that controls the Windows XP or Windows Vista installation process.

For a virtual machine that has any of Windows OS (starting from Windows 2000) as a guest OS, the following objects are also created automatically:

- **Windows Applications folder.** *This folder is for use by Parallels Desktop only.* It contains references to the Windows applications used in the virtual machine. References are used for supporting the file extensions transparency. The folder cannot be deleted when the virtual machine is running.
- **Windows Disks folder.** *This folder is for use by Parallels Desktop only.* Contains references to Windows disks available in the virtual machine.

### Files of Snapshots

For a virtual machine with snapshots, in the folder where the configuration file is located, the following objects are present:

- **snapshots.xml** - This file stores the information about virtual machine snapshots.
- **Snapshots folder** - Snapshot files are placed into this folder. For each snapshot the following files are created:
  - **.pvc** file contains the copy of the virtual machine configuration file.
  - **.png** file contains the screen shot of the guest OS in case the snapshot was taken at runtime.

For each virtual disk, its .hdd bundle file contains an original state of the disk and the disk difference files for all snapshots that were created for the virtual machine.

## Support of Virtual and Real Disks

In this section we discuss all types of disks which can be used by Parallels Desktop virtual machines and basic operations that the user can perform with these disks.
Supported Types of Hard Disks

The current version of Parallels Desktop allows virtual machines to use virtual hard disks and Boot Camp partition with Windows XP/SP2 or Windows Vista installations only.

Note. A Live CD may be used with a virtual machine that has no virtual hard disk.

Virtual Hard Disks

The capacity of a virtual disk can be set from 20 MB up to 128 GB.

Virtual hard disks can be in one of two formats: plain or expanding.

plain
The file that stores an image of disk in this format has constant size from the moment it is created. This reserves space on virtual disk even when there is no free space on the real hard disk. It also allows the guest OS to operate a little bit faster. Disk in plain format can be created with the help of OS Installation Assistant, in the Custom mode.

expanding
The file that stores an image of expanding disk is small initially and grows as you add applications and data to the virtual disk. The size specified when the disk is created is the disk capacity, while the disk image file has a smaller size most of the time. Using disks in this format saves space on the hard disk of your Macintosh computer.

Disks of both formats require certain maintenance, for more information see Maintaining Virtual Hard Disks (page 230).

Note. You cannot change the format of the virtual disk in the current version of Parallels Desktop.

Split disks

A virtual disk of either format can be a single-piece disk or a so-called split disk. By default, the split disk is cut into 2 GB pieces. The split disk is stored as a single .hdd bundle. The .hdd bundle for a split disk includes a number of files and one XML file that contains all the information about other files. Split disks allow faster access to the data.
Boot Camp Option

Now you can use your Boot Camp Windows XP/SP2 or Windows Vista installation to boot in it natively (via Boot Camp) or via Parallels Desktop. Generally, Boot Camp Windows partition can be used as a bootable disk or as a data disk in Parallels virtual machines.

During the installation, Parallels Desktop checks if your Macintosh computer has a Boot Camp partition with Windows XP or Windows Vista installed, and automatically creates a new virtual machine for using this partition if there is no other virtual machines on the computer.

- If the Windows partition is mounted to Mac OS X desktop, Parallels Desktop attempts to recognize the operating system installed on the partition and creates appropriate virtual machine for the recognized OS.
- If the Windows partition is not mounted to the Mac OS X desktop, or if Parallels Desktop cannot recognize the operating system, it creates a virtual machine for Windows XP. If you really have Windows Vista installed on the Boot Camp partition you have to change the type of the guest OS for the virtual machine from Windows XP to Windows Vista in Configuration Editor.

Alternatively, you can create a new virtual machine with OS Installation Assistant for using the Boot Camp Windows partition as a bootable volume, or add the Boot Camp partition as a data disk to an existing virtual machine with Add Hardware Assistant.

Parallels Tools will be installed automatically when you boot into the Boot Camp Windows partition for the first time. Parallels Tools will not interfere with the system when you boot into it via Boot Camp.

**Note.** You cannot create snapshots or use Undo Disks feature for a virtual machine that uses the Boot Camp partition.

CD/DVD Discs and Their Images

Parallels Desktop can access real CD/DVD discs and images of CD/DVD discs.

The current version of Parallels Desktop has no limitations on using multisession CD/DVD discs. Virtual machine can play back audio CDs (no limitation on copy-protected discs).

If your Macintosh computer has a writable CD/DVD-ROM drive, you can use it to burn CD or DVD discs in a virtual machine.

Parallels Desktop uses CD/DVD disc images in ISO format (as files with .iso extension). Parallels Desktop can read ISO images of discs created by many third-party applications. It can also read DMG images of discs made with Disk Utility. When creating such images make sure you create the read-only and uncompressed images.

If errors occur when you install the guest OS installation from a CD/DVD, try to install from an ISO image of that CD. In most cases guest OS installation is performed faster and with less or no errors when an ISO image is used.
Floppy Disk Images

Although most new Macintosh computers do not have floppy drives, a Parallels Desktop virtual machine has virtual floppy disk drive. Parallels Desktop can use floppy image files that appear to a virtual machine floppy drive as real diskettes. Parallels Desktop supports images of floppy disks as files with .fdd extension.

In the guest OS you may also access real diskettes using an external USB floppy drive plugged into Macintosh computer.

Parallels Desktop does not allow creating images of real diskettes. It can create an image of a blank floppy only. How to create an image of a floppy disk is described in Creating Floppy Disk Images topic (page 217).
CHAPTER 3

Installing Parallels Desktop

This chapter describes the system requirements and provides the information on how to install Parallels Desktop on your Macintosh computer and how to activate it.

In This Chapter

System Requirements............................................................22
Installing Parallels Desktop..................................................24
Upgrading to Parallels Desktop 3.0 .......................................29
Starting Parallels Desktop......................................................29
Activating Parallels Desktop..................................................30
Updating Parallels Desktop...................................................32
Uninstalling Parallels Desktop...............................................37

System Requirements

Note. Before installing the product, please make sure your computer meets the hardware and software requirements described in this section.
Hardware Requirements

In order to install and successfully run Parallels Desktop you should have:

- An Intel-powered Core™ Duo or Core™ Solo Mac® Mini, iMac®, MacBook™, MacBook Pro or Mac Pro.
- A minimum of 768MB of RAM. 1GB is recommended.
- About 200 MB of hard disk space on the boot volume for Parallels Desktop installation.
- Sufficient space on hard disks to allocate for virtual machines. 15 GB of hard disk space for each virtual machine is recommended.

Planning Parallels Desktop Installation

The current version of Parallels Desktop can be installed only on the Mac OS X boot volume. Parallels Desktop requires only 40.5MB of hard disk space, while virtual machines require much more space. By default, Parallels Desktop is configured to place a new virtual machine into home folder of the user who created it. Home folders, as a rule, are also located on the boot volume. If you have other disk(s) or partition(s) on your Macintosh computer, you may select any of them to store your virtual machines.

Note. Working with virtual machines that are located on an external USB drives is not recommended. If, nevertheless, you decide to do it, make sure that the drive is formatted as a native to Mac OS X file system.

Software Requirements

Parallels Desktop can be successfully installed if you are running Mac OS X 10.4.6 or later as your primary operating system. To check what version of Mac OS X you have got, choose About This Mac from the Apple menu in the menu bar.

Mac OS X 10.5 (Leopard) is supported experimentally.
Installing Parallels Desktop

1. If you purchased Parallels Desktop online, locate the downloaded package. Double-click it, you'll see the Parallels Desktop window. Click **Install Parallels Desktop** file.

![Install Parallels Desktop file](image)

2. If you purchased a box edition, insert the installation CD. On Mac's desktop double-click the CD icon to open it. Double-click the **Parallels Desktop.pkg** file to start the installation.

![Parallels Desktop.pkg file](image)
3. In the **Introduction** dialog click the **Continue** button.

![Welcome to the Parallels Desktop Installer](image1)

4. In the **Software License Agreement** window use the scroll bar to read the entire agreement. We recommend to print the license agreement for your records using the **Print** button or to save it for future reading using the **Save** button. When you are ready, click the **Continue** button.

![Software License Agreement](image2)
In the pop-up dialog, click the **Agree** button to continue installing.

5 Next you'll see the **Select a Destination** window. You can install Parallels Desktop only on the boot volume, the same disk where Mac OS X is installed. Other disks (if any) will be disabled for selection. Click **Continue**.

6 Click **Install** to start the Parallels Desktop installation, or click **Upgrade** if you are installing over the previous version of Parallels Desktop.
Note: You can return to the previous steps by clicking the Go Back button at any time.

7 Enter your password when prompted and press Return (Enter) on your keyboard.

8 The installation progress is shown in the Installing Parallels Desktop window.
The Installer informs you that the installation was successful. To complete the installation, click Close.
Upgrading to Parallels Desktop 3.0

Generally, the upgrading procedure for Parallels Desktop is the same as for its installation. See Installing Parallels Desktop (on page 24).

Using an Upgrade Activation Key

If you purchased an upgrade activation key for Parallels Desktop 3.0, you will be prompted to confirm that you have a valid, permanent key for the previous version:

- If you activated the previous version of Parallels Desktop with a permanent key, you will need to enter the upgrade key when installing the 3.0 version.
- If, at the moment, you are using a trial activation key, you will be prompted to enter both keys: a key for the previous version and the upgrade key for the 3.0 version.

Converting to the New Virtual Disk Format

Parallels Desktop 3.0 uses the new format of virtual hard disks. So, when you start the existing virtual machine after upgrading Parallels Desktop, the virtual disks will be automatically converted to the new format. This conversion to the new format is irreversible.

Warning. Please back up your old virtual machines before upgrading to Parallels Desktop 3.0 if you want to continue using the virtual machines with Parallels Desktop 2.5. For general information on backups refer to the Backing Up the Virtual Machines (page 230).

Upgrading Parallels Tools

Upgrading of Parallels Tools will be performed automatically once the virtual machine is started.

Starting Parallels Desktop

To start Parallels Desktop:

- In the Finder, open Applications -> Parallels, and then double-click the Parallels Desktop icon.

If you want to add Parallels Desktop alias to the Dock, just drag its icon from any Finder window to the Dock; you'll be able to open the application at any time by simply clicking its icon.

To remove Parallels Desktop icon from the Dock, just drag it off the Dock.

Warning. You must activate your copy of Parallels Desktop with an activation key (temporary or permanent) before you can use it.
Activating Parallels Desktop

To run Parallels Desktop you should activate it with an activation key. If you purchased the box version of the program in a retail store, you can find the activation key printed on the installation CD sleeve. If you purchased the program online, you have received the activation key by e-mail. Also, you may get a trial activation key valid for a certain period of time if you want to evaluate the program before buying it.

Activating Your Copy of Parallels Desktop

To activate Parallels Desktop, follow these easy steps:

1. Choose **Activate Product** from the **Help** menu.
2. In the **Activate Product** dialog, fill in the following fields:
   - In the **Activation Key** field type the activation key. When you fill in this field, the **Activate** button becomes enabled.
   - Specify your name and the name of your company in the **User Name** and **Company Name** fields. These fields are optional.

   ![Activate Product Dialog](image)

   - This copy of Parallels Desktop is currently not active. Please purchase a permanent activation key or obtain a free trial activation key.
Click the Activate button. If you have entered a valid activation key, the following message will be displayed: "Parallels Desktop has been activated successfully. Thank you!" Now, that your copy of Parallels Desktop is activated, you can build, configure, and run virtual machines, congratulations!

**Getting Trial Activation Key**

Please note that at Parallels Download Center you can get a trial activation key only for English-language version of Parallels Desktop.

After you download Parallels Desktop from Parallels Download Center (http://www.parallels.com/en/download), follow the steps below:

1. Select Activate Product from the Help menu.
2. In the Activate Product dialog, click the “obtain a free trial activation key” link in the License Information text..
3. In the User Registration Form, specify your e-mail address and your name. Name of your company is optional. Specify if you want to receive news from Parallels.

![User Registration Form](image)

4. You can also fill in the fields on the Optional information tab.
5. Finally, click the Register button to send this information to Parallels. A free trial activation key will be sent immediately to the e-mail address you provided.

You may also register online at the Parallels web site. For this, click the Register On Site button. You will receive a free trial activation key by e-mail after you fill out and submit the online form.
If your trial key has expired, you’ll need a permanent activation key. Follow these steps to get one:

1. Select Activate Product from the Help menu. This opens the Activate Product dialog.
2. In the Activate Product dialog, click the “purchase a permanent activation key” hyperlink in License Information text to open the Parallels Online Store where you can purchase a permanent activation key.

About Registration

After you have activated your copy of Parallels Desktop with a permanent activation key, the next time you start Parallels Desktop you will be asked to register it. When you see the message shown below, click the Register button. The online user registration form will open in your Web browser. We will use your contact information only to send you notifications about our new updates and products.

---

**Updating Parallels Desktop**

Parallels Desktop includes an updating feature that helps you keep your Parallels Desktop installation up-to-date. You can use the update feature only if your computer is connected to the Internet.

Update checks can be initiated either automatically or manually:

- We recommend that you turn on automatic updating in order to be notified when an update is available. Parallels Desktop will regularly check the Parallels server and will inform you only when an update is available.
- In addition to automatic updating, you may start the updating manually at any time.
Automatic Updating

To use the automatic updating feature, your Macintosh computer should have a stable Internet connection.

Configuring Parallels Desktop

To configure Parallels Desktop:

1. Select **Check for Updates** from the **Help** menu. You will see the following dialog:

   ![Check for Updates dialog]

   - **Check for update automatically.**
   - Specify the frequency in the **Perform check every** field. With these options set, Parallels Desktop will access the Parallels server and notify you when an update is available.
4 If you want Parallels Desktop to download the updates automatically, select **Download updates in background** and specify the folder where the updates will be placed.

![Current version: 2.1.1832
Last check: Thu May 25 13:53:31 2006 (0 day(s) ago)](image)

- **Check for update automatically**
  - Perform check every: 7 day(s)
  - **Download updates in background**
  - /Users/ms/Desktop

5 Click **OK** to close the dialog and apply new settings.

After this:

- If you have not selected **Download updates in background**, you will be notified of an existing update by the dialog shown in step 3 of Manual Updating (page 35). To complete updating, follow the rest of the steps in this section.

- If you have selected **Download updates in background**, you will be notified of an update downloaded by the dialog shown in step 4 of Manual Updating (page 35). To complete updating, follow the rest of the steps in this section.
Manual Updating

1 In the menu select Check for Updates from the Help menu. You will see the following dialog:

![Check for Updates dialog](image)

Settings on this dialog are used for auto-updating and are discussed in the previous topic, Auto-Updating Parallels Desktop (page 33).

To proceed with manual update click Check Now.

2 The Updater accesses the Parallels Desktop web server and compares available updates with the installed version. If a more recent version is not found, you will see the following message:

![Update message](image)
3 If one or more later versions are found, they will be listed in the following dialog. Choose one and click the **Download** button to start downloading.

![Update Table](image)

**Update Title:**

<table>
<thead>
<tr>
<th>Name</th>
<th>Version</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parallels Desktop (build 1832)</td>
<td>2.1.1832</td>
<td>19554Kb</td>
</tr>
</tbody>
</table>

**Details:**

Thank you for choosing Parallels Desktop.

4 After the update is downloaded, you will see the following message. To install the update, click **Quit Application** and follow the same steps as when Installing Parallels Desktop (on page 24).

![Update Information](image)

**Software Update Information**

Parallels Desktop has completed downloading the software update. You can find downloaded file at the following location:

/Users/ms/Desktop/Parallels-Desktop-1832-Mac.dmg

To install this update you should close the application and run setup package.

Click **Quit Application** to shutdown Parallels Desktop. Click **Continue** to return to the application.
Uninstalling Parallels Desktop

To uninstall Parallels Desktop:

1. Locate and open the "Parallels Desktop 3.0.XXXX Mac.dmg" file that you used to install Parallels Desktop. Click Uninstall Parallels Desktop.

2. In the next dialog click the Continue button.
In the next dialog click **Uninstall**.

![Uninstall](image)

3 Enter your password when prompted and press Return (Enter) on the keyboard.

![Authenticate](image)

4 Uninstaller removes Parallels Desktop from your computer, and displays the following dialog. Click the **Finish** button.

![Finish](image)
CHAPTER 4

Interface Basics

This chapter provides the information about Parallels Desktop main window and its controls including the Parallels Desktop menu.

In This Chapter

Main Window ................................................................. 40
Configuration Editor ...................................................... 48
Menu ............................................................................ 49
About Parallels Desktop Dialog ........................................ 50
More Information .......................................................... 51
Making Screen Shots ...................................................... 52
Main Window

This section provides the information on Parallels Desktop main window: different view modes and controls.

When you start Parallels Desktop, its main window displays the Select virtual machine dialog with a list of virtual machines available on your computer. When you select an existing virtual machine, the Select virtual machine dialog disappears, and you see the Configuration Page of the selected virtual machine.

Note. If you have no virtual machines on your Macintosh computer, then on Parallels Desktop startup, OS Installation Assistant appears. It will help you create a new virtual machine and install an operating system in it. For details see OS Installation Assistant (page 56).

The main window of Parallels Desktop displays:

- **Configuration page** of the selected virtual machine when the machine is not started. See Configuration Page (page 42) to learn more about it.

- **OS Window** or **Guest OS Window**. When you start the virtual machine, main window changes to guest OS Window, that acts as the virtual machine's display. Os Window mode is available only when the virtual machine is running.

The main window has the following visual controls:

- **Title bar** located on the top of the Parallels Desktop window;
  - To see the path to the currently open virtual machine click the Parallels Desktop icon on the title bar while pressing the Command key.
- To create an alias (shortcut) for the virtual machine drag the Parallels Desktop icon to desktop or into the Dock while pressing Command+Option (Alt) keys.
- **Toolbar**; for details, see Toolbar (page 45).
- **Status bar** at the bottom of the window; available only when the virtual machine is running.
  it indicates the status of the virtual machine and the status of its devices; see Status Bar.

## Select Virtual Machine Dialog

Whenever you start Parallels Desktop, it opens with the Select virtual machine dialog over the Configuration Page of a new blank virtual machine.
The **Select virtual machine** dialog contains the following items:

- The list of existing virtual machines. The virtual machines are listed by their names, not pathnames. The names of the open virtual machines are grayed out and cannot be selected.
- The **Select** button. Click it to open the virtual machine selected in the list.
- The **New** button. Click it to start OS Installation Assistant.
- The **Choose** button. Click it to locate a virtual machine that is not in the list (on an external USB storage, on the network).
- The **Download** button. Click it to get to the web page of Parallels Virtual Appliances Library http://ptn.parallels.com/en/ptn/dir, choose a virtual appliance and download it. Parallels Virtual Appliances are ready-to-use virtual machines, specially configured for running particular applications.

Point the cursor to a virtual machine in the list and view the description in a pop up help tag. The description for a virtual machine can be provided on the **General Options** tab in **Configuration Editor**.

If the list of virtual machines includes more than 5 items, the **Search** field at the top of the **Select virtual machine** dialog appears. Type any string (not more than 8 symbols) that the name of the desired virtual machine contains. As you are typing it, Parallels Desktop filters virtual machine names and displays in the list only those machines whose names match the string.

**Note.** The name of the virtual machine can be changed in Configuration Editor, see the General Options (page 156) topic.

---

### Configuration Page

![Configuration Page](image-url)
When you open an existing virtual machine, its Configuration Page is displayed. The upper part of the page displays the virtual machine name, the type of the guest operating system (regardless whether it is installed or not), and the virtual machine status (Running, Stopped, Paused).

**Configuration**

The lower part of the main window titled **Configuration**, provides the information about virtual machine configuration: memory, hard disk and other devices connected to the virtual machine.

To edit the virtual machine configuration or view its details, click the **Configuration** title or any device link in the list. This will open Configuration Editor (page 155) (available only when the virtual machine is not running).

When the guest OS is running, Configuration Page is available for viewing only. Links are disabled.

**To open Configuration Page**

Choose **VM Configuration** from the **View** menu.

If your virtual machine is configured to start up when you select it in the **Select virtual machine** dialog or when you click its alias, to open Configuration Page do one of the following:

- Start Parallels Desktop. While pressing the **Cmd** key in the **Select virtual machine** dialog highlight the desired virtual machine and click the **Select** button.
- While pressing the **Cmd** key, double-click the virtual machine alias.
Guest OS Window

You can interact with a running virtual machine via its Guest OS window. The Configuration Page transforms to the Guest OS window when you start the virtual machine. If you have a guest operating system installed, you will see the booting process as it would be displayed on a screen of a physical computer. All toolbar buttons and many of the menu commands become enabled.

You also can resize the virtual machine window as you would do with any other application window by dragging its right corner. Resolution is being changed automatically in Windows (starting Windows 2000) and in most Linux operating systems.

When the guest operating system is running, you can switch between several display modes of the Guest OS window:

- **Full screen.** For detailed information see Switching to Full Screen (page 107).
- **Coherence.** For detailed information see Switching to Coherence.

**To switch to the Guest OS window**

- When in full screen mode, press Ctrl+Option to display the Parallels Desktop menus and choose **OS Window** from the **View** menu.
- When in Coherence mode point to any Windows application to display the Parallels Desktop menus in the menu bar and choose **OS Window** from the **View** menu.
Toolbar

The toolbar buttons are used to control the virtual machine.
Most of the toolbar buttons become enabled only when you start the virtual machine. If you click a toolbar button, it becomes visibly pressed.

The first three buttons control the virtual machine. Two buttons of the next group control the display mode of Parallels Desktop window. The buttons of the last group let you save states of the virtual machine and roll back the virtual machine to specific state.

The following buttons are available on the toolbar:

- **Stop Virtual Machine** button; forces the virtual machine to stop. It is recommended to stop virtual machine by shutting down the guest OS, not by using this button.

- **Pause Virtual Machine** button; pauses the virtual machine.

- **Start Virtual Machine** button; starts the virtual machine.

- **Full Screen** button; switches the virtual machine to full screen, so that no Mac OS X controls are present on the screen.

- **Coherence** button; switches Parallels Desktop window to Coherence.

- **Create Snapshot** button; when clicked creates a snapshot for the virtual machine.

- **Revert to Last Snapshot** button; rolls back changes made to the virtual machine since the time of the last snapshot.

- **Snapshot Manager** button; opens Snapshot Manager. For more information refer to Working with Snapshots (page 144).

When the virtual machine is stopped, only the **Start Virtual Machine** and **Create Snapshot** buttons are enabled.

When the virtual machine is running, you can switch it between two view modes (or screen modes): Full screen and Coherence.

**Toolbar Position**

By default, the toolbar is located to the right of the Parallels Desktop window. You may place it to the left or to top of the window if you like. Parallels Desktop will remember the toolbar position next time you launch the application. For how to change the toolbar position see Main Window Options (page 112).

If you don't see the toolbar in the Parallels Desktop window, click the button in the upper right corner of the Parallels Desktop window.

**Toolbar Buttons**

There are several pre-defined sets of toolbar button icons, among them: Standard and Modern. You can use any of them or create and add your own set of icons. For more details see Adding New Icon Set for Toolbar Buttons (page 112).
On the picture below you can see the *Modern* set of buttons.

![Modern set of buttons](image)

**Status Bar**

The status bar displays the devices information when the virtual machine is running. The left part of the status bar displays tooltips for devices currently pointed by the cursor or other messages while the right side of the status bar displays the devices icons.

![Status bar](image)

The following devices have icons on the status bar:

- hard disk
- CD/DVD-ROM
- floppy disk drive
- network adapter
- serial port
- parallel port
- sound device
- shared folders
- USB controller

When a device is used, a colored circle on its icon indicates its state:

- green circle when reading is being performed,
- orange circle when writing is being performed.

If a device can be connected or disconnected at runtime (actually, most of the devices can be), this can be done using the device's shortcut menu. Click the device icon to display its shortcut menu and select the command. The picture below shows the shortcut menu for the CD/DVD-ROM drive.

![Shortcut menu](image)
You can also allow connect CD/DVD discs or images of discs to the virtual machine CD/DVD-ROM drive or connect a floppy image to its floppy drive in the following way: drag the required image file over the icon of CD/DVD-ROM drive on the Parallels Desktop status bar. For more information, please refer to the Changing Configuration at Runtime (page 126) section.

Configuration Editor

The configuration of an existing virtual machine displayed on the configuration page can be changed in the Configuration Editor.

To open Configuration Editor do one of the following:

- open Configuration Page and:
  - click the Configuration link (General Options page will be open)
  - click any of the devices in the list (the Configuration Editor will be opened on the particular device page)
- select VM Configuration from the Edit menu.

Note. When the virtual machine is running, Configuration Editor is not available. All the links on the Configuration Page are disabled, and Virtual Machine command on the Edit menu is disabled.

For more detailed information see the Editing Virtual Machine Configuration (page 155) section.
Menu

Menus for Parallels Desktop contains all the controls available for Parallels Desktop and its virtual machines.

There are the following menus:

- **Parallels Desktop** menu displays the About Parallels Desktop dialog and lets you set Preferences.
- **File** menu lets you perform operations with virtual machines, such as create a new VM, open/delete/clone one of already existing virtual machines. It also includes the Import command to migrate the information from other computers or virtual machines.
- **Edit** menu lets you edit the virtual machine configuration.
- **View** menu includes commands for displaying the Parallels Desktop main window as Configuration Page or as Guest OS window, the Guest OS window can be switched to full screen, Coherence or to window mode. You also can customize how you view the toolbar and set some Coherence mode options.
- **Actions** menu includes basic virtual machine starting and stopping commands, commands for installing Parallels Tools, Kaspersky Internet Security and command for launching the built-in utility Parallels Compressor. For Windows XP virtual machines it also includes the Prepare for Windows Vista Upgrade command. The Actions menu also includes the Snapshots section.
- **Devices** menu allows connecting or disconnecting devices and changing their options. Some of the options are available when the virtual machine is running.
- **Applications** menu appears on the menu bar only when Windows 2000/XP/2003/Vista virtual machine is running; it contains the list of favorite Windows applications and the list of running applications. To view and access this menu you must install Parallels Tools.
- **Help** menu opens Parallels Desktop Online Help or Quick Start Guide, and lets you activate the product, check for updates.

**Parallels Desktop Shortcut Menu**

Parallels Desktop icon placed in the Dock has a shortcut (contextual) menu with the following commands: New, Open, Preferences, Keep in Dock, Open at Login, Show in Finder, Hide and Quit. It also shows the name of running virtual machine associated with the alias.

Right-click the Parallels Desktop icon to open this menu.

If a Windows XP/2003/Vista virtual machine is running, you will also see the Windows Start menu and Applications (the Favorites and Running sections) commands on the shortcut menu.
About Parallels Desktop Dialog

**Parallels Desktop 3.0 for Mac**
Build 3532 Beta 2 (April 20, 2007)

Parallels and Parallels logo are registered trademarks, and Compressor is a trademark of Parallels Software International, Inc. This product is based on a technology that is the subject matter of a number of pending patent applications.

**Licensing Information:**
This is an active copy of Parallels Desktop. It is licensed to:

**Support Information:**
Technical support page: [http://www.parallels.com/support](http://www.parallels.com/support)
To open the dialog select in the menu: choose *About Parallels Desktop* from the *Parallels Desktop* menu.

The upper part of the *About Parallels Desktop* window provides the following information:
- the number of the build you are using
- the full name of the vendor and link to its web site
- copyright and trademark information

**Licensing Information.** Displays your type of activation and other activation information.

**Support Information.** Contains the contact information of the Parallels technical support group.

**Buy Online** and/or **Evaluate** buttons. Displayed only if you have a trial activation or did not activate your copy at all. If you have activated the program with a permanent activation key, these buttons are not displayed. See Activating Parallels Desktop for further information (page 30).

**More Info** button. Opens the dialog with details of your license and other information.

---

**More Information**

<table>
<thead>
<tr>
<th>License Status:</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is an active copy of Parallels Desktop</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User Name: Cool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company Name: Cool</td>
</tr>
<tr>
<td>Product ID: 00000–00000000–00000</td>
</tr>
<tr>
<td>Validity period: Not limited</td>
</tr>
<tr>
<td>Primary OS(e)s: Mac OS X</td>
</tr>
<tr>
<td>Terminal Services: No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Virtual Machine Features:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtualization Mode: Off</td>
</tr>
<tr>
<td>Remote Session: Off</td>
</tr>
</tbody>
</table>
License Status:

- **User Name** and **Company Name** display the information that you entered in the **Activate Product** window.
- **Product ID** displays the identification number of your copy of Parallels Desktop - its license number.

Scope of your license:

- **Validity period** shows the date until your license is valid.
- **Primary OS** indicates that only Mac OS X as a primary operating system is allowed by your license.
- **Terminal Services** displays what primary operating systems are able to access Parallels Desktop remotely.

*Note:* The same license information is displayed in the **Activate Product** window. See Activating Parallels Desktop (page 30).

Virtual Machine Features:

This group contains indicators that are active only when the guest OS is running. Otherwise they are off.

- **Virtualization Mode** has the value: Intel VT-x when you work on an Intel VT-enabled processor and VT-x support is enabled in the virtual machine.
  
  If you are running virtual machine with VT-x support disabled, **Virtualization Mode** indicates the acceleration level. All guest OSes, except Windows NT/2000/XP/2003/Vista, run in **Software mode 0**. Either of Windows NT/2000/XP/2003/Vista starts with **Software mode 0**, then switches to **Software mode 1** or to **Software mode 2** in case the **Acceleration Level** option is set to High. See Configuring Virtual Machine, Advanced tab (page 158).

- **Remote Session** indicates if Parallels Desktop is executed on a remote server.

### Making Screen Shots

Parallels Desktop allows you to make screen shots of the guest operating system window when guest OS is running. Click **Make Screen Shot** in the **Actions** menu. The first screen shot file will have the file name *Parallels Picture.png* and will be placed on the desktop; the next screen shots will have the same name with the appropriate number added.
CHAPTER 5

Creating a Virtual Machine

This chapter describes how to create a new virtual machine and install a guest operating system. The chapter includes an overview of the process and complete how-to instructions.

In This Chapter

Overview............................................................................................................................................... 53
Typical Configurations....................................................................................................................... 55
OS Installation Assistant .................................................................................................................... 56
Installing Guest OS ............................................................................................................................ 74
Capturing and Releasing the Keyboard and Mouse Input. .............................................................. 83
Installing Parallels Tools .................................................................................................................. 84
Uninstalling Parallels Tools in Windows............................................................................................. 96
Uninstalling Parallels Tools in Linux .................................................................................................. 97
Updating Parallels Tools .................................................................................................................... 97

Overview

Generally, the process of creating a virtual machine consists of several steps:

1 Creating a virtual machine configuration. It's like building a real computer from hardware components. This step is performed by using OS Installation Assistant (page 57). In Windows Express and Typical modes, OS Installation Assistant creates a virtual machine with configuration typical for the selected guest OS. To create a virtual machine with other than typical configuration, choose Custom mode. For details see Typical configurations below.

2 Installing a guest operating system. When you have got the computer's hardware, you need an operating system to control this hardware. For Windows XP and Windows Vista virtual machines OS Installation Assistant creates a virtual machine configuration and installs an operating system for you automatically. For other guest operating systems OS Installation Assistant creates a virtual machine configuration and starts the installation that you continue by yourself. For how to install the guest OS in other cases see the notes on Installing Guest OS (page 74).

3 Installing the Parallels Tools in the guest OS. Tools are available for most of the Windows OSes, and some tools are available for Solaris, OS/2, and eComStation. See Installing Parallels Tools (page 84).
After completing these steps you may proceed with "fine tuning" of the virtual machine, such as setting up shared folders, adjusting screen resolution if needed, and installing applications.

Note. For Windows XP and Windows Vista guest operating systems, Kaspersky internet Security is available from the Actions menu. To install it in the guest OS, choose Install Kaspersky Internet Security from the Actions menu.
**Typical Configurations**

A typical virtual machine includes the following *basic* virtual hardware:

- memory
- a hard disk drive
- a floppy drive
- a CD/DVD-ROM drive
- a network adapter
- a sound device (except for FreeBSD and MS-DOS configurations)
- a USB controller (in Windows 98/ME/2000/XP/2003/Vista and all of the Linux typical configurations)
- a parallel (LPT) port for Windows 95/98/ME/NT/XP/2003/Vista and OS/2. In configurations for Windows Guest OSes, the parallel port is connected to the printer set as the default in Mac OS X. If Parallels Desktop detects no printers connected to the Macintosh computer, it doesn't add a parallel port to the configuration.

**Note.** When virtual machine is created, you can add hardware with the help of Configuration Editor.

Amounts of memory and hard disk sizes vary for different guest OSes. Refer to the table below for the memory amount and the hard disk size that a typical virtual machine will have for the particular guest operating system. The virtual hard disk for typical virtual machines is always created in expanding format.

<table>
<thead>
<tr>
<th>Operating systems</th>
<th>RAM, MB</th>
<th>HDD, GB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista, XP</td>
<td>512</td>
<td>32</td>
</tr>
<tr>
<td>Windows 2003</td>
<td>384</td>
<td>32</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>256</td>
<td>32</td>
</tr>
<tr>
<td>Windows ME/98</td>
<td>256</td>
<td>8</td>
</tr>
<tr>
<td>Windows NT</td>
<td>128</td>
<td>8</td>
</tr>
<tr>
<td>Windows 95</td>
<td>128</td>
<td>2</td>
</tr>
<tr>
<td>Windows 3.11</td>
<td>64</td>
<td>2</td>
</tr>
<tr>
<td>Linux</td>
<td>256</td>
<td>32</td>
</tr>
<tr>
<td>FreeBSD</td>
<td>256</td>
<td>32</td>
</tr>
<tr>
<td>OS/2 Warp 4</td>
<td>128</td>
<td>2</td>
</tr>
</tbody>
</table>
### OS Installation Assistant

This section describes how to use the main tool for creating a virtual machine - **OS Installation Assistant**.

To start OS Installation Assistant do one of the following:

- Choose **New** from the **File** menu.
- Click the **New** button in the **Select virtual machine** dialog that opens on Parallels Desktop startup.

<table>
<thead>
<tr>
<th>OS/2 Warp eComStation 4.5</th>
<th>256</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>other OS/2</td>
<td>128</td>
<td>2</td>
</tr>
<tr>
<td>Solaris</td>
<td>256</td>
<td>32</td>
</tr>
<tr>
<td>MS-DOS</td>
<td>32</td>
<td>2</td>
</tr>
<tr>
<td>Other guest OSes</td>
<td>256</td>
<td>8</td>
</tr>
</tbody>
</table>
Overview

The assistant offers several installation modes. You can choose the mode that better fits your needs or your experience with Parallels Desktop. Regardless of what method you select, you will be able to change the configuration of the virtual machine later using the Configuration Editor (page 155).

Windows Express Installation

This installation mode is available only for two guest operating systems: Windows XP and Windows Vista. OS Installation Assistant not only creates a virtual machine configuration, it automatically installs the guest OS using some default options. It is the easiest way to get a new virtual machine. You only need to insert an installation disc with Windows XP or Windows Vista. See Express Installation (page 58). In this mode, virtual machines are created with typical configurations (see Typical Configurations (page 55) for details) and placed to the default folder (see below).

If you have a printer connected to your Macintosh computer which is set as a default printer, OS Installation Assistant will connect it via parallel port to the virtual machine.

After installing the operating system, the assistant automatically installs Parallels Tools.

Typical Installation

Typical Installation is designed for new users and for fast virtual machine creation. You only have to specify the type and version of the guest operating system that will be installed, and where to store the virtual machine files. OS Installation Assistant creates a typical (for the selected guest OS) virtual machine configuration and starts the installation of the guest OS as interactive installation. See Typical Installation (page 62).

Custom Installation

Custom installation is intended for experienced users only. It allows the user to create configurations other than typical ones. In this installation mode, the user is prompted to specify such options for the basic hardware, as the amount of RAM, a size and format of a virtual hard disk, and networking option. Additional devices can be added later using the Configuration Editor (page 155). After OS Installation Assistant creates a virtual machine configuration, it starts installing the guest OS if such option is selected. See Custom Installation (page 67).

Default Folder for Virtual Machines

By default, Parallels Desktop is configured to place a new virtual machine into home folder of the user who created it:

/</userDomain>/Documents/Parallels/,

where <userDomain> stands for the user's home folder.

However, you can select other folder as a default folder for the virtual machines.

To specify another default destination for saving virtual machines do the following:
1 Choose Preferences from the Parallels Desktop menu.
2 On the General tab of the Preferences window, specify the destination volume and a folder for virtual machines in the Default folder for virtual machines field. It will be used as a default location.

Note. You can specify a folder for a virtual machine when creating it. An existing virtual machine can also be moved to a different folder after it is created.

Windows Express Installation

1 Start Parallels Desktop. Click the New button in the Select virtual machine dialog or select New from the File menu. The Welcome window of OS Installation Assistant appears.
2 Select the Windows Express option. Click Next.
3 Select Windows XP or Windows Vista. Unattended installation is available only for these two operating systems.

4 Enter the product key for your copy of Windows and personal information required for the operating system installation.
5 By default, the virtual machine gets its name by the name of the operating system that will be installed. If such a virtual machine already exists, you will be prompted to specify another name. The name should be no longer than 50 characters. Click More Options if you want to specify other than the default location for the virtual machine.

6 Choose the preferable way of allocating the computer resources: to the virtual machine or to Mac OS X.
Now, if you have an installation disc with the selected Windows OS, insert it into the CD/DVD-ROM drive of your Macintosh computer.

If you have an ISO image of the installation disc, click More Options to open the list of available options. Select the ISO image option and click the Choose button to specify the pathname for the image file.

Click Finish and leave Parallels Desktop for a while. It will create a new virtual machine for you and install the guest OS. Parallels Desktop installs the guest OS, and right after that it installs Parallels Tools.

During the unattended installation, Parallels Desktop creates an administrator account with a blank password. When the guest OS installation is complete, we recommend that you change the password in order to protect the safety of your data.

To change the administrator password in Windows XP (Professional):
- Click the Start menu, then select Control Panel -> Administrative Tools -> Computer Management.
- In the Computer Management window, open System Tools -> Local Users and Groups -> Users. Right-click the Administrator account and select Set Password in the context menu.

To change the administrator password in Windows Vista:
- Click the Start menu, then select Control Panel -> User Accounts and Family Safety -> Change your Windows password.

For changing password in other versions of Windows refer to the Microsoft Help: Start -> Help and support.
Now, you have the opportunity to install Kaspersky Internet Security program in your Windows XP or Windows Vista guest operating systems. Choose **Install Kaspersky Internet Security** from the **Actions** menu.

**Troubleshooting**

There may be problems with localized versions of Windows XP and Windows Vista installed in a virtual machine with the help of Windows Express mode. If your Mac OS X is set to English as the default language, and you install a localized version of Windows in the virtual machine, there may be problems with displaying the Windows Start menu options or the **All Programs** list correctly.

To work around this problem set the Mac OS X regional settings to the same language that the Windows is localized to. When the installation of the guest OS is complete, you can return the language and regional settings back to the original values.

**Typical Installation**

1. Start Parallels Desktop. Choose **New** from the **File** menu. OS Installation Assistant starts.
2. Select the **Typical** option. Click the **Next** button to continue.
3 In the next dialog specify the type and the version of the guest operating system you want to install in a new virtual machine. When the guest operating system is specified, click **Next**.
4 After that, specify a descriptive name for the virtual machine. The name is needed for identification of the VM and is important if you plan to create several VMs running the same operating system. The name should be no longer than 50 characters. Both virtual machine configuration file and hard disk file will be placed to the same default folder. To set a new default destination folder choose Preferences from the Parallels Desktop menu and open the General tab. Please refer to the General Tab (page 206) topic in the Setting Parallels Desktop Preferences section.
Choose the preferable way of allocating the computer resources: to the virtual machine or to Mac OS X.

If you have the installation files of the selected operating system on a CD/DVD, insert the disc into the CD/DVD-ROM drive and click Finish.

If you have the OS installation files on the ISO image file/files, click More Options. Select the ISO image option and choose the image file. Click Finish to start the installation.
If you don't want to install the guest OS right now, clear the check box for the **Start <guest OS> installation** option. To learn how to start the installation later refer to the **Installing Guest OS** (page 74) section.

When the installation is complete, install Parallels Tools if they are available for the guest OS you just installed. Refer to the **Installing Parallels Tools** (page 84) section.
Custom Installation

1. Start Parallels Desktop. Choose New from the File menu. In the OS Installation dialog select the Custom option. Click Next.

2. In the Select guest OS dialog specify the type and the version of the guest operating system you want to install in a new virtual machine. Click Next.
3 In the next dialog set the amount of RAM for the new virtual machine. We strongly recommend that you allocate no more than a half of the physical RAM installed on your computer. You can choose any value from 4 to 1500 MB. Use multiples of 4 MB to specify the amount of memory. Click Next.
4 Decide whether you want to create a new virtual hard disk, use an existing one, use Boot Camp partition or even not to add any disk at all. If you have selected to use an existing hard disk image, go directly to step 8. If you have decided not to add any disk at all (to use a Live CD instead), proceed to step 9. For how to use Boot Camp partition refer to the Using Boot Camp Partition (page 250) chapter.
5 If you selected to create a new virtual disk on the previous step, specify its size and format. Disk formats options are briefly explained in the dialog, but a more detailed description is available in the Format of The Virtual Disk (page 19) topic. Click **Next**. Proceed to the Step 7.

![Custom Installation](image)

6 If, in Step 4, you decided to use an existing image file as a hard disk for the virtual machine, you have to specify where this disk image is stored. Use the **Choose** button to locate it or type the file name with its path directly into the field.

![Custom Installation](image)
Specify a descriptive name for the virtual machine. Name is important if you plan to create several VMs running the same operating system. The name should be no longer than 50 characters. By default, all the files created for this virtual machine will be saved in a new folder in the default location. The default location is specified on the General Tab (page 206) in the Preferences. If you want to place the virtual machine files to a particular location, open More Options. In the input field the default path and name for the configuration file are shown. Click the Choose button or type the path directly into the field.
Choose the preferable way of allocating the computer resources: to the virtual machine or to Mac OS X.

In the next dialog specify the type of networking for the new virtual machine. *Shared Networking* is recommended: you can access the Internet without making your VM accessible from outside. (See Networking in Virtual Machine (page 152) for more detailed information about different types of networking.) If you do not have a physical network interface card or do not need a network access in this virtual machine, select the *Networking is not required* option.
Click Next. If you have selected Host-only Networking, Shared Networking, or Networking is not required proceed to the step 11 of the current instructions.

10 If you have selected the Bridged Ethernet networking option for the new VM, on this window specify what real adapter must be connected to the virtual one. Select one in the list and click Next.

11 Finally, the assistant prompts you to proceed to guest OS installation. If you have your guest OS installation on the disc, insert it and click Finish.
If you have your guest OS installation on ISO image files, click More Options, and select the ISO image option. Use the Choose button to locate the file.

You may skip the guest OS installation if you selected to use an existing virtual disk or just want to perform the installation later. Clear the check box for the Start <guest OS> installation option. To learn how to start the installation later, refer to the Installing Guest OS (page 74) section.

After the installation is complete, install Parallels Tools if they are available for your guest OS. Refer to the Installing Parallels Tools (page 84) section.

## Installing Guest OS

This section discusses how to install an operating system in a virtual machine.
Installing a Guest Operating System

You can install a guest operating system into a virtual machine from a CD or DVD, or from an image file of such CD/DVD. Some operating systems are available on ISO images only.

In some cases, the installation cannot be performed from a real CD/DVD because of disc reading problems. In such cases, we recommend that you try to install the OS from an ISO image of this disc. ISO images of CD/DVDs can be created using any third party imaging utility. As a rule, installation from the ISO image is performed faster.

Some operating systems are installed only from floppy disks. Most of Intel-based Macintosh computers do not have floppy drives. Nevertheless, you can install such OSes using images of installation floppies or using real floppies and an external USB floppy drive. How to create an image of a floppy disk is described in the Floppy Disk Images (page 21) topic.

General Steps:

1. Start Parallels Desktop.
2. Start OS Installation Assistant by choosing New from the File menu. Choose Express Windows option if you are going to install Windows XP or Windows Vista. Choose Typical or Custom option for other guest OSes. Specify the guest OS correctly, since incorrect specification will affect the performance of your virtual machine.

To Install from Physical CD/DVD or ISO Image

1. Insert the disc into the CD/DVD-ROM drive.
   
   On the virtual machine Configuration Page, click the desired CD/DVD-ROM drive to open its options in Configuration Editor. Make sure that the Enabled and the Connect at startup options are selected.

2. Connect the guest OS installation media to the CD/DVD-ROM drive.
   
   ▪ If you are installing from a real CD/DVD:
     
     Select the Use CD/DVD-ROM option and specify which real drive to connect to the virtual device in the CD/DVD-ROM Drive list.
     
     Insert the CD/DVD disc with the operating system files into the appropriate drive of your computer.
   
   ▪ If you are installing from an .iso image file:
     
     Check the Use image file option and specify the path to the .iso file in the Image File field.

3. Specify the IDE channel for the virtual CD/DVD-ROM. In the Connect to list select 0:1.
4. Click OK in Configuration Editor to save the changes.

5. Start your virtual machine by clicking Start on the toolbar. Follow the installation instructions for the operating system.
Note. When installing a Windows guest OS, you may need to press F8 or other functional keys in a virtual machine. If you use MacBook and MacBook Pro keyboard, you have to press Fn+F8 combination instead. You can configure your Macintosh computer in such a way that you will not have to press the Fn key. Please refer to How to Press F1-F12 and Other Functional Keys in MacBook and MacBook Pro in the Keyboard Shortcuts in a Virtual Machine (page 219) topic.

To Install from a Floppy Image:

1. Select the floppy drive and open its options tab.

   On the virtual machine Configuration Page (page 42) click the Floppy link to open Floppy Options (page 168) in the Configuration Editor. In the Floppy Options tab, make sure that the Enabled and the Connect at startup options are selected.

   Specify the path to the floppy image file with the OS installation in the Image File field.

2. Start the virtual machine clicking Start on the toolbar. Follow the installation instructions for the operating system.

Re-Installing the Guest OS

First of all, with virtual machines, you don't have to re-install the guest OS, just create a new virtual machine, install the guest OS and delete the old machine after moving all the necessary data to the new one.

If, nevertheless, you want to re-install a guest OS in an old VM, please DO NOT install a guest OS other than the one installed before. You should re-install only the SAME guest OS that was installed previously.

If you decide to re-install or repair a guest operating system, you have to change the boot sequence:

- Open Configuration Editor by clicking any device link on the Configuration Page. Then open the Booting Options tab of the General Options (page 156),

- Set the boot sequence to [CD-ROM, Hard Disk, Floppy] or [Floppy, Hard Disk, CD-ROM], if you installed from a CD/DVD or a floppy disk respectively.

During the installation, when the guest OS reboots for the first time, return the boot sequence to booting from hard disk:

- When the virtual machine is off, set the [Hard Disk, CD-ROM, Floppy] sequence, and start the guest OS.
Upgrading Windows XP to Vista

If you already have a Windows XP (Home or Professional edition) virtual machine you can "upgrade-in-place" the operating system to one of supported Windows Vista. Please check the Microsoft web site to learn if such upgrade path officially exists. During such upgrade-in-place only the operating system will be affected, and you won't need to re-install the applications in the virtual machine.

To upgrade Windows XP virtual machine

1. Shut down the guest operating system by using the Windows Start menu.
2. Insert the Windows Vista upgrade disc.
3. Choose Prepare for Windows Vista Upgrade command from the Actions menu.
4. When the necessary preparations are complete, the virtual machine will be started automatically.
5. The upgrade to Windows Vista starts. Follow the on-screen instructions.

You can perform the Prepare for Windows Vista Upgrade operation before you actually start upgrading your Windows XP virtual machine, and you can continue working with Windows XP. If eventually you decide not to upgrade to Windows Vista, you can change the value Vista in the OS version field back to Windows XP using the Configuration Editor, Options -> General Options tab.
Installig Windows 98 as a Guest OS

All Windows 95 and some of Windows 98 installation packages include a bootable floppy (a startup floppy disk). The floppy is used to perform disk partitioning and formatting by means of MS-DOS. Since a modern Macintosh computer do not have a floppy drive, you will need an external USB floppy drive or an image of a boot floppy. Please refer to the Floppy Disk Images (page 21) topic.

If you have a bootable CD with Windows 98 installation, you may use it "as is" or may create an ISO image of the CD.

Below we describe the installation procedure for Window 98, for the case when you have a startup floppy image and a CD-ROM with installation files. The installation of Windows 95 is similar to that.

Preparing a Virtual Machine for Windows 95/98 Installation

We recommend that you use a virtual machine created with a configuration typical for Windows 98 (128MB RAM and 6GB hard disk). If you created a custom configuration, check that virtual machine's RAM and hard disk size meet particular OS's requirements.

Note. For Windows 95 do not create virtual hard disks with more than 2 Gb, they are not supported by the system.

If you have a bootable floppy image, perform the following operations:

1. On the last dialog of the OS Installation Assistant in the More Options, clear the check box for the Start Windows 95/98 installation option and click Finish.

2. Open the Booting Options (page 157) tab in Configuration Editor and set boot sequence to [Floppy, Hard disk, CD-ROM].

3. Open the Floppy options tab in Configuration Editor.

4. Make sure the Enabled and Connect at Startup options are selected. Specify the floppy image in the Emulation section of the tab.

5. Click OK to close Configuration Editor.

Initial Partitioning and Formatting

1. Start the virtual machine. You will see the black screen and messages indicating the process of booting to MS DOS.

2. When prompted, type the following command:

   `fdisk`

   and press Return (Enter). This MS-DOS utility, Fdisk, is used to partition hard disks and floppies.
3 Then you can see the Fdisk options on the screen. Choose the operation to perform, the default choice is 1, press `Return (Enter)` to continue.

```
Microsoft Windows 95
Fixed Disk Setup Program
(C)Copyright Microsoft Corp. 1983 - 1995

**Fdisk Options**

Current fixed disk drive: 1

Choose one of the following:

1. Create DOS partition or Logical DOS Drive
2. Set active partition
3. Delete partition or Logical DOS Drive
4. Display partition information

Enter choice: [1]
```

4 Fdisk prompts you to create a partition. Select the **Create Primary DOS Partition** option if you are going to have only one partition or less than 4.

```
Create DOS Partition or Logical DOS Drive:

Current fixed disk drive: 1

Choose one of the following:

1. Create Primary DOS Partition
2. Create Extended DOS Partition
3. Create Logical DOS Drive(s) in the Extended DOS Partition

Enter choice: [1]
```

Other choices are for the case when you want to create more than 4 partitions. Type 1 and press `Return (Enter)`.

5 Then Fdisk prompts you to define the size of the primary partition. Press `Return (Enter)` if you wish to create a partition of the maximum size available.
To define other size type N and press Return (Enter). You will be prompted to specify the size.

6 Fdisk creates the partition and then prompts you to restart the computer (virtual machine).

7 Reboot the virtual machine using the same image of the boot floppy. That is, press Ctrl+Option (Alt) keys to release the keyboard input and then click the Turn off button ( ) to stop the virtual machine. Then click the Start button ( ).

8 When the booting is complete, you have to format the system drive C:. Type the command:

   format c:

   Confirm that you want to format the disk C: when prompted. Type y and press Return (Enter).

   You may be prompted to choose how exactly to format your disk. Windows 95/98 supports FAT16 and FAT32 file systems.

   FAT16 partition can not be greater than 2 GB. Larger disks can be formatted with FAT32. But do not use larger disks if you are going to run legacy applications.

   The program starts formatting the disk C:.

   Format other disks too (if you created more than one primary partition or if you created a custom virtual machine with more than one disk). Use E:, F: drive letters.

9 Enter a label for each disk (11 character string). The label is optional, you can press Return (Enter) to skip this step.

10 Shut down the virtual machine.

Now, you are ready to start the installation of the system.

**General steps of Windows 98 installation**

1 Start the virtual machine using the same bootable floppy image.
2 Insert the Windows 98 installation CD, or connect an ISO image of the installation disc choosing **CD/DVD-ROM -> Connect Image** from the **Devices** menu.

3 If you created only one primary partition (disk C:), by default, your CD-ROM drive will have the drive letter D:. Type the command:

   ```D:\setup.exe```

   and press Return (Enter). The installation starts, and files are copied from the CD to the virtual hard disk.

4 Follow the on-screen instructions of the Setup. Note that you can add or remove options later.

5 Read and accept the **License Agreement**. Enter the license key.

6 Confirm the default system directory or specify another one.

7 In the **Setup options** dialog choose the type of installation, **typical** is recommended.

8 (only for Windows 98) If you are going to use networking, select the network card when prompted.

9 Turn off the virtual machine.

10 Eject the installation CD or disconnect the ISO image.

11 Open Configuration Editor. Set the boot sequence to **[Hard Disk, Floppy, CD-ROM]**. Close Configuration Editor.

12 Restart the virtual machine. This time, it will boot from the hard disk.

13 Install Parallels Tools: choose **Install Parallels Tools** from the **Actions** menu.

   The sound driver and (in some cases) video driver for Windows 95/98 guest OS require manual installation. Refer to the **Windows 98 Tools Installation** (on page 90) topic.

   Drivers that require manual installation are located on the CD image: **VMTools.iso**, which can be found in the same folder Parallels Desktop is installed: `/Library /Parallels /Tools`.

   You can connect the virtual machine to the Internet. Host-only network option is not available for Windows 95/98 and earlier versions.

**Configuring X Window System in FreeBSD Guest OS**

If you want to use the X Window System graphic shell in a FreeBSD guest OS, you should configure it manually. Running automatic configuration command **X -probeonly** or **X -configure** may not work. The X Window System can be configured using **xorgconfig** text utility or **xorgcfg** graphical utility. You need **root** privileges to run them.

To start manual configuration:

1 Start the virtual machine. Log in as **root**.

2 Type one of the following commands in the command line:

   ```xorgconfig```

   or
**xorgcfg**

**Note.** When configuring, please make sure that you specify video card, its memory and screen resolution for the virtual machine, not for the host computer.

1. For the video card select *Generic VESA compatible*.

2. Select *4096K* of video memory (that is the default value for Parallels virtual machines). If you changed the amount of video memory for your virtual machine in Configuration Editor, select the current value.

3. When selecting screen resolution for a color depth, make sure that the selected resolution for a particular color depth does not require more memory than the virtual machine’s video card has. For *4096K* video card do not select resolutions greater than *800x600* for 16-bit color.
Capturing and Releasing the Keyboard and Mouse Input

This section explains how to capture the input of input devices (like the mouse and keyboard) inside a virtual machine and release the input. Parallels Tools package available for most of Windows and Linux OSes, includes special tools that make capturing and releasing input devices easier.

**Without Parallels Tools**

Generally, the same input devices are used by Mac OS X and the guest OS. When you start a virtual machine, either during a guest OS installation or normal operation, you will need to use the computer's input devices in the virtual machine. For this you have to capture the input of the devices in the virtual machine. To use the input devices in Mac OS X you need to release them to Mac OS X.

**To capture the keyboard and mouse input in the virtual machine**

- Move the cursor over the Guest OS Window and click in the window.

When the mouse and keyboard input is captured, you cannot move the cursor out of the virtual machine window.

**To release the keyboard and mouse to Mac OS X**

- Press the hot key combination designated to release the keyboard and mouse input. The default combination is Ctrl+Alt or Ctrl+Option, it can be changed on the Keyboard (page 214) tab of the Preferences window.

The keyboard and mouse will be released immediately.

**After Parallels Tools Installation**

Parallels Tools are available for most of the Windows OSes. See the Parallels Tools Overview (page 85) to learn if this package is available for your guest operating system. OS Installation Assistant in Express installation mode installs Parallels Tools automatically. In other cases you should install the Tools manually.

After Parallels Tools installation, you can switch the control over the mouse and keyboard input more easily:

- **to capture** - click anywhere in the Guest OS window
- **to release** - click anywhere outside the Guest OS window
Installing Parallels Tools

Parallels Desktop includes specially developed tools that help you use your virtual machines in the most comfortable and efficient way. The current version of Parallels Desktop provides tools for the following guest operating systems:

- OS/2 and eComStation.
- Linux operating systems with x.org-7.0 and later.
- Solaris. We provide RTL8029 driver for Solaris guest OS to support networking.
- For other guest operating systems we provide RTL8029 network adapter driver.

Parallels Tools are located on the CD image VMTOOLS.ISO; however, the network drivers for OS/2 are also available on the floppy disk image VMTOOLS.FDD. Both CD and floppy images can be found in the folder: /Library /Parallels /Tools.
Parallels Tools Overview

The current version of Parallels Desktop includes the following tools.

**Clipboard Synchronization Tool**

The Clipboard Synchronization Tool synchronizes the guest OS clipboard and the Mac OS X clipboard, making the exchange of texts and pictures via clipboard possible. Currently, you can transfer only text up to 128 KB in size.

If you enable the Clipboard Synchronization Tool in all of your guest OSes, all of them will share the same clipboard with Mac OS X.

In the Windows guest OSes, this tool is installed automatically with Parallels Tools installation. In OS/2 and eComStation you must install it manually.

**Note.** If you installed other time synchronization software, please stop it before installing Parallels Tools in order to avoid potential conflicts.

**Coherence Tool**

Available only for Windows 2000/2003/XP/Vista guest OSes. Coherence Tool re-paints Windows application windows on Mac OS X desktop when the virtual machine is switched to Coherence mode.

**Disk Compacting Tool**

Parallels Desktop uses virtual hard disks of two types: plain and expanding. Expanding virtual disks grow in size as you work with them. The Disk Compacting Tool cleans up unused space on an expanding virtual disk and reduces the size of that disk file in Mac OS X. See Compacting Virtual Disk (page 231) for guidelines on using this tool.

**Note.** This tool does not reduce the size of files of virtual disks in plain format.

**Drag-and-Drop Tool**


**Dynamic Resolution Tool**

Dynamic Resolution Tool allows you to work with dynamic resolution. Drag the lower right corner of the Guest OS window to resize the window, and the resolution will change automatically now in both Windows and Linux guest OSes.

**Favorite Applications Tool**
Available only for Windows 2000/2003/XP/Vista guest OSes. Favorite Applications Tool enables you to manage your favorite Windows applications. You can assign some applications running in Windows virtual machine as Favorite applications. Favorite applications appear on the Applications menu (the Favorite Applications section), and aliases for them appear on Mac OS X desktop. Clicking such an alias starts the virtual machine and your favorite Windows application in it.

**File Sharing Tool**

This tool lets you access guest OS files and folders directly from Mac OS X.

**Mouse Synchronization Tool**

The Mouse Synchronization Tool (now available for Windows and Linux guest OSes) helps capture the mouse input automatically when the pointer intersects the guest OS window border from outside and releases the mouse input when the pointer moves from the guest OS window. This tool also makes mouse movements smoother.

**Network Adapters and Drivers**

Parallels Tools provide the following adapters:

- **Parallels Network Adapter.** This Ethernet driver for the RTL8029 adapter is specially developed for Parallels Desktop to improve network performance.

- **RTL8029.** Parallels Tools include native Realtek drivers for the RTL8029 network adapter for many different operating systems. They are located in the `vmtools.iso` file that can be found in the `Drivers\Network\RTL8029` folder.

Some guest operating systems such as Windows 2000, provide an RTL8029 driver, whereas others like Windows 2003 and OS/2 do not include this driver at all.

**Note.** Unlike other guest OSes, a Solaris guest OS requires an RTL8029-compatible driver to support networking. Otherwise, networking will not be possible.

An RTL8029-compatible driver for Solaris has been created by an independent developer and is distributed under the terms of BSD license. A slightly modified version of this driver is included into the Parallels Desktop Tools.

**Shared Applications Tool**

With this tool you can open guest OS documents with Mac OS X applications.

**Shared Folders Tool**

This tool is needed for a guest OS to view shared folders. Without it, the guest OS can not use the shared folders although they may be set up in your virtual machine configuration. To learn more about shared folders see Using Shared Folders (page 200).

**Shared Internet Applications Tool**
This tool lets you define the same default Internet application for http, mail and ftp Internet links in the guest OS and in Mac OS X. For example, open web pages by Safari no matter where you open them, in the virtual machine or in Mac OS X.

**Sound Driver**

Parallels Tools pack includes an AC'97 sound driver for those guest operating systems that do not have a standard AC'97 driver. Sound drivers for Windows XP/2003 are not included in the Parallels Tools pack, since these operating systems have sound drivers in their installations.

**Start Menu Integration Tool**

Open the Windows Start menu directly from the Dock by right-clicking the Parallels Desktop icon - the **Start** menu item appears on the shortcut menu. Or open the Windows Start menu directly by clicking the Parallels Desktop icon in the Dock.

**Time Synchronization Tool**

The Time Synchronization Tool allows the guest OS to keep the same system time as the primary OS. Without this tool the guest OS system time may differ from that of the primary OS.

This tool also allows you to maintain a constant difference in time between the guest and primary OSes. You may configure this tool while the guest OS is running. See Time Synchronization Tool Options (page 117).

**Video Driver**

The best graphical mode available in Windows NT and 2000 guest operating systems without this driver is 16-color VGA with 640x480 resolution. The video driver allows Parallels Desktop to use SVGA graphical modes in guest OS monitors.

In Windows 2000/XP/2003/Vista the video driver is required for the functioning of the Mouse Synchronization Tool and is chosen automatically when you select the Mouse Synchronization Tool in *custom* installation.

**Note.** If you install the video driver, you will not be able to use VGA modes. To return to VGA, you must uninstall the Parallels Tools.
Parallels Tools Available for Different Guest OSes

The table below shows which tools have been developed for a particular operating system.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Windows</th>
<th>OS/2, eCS</th>
<th>Linux</th>
<th>other</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Windows</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>95, 98, NT, ME</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>2000</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>XP, 2003, Vista</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Parallels Tools Available for Different Guest OSes</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clipboard Synchronization Tool</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Time Synchronization Tool</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drag-and-Drop Tool</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Sharing Tool</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shared Internet Applications Tool</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start Menu Integration Tool</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shared Applications Tool</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coherence Tool</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Favorite Applications Tool</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dynamic Resolution Tool</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Video Driver</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Mouse Synchronization Tool</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Sound Driver</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shared Folders Tool</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk Compacting Tool</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Network Drivers:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Parallels Network Adapter Driver</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- RTL8029</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
</tbody>
</table>

*Parallels Desktop for Mac User Guide*
In Windows guest OSes you can control the tools during guest OS execution. See the Parallels Tools Center (page 115) section to learn how to do this.

**Installing Parallels Tools in Windows**

If you created a Windows XP or Windows Vista virtual machine using OS Installation Assistant in Express Windows Installation (page 58) mode, then you don't have to install Parallels Tools - they were installed automatically. In all other cases you have to install Parallels Tools.

To install Parallels Tools in a Windows guest OS do the following:

1. Make sure that the virtual machine configuration includes a CD/DVD-ROM drive, and it is enabled (the **Enabled** check box is selected). See CD/DVD-ROM Options (page 173).

2. Start your virtual machine and log into the guest operating system.

3. Choose **Install Parallel Tools** from the **Actions** menu.

4. Parallels Tools Setup program starts. Click **Next**.

5. In the **Choose Destination Location** dialog click **Next** to install Tools to the default folder. Use the **Change** button to specify other location. Then click **Next**.

6. In the **Setup Type** dialog choose between the **Complete** and **Custom** setup. The **Complete** setup installs all of the tools available for your guest OS. The **Custom** setup allows you to choose the tools you want to install. If you selected the **Complete** setup, proceed to Step 8.

7. If you selected the **Custom** setup, in the **Select Features** dialog select the desired tools from the list of the tools available for your guest OS, and click **Next**.

8. In the **Ready to Install the Program** dialog, click **Install**.

9. Wait while the Installer copies the files.

10. The **Installation Completed** dialog prompts you to restart the computer now. For all of the Windows guest OSes, except Windows 98 and NT, you must restart the virtual machine. Click **Restart**.

**Notes:**

1. In a Windows 98 guest OS, you have to manually install the Sound Driver. Please refer to Windows 98 Sound Driver Installation (page 90).

2. For how to complete tools setup in a Windows NT guest OS, please refer to Windows NT Tools Installation (page 92).

**Troubleshooting when installing Tools**

If the installation of Parallels Tools doesn't start automatically, follow these steps:

1. Make sure that the **vmtools.iso** file is connected to the virtual machine CD-ROM drive.

2. Start Parallels Tools installation manually. For this, click **Start -> My Computer**. Right-click the CD-DVD-ROM icon and choose **Open** from the shortcut menu. View the contents of the **vmtools.iso**, find **PrlTools.exe** file, and double-click it to start it.
Installing Parallels Tools in Linux

Parallels Tools are now available for Linux guest OSes with X.org versions 7.0, 7.1 and 7.2. See Parallels Tools Available for Different Guest OSes (page 88).

**Warning.** Before starting Parallels Tools installation close all the open applications to prevent data loss during possible X-Server restart.

To install Parallels Tools:

1. Start the virtual machine.
2. When the guest OS is loaded, log in as the root.
3. Press Ctrl+Option(Alt) to release the keyboard and mouse input to Mac OS X. From the Actions menu choose Install Parallels Tool. The ISO image of Parallels Tools installation CD will be connected to the virtual machine.
   
   By default, in Mac OS X, the image file can be found: /library/Parallels/Tools/vmtools-linux.iso
4. Click anywhere in the Guest OS window to capture the keyboard and mouse input in the guest OS.
5. Start the terminal.
6. Make sure the CD-ROM is mounted.
7. Change the directory to the CD-ROM and run the installer by the command:
   
   ```sh```
   parallels-tools.run
   ```sh```
8. Wait while Parallels Tools are being installed...
9. Restart the virtual machine.

Windows 98 Tools Installation

The sound driver for a Windows 98 guest OS requires manual installation which is performed after the general Parallels Tools installation is complete. It is described in the Installing Parallels Tools in Windows (on page 89) topic. In some cases you may need to manually install the video driver too.

Make sure the Parallels Tools ISO image (`vmtools.iso`) is connected. Click the CD icon on the status bar. Choose the Connect image option and specify the location of the image. Image can be found in the folder: `/Library/Parallels/Tools`. Locate the image and click Open.

AC'97 Sound Driver Installation

1. Open the Control Panel. To do this, click the Start system menu, select Settings, and then Control Panel.
2. Double-click the System icon to open the System Properties window. In the System Properties window select the Device Manager tab.
Creating a Virtual Machine

3. Locate the PCI Multimedia Audio Device in the hardware list. Select it and click the Properties button.

4. In the PCI Multimedia Audio Device Properties window click the Reinstall Driver button.

5. In the Update Device Driver Wizard select the Sound, video, and game controllers item and click Next.

6. In the next window select the second option: Display a list of all the drivers in a specific location, so you can select the driver you want, and click Next.

7. In the window asking you to select the type of device click Next.

8. In the next window click the Have Disk button. The Install From Disk window is opened, in the Copy manufacturer's file from: field type the following path "C:\Program Files \Parallels \Parallels Tools \Sound" and click OK.

9. In the Select Device window select the AC'97 Audio and click OK.

10. In the Update Device Driver Wizard click the Next button. When the wizard asks, insert the disc (or connect the CD-ROM image file) with your Win98 installation files and type the path to it in the field Copy files from. Click OK. After wizard finishes copying files, click Restart.

11. Close the windows with AC'97 audio properties and system properties.

12. If prompted, restart the virtual machine for the new settings to take effect.

Video Driver Installation

1. Open Control Panel. To do this, click the Start system menu, select Settings, and then Control Panel.

2. Double-click Display icon to open the Display Properties dialog box.

3. Click the Settings tab.

4. Click the Advanced button.

5. On the Adapter tab, click the Change button.

6. The Update Device Driver Wizard appears. Click the Next button.

7. Choose the Search for a better driver than the one your device is using now, and then click Next.

8. Select Specify a location option. Click Browse. In the opened window locate the ISO image with Parallels Tool: choose CD-ROM drive (Prtools) -> Drivers -> Video and choose Win9x, click OK to close the dialog box.

9. Click Next in the Update Device Driver Wizard and then click Next again when the driver is found.

10. Click Finish and then Close to close the Update Device Driver Wizard.

11. Click Close to exit the Display Properties dialog box.

12. When you are prompted to restart the guest OS in the System Settings Change dialog box, click Yes.

Note: To complete the setup you must restart the virtual machine.
Windows NT Tools Installation

To install Parallels Tools in Windows NT:

- Perform the installation procedure described in the Windows Tools Installation (page 89) topic. It is enough to install such tools as Clipboard Synchronization and Mouse Synchronization Tools.
- Perform these specific steps for installing the Video Driver and Sound Driver:

Video Driver Installation

To install the Video Driver do the following:

1. Open the Control Panel. For this click the Start system menu, select the Settings item, and then Control Panel.
2. Double-click the Display icon to open the Display Properties window.
3. In the Display Properties window select the Settings tab. Then click the Display Type button.
4. In the Display Type window select the Change button.
5. In the Change Display window select the Manufacturers -> Parallels and Display -> Parallels Video Driver. Click OK.
6. In the Third-party Drivers window click Yes.
7. The Installing Driver window informs you of the completed installation. Click OK.
8. Click the Close button in the Display Type window.
9. Click the Close button in the Display Properties window.
10. Click the Yes button in the System Settings Change window to restart the guest OS.

Note: You must restart the virtual machine after the setup.

AC'97 Sound Driver Installation

To install the AC'97 Sound Driver do the following:

1. Open the Control Panel. Click the Start button in the system menu. Then select the Settings item, and then Control Panel.
2. Double-click the Multimedia icon to open the Multimedia Properties window.
3. In the Multimedia Properties window select the Devices tab. Then select Audio Devices from Multimedia devices: tree. Click Add button.
4. In the Add window select the Unlisted or Updated Driver from List of Drivers. Click OK.
5. In the Install Driver window click the Browse button and select the sound driver path.
   If you have installed Parallels Tools to the default location, select C:\Program Files\Parallels\Parallels Tools\Sound.
   If you have installed Parallels Tools to another folder, you should locate this folder.
   Click OK. Then click OK in the Install Driver window.
6. In the Third-party Drivers window click Yes.
7 The Add Unlisted or Updated Driver window informs you that you are about to install the AC'97 Audio Driver. Click OK.

8 Click OK in the About AC97 Audio Driver window.

9 Click OK in the System Settings Change window.

10 Click Close button in the Display Type window.

Note: To complete this setup you must restart the virtual machine.

OS/2 and eComStation Tools Installation

All of the OS/2 and eComStation tools can be installed from the vmtools.iso file located in the folder: /Library /Parallels /Tools.

Network drivers can also be installed from the floppy disk image file vmtools.fdd during the operating system installation. The latter is easier in most cases.

Before starting the installation connect the CD-ROM image with Parallels Tools to your virtual machine CD-ROM drive. Do the following:

- Select Install Parallels Tools from the Parallels Desktop Actions menu.

Mouse Synchronization Tool Installation

The Mouse Synchronization Tool consists of the mouse driver and the video driver.

Note. To install the Mouse Synchronization Tool you should have a VESA video driver installed, such as SDD or GENGRADD. For instructions on how to do this refer to OS/2 documentation.

To install the mouse tool:

1 Click the Drives icon on the system panel. Select the CD-ROM drive and Drivers\Mouse\OS2 folder on it.

2 Launch the INSTALL.CMD batch file. The INSTALL.CMD copies files and makes necessary modifications to the CONFIG.SYS file.

3 Restart the guest OS/2 operating system.
Note: The Mouse Synchronization Tool increases performance of the guest OS/2 operating system under Citrix.

Clipboard Synchronization Tool Starting

In OS/2 and eComStation you must start the Clipboard Synchronization Tool manually. This tool is an ordinary application. If you want the Clipboard Synchronization tool to start automatically when your guest operating system is started:

- include the tool file PrlClip.exe into the autostart group (startup.cmd or another file as it is done in your operating system).

The Clipboard Synchronization Tool is located in the ClipBrd\OS2 folder on the vmtools.iso containing Parallels Tools.

Sound Driver Installation

Note: In OS/2 guest OS, before installing the Sound Driver install the multimedia support.

To install the Sound Driver:

1. Click the System Setup icon on the system panel.
2. Select the Install/Remove line, and then select Multimedia Application Install.
3. In the IBM Multimedia Presentation Manager/2 - Installation window choose CD-ROM drive, then Drivers\Sound\OS2 folder. Select the ALC Codec option and click the Install button.
4. Restart the OS/2 guest operating system.

Network Driver Installation

To install the Realtek RTL8029 driver inside the OS/2 Warp version 4.0.

1. Click the System Setup icon on the system panel.
2. Click the MPTS Network Adapters and Protocol Services icon to open the Multi-Protocol Transport Services window.
3. Click Configure.
4. In the Configure window, click Configure again to open the Adapter and Protocol Configuration window.
5. Click the Other adapters button below the Network Adapters section of the window to open the Copy Additional Network Adapter Drivers window.
6. Specify the path to the Parallels driver on CD-ROM disc image. The path should be:
   `<CD-ROM drive> \Drivers \Network \RTL8029 \NDIS2OS2`
7. Click OK. The Parallels network adapter driver will be copied. After this you can see the name RTL8029 PCI Ethernet Adapter included in the Network Adapters list. Select this name.
8. Click Change in the Network Adapters section of the window to change the current network adapter into the selected one.
9 Click OK when the message "Are you sure you want to change this network adapter?" is displayed. After that, the RTL8029 PCI Ethernet Adapter appears in the appropriate field of the Current Configuration section of the window. Now if you click Edit in the Current Configuration section of the window, you will see that you do not need to configure any driver properties, because they are self-configurable.

10 Click OK when finished.

11 Close both the Configure and Multi-Protocol Transport Services windows.

12 Click Exit in the Update CONFIG.SYS window.

13 Exit the configuration program and restart the guest OS.

Solaris Network Driver Installation

Unlike other guest OSes Solaris does not support the RTL8029 network driver emulated in virtual machines. To add RTL8029 support to a Solaris virtual machine you have to install the RTL8029 network adapter driver. Use the special network.sh script, or you install and configure the driver manually. Both ways are described below.

Before Installing the Driver

Before installing the driver perform the following steps:

1 Make sure that the virtual machine configuration includes a CD/DVD-ROM drive, and it is enabled. See CD/DVD-ROM Options (page 173).

2 Start your guest operating system.

3 Connect the vmtools.iso file to the CD/DVD-ROM drive of the virtual machine:
   ▪ right-click the CD/DVD-ROM icon on the status bar and select the Connect image on the contextual menu (also, you may select Devices -> CD/DVD-ROM <number> -> Connect Image in the menu);
   ▪ browse for vmtools.iso in the folder where you installed Parallels Desktop.

Proceed to the RTL8029 network driver installation, use the network.sh script or do it manually.

To install the RTL8029 network driver using network.sh script

1 In the shell, run the
   
   ```
   cd /cdrom /PRLTOOLS /Drivers /Network /RTL8029 /SOLARIS/
   ```
   command to move to the respective directory.

2 Issue the following command to begin installing the driver:
   
   ```
   ./network.sh
   ```

3 You are sequentially informed that the driver is being extracted, compiled, and installed. When it is finished, you are asked "Will you receive IP addresses from DHCP server?" If IP addresses on your network are managed by DHCP server proceed to step 4, otherwise proceed to step 5.

4 If IP addresses on your network are managed by DHCP server, type "y" and the script will configure the DHCP client. Proceed to step 6.
5 If IP addresses on your network are NOT managed by DHCP server, type "N" and then specify an IP address for your virtual machine, network address, network mask, and default gateway IP address when you are asked for them.

6 Restart the guest operating system by issuing the command

```
init 6
```

To install the RTL8029 network driver manually

1 In the shell, issue the following command to get root privileges:

```
su
```

Enter the password to the root account when prompted.

2 As a root run the following commands:

```
set /tmp

gzcat /cdrom/PRLTOOLS /Drivers /Network /RTL8029 /SOLARIS
/nio.8.11.tgz |tar xvf -
cd ni-0.8.11
/usr/ccs/bin/make install
./addni.sh
```

3 If IP addresses on your network are managed by DHCP server issue the following commands:

```
touch /etc/hostname.ni0

touch /etc/dhcp.ni0
```

If IP addresses on your network are NOT managed by DHCP server, see the Solaris System Administration Guide.

4 Leave the root account by running the command

```
exit
```

5 Restart the guest operating system by the command:

```
init 6
```

---

Uninstalling Parallels Tools in Windows

In all Windows guest operating systems you can uninstall Parallels Tools by using the general program removing procedure.

For example, in Windows XP Professional:

1 Click Start -> Control Panel - > Add / Remove Program (or Start -> Settings -> Add Remove Programs depending on the selected appearance of the guest OS).

2 Select Parallels Tools from the list of programs installed.

3 Click Remove.
Uninstalling Parallels Tools in Linux

To uninstall Parallels Tools:

1. Start the virtual machine.
2. Log in the guest OS as root.
3. Press Ctrl+Option(Alt) to release the keyboard and mouse input to Mac OS X. Locate the ISO image file of Parallels Tools. By default, it can be found in the folder:

   /library/Parallels/Tools/vmtools-linux.iso.
4. Connect the image to the CD-ROM drive by clicking the drive's icon on the status bar and selecting Connect the Image from the shortcut menu.
5. Click anywhere in the Guest OS window to capture the keyboard and mouse input in the guest OS.
7. Mount the CD-ROM to the guest OS file system.
8. Change the directory to the CD-ROM and run the uninstaller by the following command:

   sh prl-tools-uninstall.sh
9. Restart XServer or the virtual machine.

Updating Parallels Tools

If you have updated Parallels Desktop, you may have virtual machines created by a previous version of Parallels Desktop with Parallels Tools installed. Please update Parallels Tools to use all the capabilities of Parallels Tools Center.

To update Parallels Tools do the following

1. Make sure that the virtual machine configuration includes a CD/DVD-ROM drive and it is enabled (the Enabled check box is selected). See the CD/DVD-ROM Options (page 173).
2. Start your virtual machine and log into the guest operating system.
3. Select the Install Parallel Tools command from the Actions menu.
4. Parallels Tools Setup wizard informs you that Parallels Tools must be updated.
5. In the Setup Type window choose the type of setup: complete or custom. If you select the complete setup, all of the tools available for your guest OS will be installed. If you select custom setup, in Select Components window select tools from the list of tools available for the guest OS.
   Click Next.
6. In the Ready to Install the Program window click Back to review the installation settings. When ready, click Install.
If your Windows guest system is configured to warn you every time an unsigned driver is installed, click **OK** to disable warnings during Parallels Tools installation. They will be re-enabled later when the installation is complete.

If your system is configured to block the unsigned drivers installation, always allow the installation of Parallels drivers; otherwise, Parallels Tools will not be installed.

The wizard copies necessary files. The **Update Completed** window prompts you to restart the virtual machine. Click **Restart**.

If during updating Parallels Tools in the Windows 98 guest OS, Parallels Tools installer cannot install a video driver, you'll get the message about this problem. In this case you should install Parallels video driver manually. See the Windows 98 Tools Installation (on page 90) topic.
Running Virtual Machine

This chapter provides the information on what you can do with a virtual machine while the guest operating system is running.

In This Chapter

Overview ................................................................. 99
Selecting and Opening a Virtual Machine ................................................. 100
Starting and Stopping Virtual Machine .............................................. 102
Switching to Full Screen ............................................................... 107
Switching to Coherence ................................................................. 108
Running Windows Guest OS ....................................................... 109
Accelerated 3D-Graphics Support ..................................................... 111
Customizing View ........................................................................ 111
Parallels Tools Center ............................................................... 115
Changing Configuration at Runtime ............................................. 126
Ejecting CD/DVD ........................................................................ 133
Using USB Devices in a Virtual Machine ......................................... 133
Setting up a Printer in Virtual Machine ............................................. 133

Overview

When you start the virtual machine, Parallels Desktop window transforms into the Guest OS window which acts like a virtual machine display (refer to OS Window topic (page 44) ). Click inside this window to capture your keyboard and mouse input in the guest OS. To release the mouse and keyboard input from the guest OS to Mac OS X press Ctrl+Option(Alt).

Parallels Desktop toolbar and menus allow you to control the virtual machine when it is running in window mode. You may also run the virtual machine in Full screen mode or to Coherence mode.

Parallels Desktop controls let you to do the following:

- Start up, turn off, and reset the virtual machine.
- Pause or suspend the virtual machine.
- Switch between the guest OS and Mac OS X.
- Connect and disconnect devices (enabled in the configuration), and change the media accessed by them.
- Switch to Full screen mode (and to Coherence mode that is available for Windows guest OSes only).
- View the Configuration Page of the virtual machine. Configuration Editor cannot be accessed while the virtual machine is running.
Selecting and Opening a Virtual Machine

This section describes different ways of selecting and starting virtual machines.

Selecting from the Select virtual machine dialog

Whenever you start Parallels Desktop, it opens with the Select virtual machine dialog over the Configuration Page of a new blank virtual machine.
Running Virtual Machine 101

The **Select virtual machine** dialog displays the list of virtual machines available on your computer. If no virtual machines were found, Parallels Desktop opens OS Installation Assistant.

With the **Select virtual machine** dialog you can:

- Use the **New** button to create a new virtual machine with OS Installation Assistant.
- Click the **Select** button to open the virtual machine that is highlighted in the list.
- Click **Choose** to locate a virtual machine that is not in the list (on an external USB storage or on the network).
- Click **Cancel** to exit Parallels Desktop.

Some helpful tips:

- Point the cursor to any virtual machine in the list and view its description in a pop up help tag. Such description helps correctly identify the virtual machines with similar names. You can provide each virtual machine with concise description in the **General Options** tab of the **Configuration Editor**.
- If the number of available virtual machines exceeds 5, the **Search** field appears in the upper right corner of the dialog. Type any string of characters to filter the list of virtual machine names. As you type, Parallels Desktop selects and lists only those VM names that match the string anywhere in the name: at the beginning, in the middle, or at the end.
- If your virtual machine is configured to start up when you select it in the **Select virtual machine** dialog or when you click its alias, to open its Configuration Page do the following: start Parallels Desktop; in the **Select virtual machine** dialog while pressing the **Cmd** key highlight the desired virtual machine and click the **Select** button.

Using Aliases for Virtual Machines

You can create an alias for a particular virtual machine on the desktop or in the Dock. To create an alias open the virtual machine and while pressing the **Command+Option** keys drag the yellow Parallels Desktop icon from the title bar to the desktop or into the Dock.

**Note.** Clicking the alias for the virtual machine that currently is not running starts another instance of Parallels Desktop and starts the guest OS automatically.

Starting Favorite Windows Applications from Mac OS X

Now you have the option of creating aliases for your favorite Windows applications on the Mac's desktop or in the Dock.

1. First, choose **Preferences** from the **Parallels Desktop** menu, open the **Appearance** tab. Make sure that the **Show applications in Dock** option has **Always** or **In Coherence** value.

2. Start your Windows virtual machine.

3. Start any of your favorite Windows applications in the virtual machine. When the application is started, its icon appears in the Dock.

4. To create an alias for your favorite Windows application right-click the application icon in the Dock and from its shortcut menu select **Add to Favorites**.
5 The application alias appears on the Mac OS desktop. Clicking this alias lets you start the virtual machine and the application in it automatically when the virtual machine is stopped. The application name also will appear in the Applications menu in the Favorites section when the virtual machine is running. This will allow you to start this application from the menu next time you run this virtual machine.

6 To keep the favorite application icon in the Dock permanently, right-click the application icon in the Dock, and choose Keep in Dock from the application shortcut menu. The application icon will stay in the Dock even when the virtual machine is stopped.

When the virtual machine is stopped, you can launch the favorite Windows application by clicking its icon in the Dock or by double-clicking the application alias on the Mac OS X desktop. In either case, a new instance of Parallels Desktop will be created, and the virtual machine where the favorite application is installed will start automatically in Coherence mode.

To remove an application from Favorites:

- When the virtual machine is running, and the application is open, right-click the application icon in the Dock, and choose Remove from Favorites from the shortcut menu.

**Opening a Virtual Machine When Another VM Is Running**

When a virtual machine is running, you cannot open another instance of Parallels Desktop via the Dock or Finder.

To open another virtual machine:

- Choose Open from the File menu to open instance of Parallels Desktop. It displays the Select virtual machine dialog. Select from the list or click Choose to locate an existing virtual machine or click New to create a new one.
- Click an alias for the desired virtual machine on the Desktop. A new instance of Parallels Desktop will be created, and the guest OS will start automatically.

**Starting and Stopping Virtual Machine**

This section provides the information on how to start and stop a virtual machine. Also, it describes how to pause or suspend a virtual machine and how to resume its work.

**Starting a Virtual Machine**

To start a virtual machine do one of the following:

- Start Parallels Desktop. From the list of available virtual machines select the desired virtual machine. See Selecting and Opening a Virtual Machine (page 100).
  - Click the Start Virtual Machine ( ) button on the Parallels Desktop toolbar.
  - Choose Start from the Actions menu.
Click the virtual machine alias on the desktop or in the Dock. In this case, the guest OS starts automatically.

You can see the booting process of the guest OS in the OS window. If no guest OS is installed, you will see the black screen with the following message: "No boot device is available".

If you don't see the toolbar on the Parallels Desktop window, refer to the Toolbar topic (page 45) to learn how to open toolbar or change its position.

**Note.** The virtual machine can be started up only if you have activated your copy of Parallels Desktop, see Activating Parallels Desktop (page 30).
Stopping and Resetting a Virtual Machine

The same rules are applied to turning off a virtual machine as to turning off a real computer.

Stopping a Virtual Machine

First, shut down a guest operating system by using the guest OS "shut down" command (such as Start -> Shut Down or Start -> Turn off Computer in Windows). It is STRONGLY RECOMMENDED that you shut down the machine in this way to ensure safety of your data. Then close the application window.

Only if you are unable to stop the guest OS this way, you may use the Parallels Desktop controls to stop it.

To force the virtual machine to stop, do one of the following:

- Click the Stop virtual machine button.
- Choose Stop from the Actions menu.
- Right-click the virtual machine icon in the Dock and select Quit from the shortcut menu. If you configured your virtual machines to stop on Quit, the virtual machine will be stopped. See Setting Parallels Desktop Preferences, General Tab (page 206).

Resetting a Virtual Machine

First, restart a guest operating system by using the guest OS "restart" command (such as Start -> Shut Down -> Restart or Start -> Turn off Computer -> Restart in Windows). It is STRONGLY RECOMMENDED that you restart the machine in this way to ensure safety of your data.

Only if you are unable to restart the guest OS this way, you may use the Parallels Desktop controls to stop or reset it.

To reset a virtual machine anyway, do one of the following:

- Choose Reset from the Actions menu.
- Select Actions -> Send Key -> Ctrl+Alt+Del in the menu.
- Press Ctrl+Option(Alt)+Del while the keyboard input is captured inside a virtual machine window.

Note. MacBook and MacBook Pro users may need to press Ctrl+Option(Alt)+Fn+Del exactly in this order.
Suspending and Resuming a Virtual Machine

The state of the running virtual machine, and states of all running inside the virtual machine applications, can be saved. This operation is called **suspending** the virtual machine. Later, you can start the virtual machine and continue running the guest OS from the point where you stopped it.

When the virtual machine is suspended, its state is saved in a file with the `.sav` extension. The file is placed into the folder where the configuration file of the virtual machine is located.

**Suspending a Virtual Machine**

To suspend a virtual machine:

1. When virtual machine is running, choose **Suspend** from the **Actions** menu.
2. You can see the progress of saving the virtual machine's state process on the **Please wait while virtual machine is suspending** dialog.

**Note.** It is not allowed to edit the configuration of the suspended virtual machine. If you attempt to edit it anyway, the `.sav` file will be deleted, and you will not be able to resume the virtual machine.

**Resuming a Suspended Virtual Machine**

To resume a suspended virtual machine:

1. Open the suspended virtual machine in Parallels Desktop.
2. Do one of the following:
   - Click the **Start** button.
   - Choose **Start** from the **Actions** menu.
3. Wait until the guest OS state is resumed. The progress is displayed on the **Please wait while virtual machine is resuming** dialog.

After the virtual machine has been resumed, its `.sav` file is deleted.
Pausing a Virtual Machine

When a virtual machine is paused, the guest OS is stopped and the virtual machine process is removed from the CPU processes list. Execution of the guest operating system can be resumed at any time.

Pausing the guest OS is recommended if you want to stop working with the virtual machine for a short period of time.

If you want to leave it for an extended time interval, and, especially, if you need to restart Mac OS X, it is better to suspend the virtual machine. See Suspending and Resuming Virtual Machine (page 105).

To pause a virtual machine:

- Select **Pause** in the **Actions** menu.
- Click the Pause button on the toolbar.

When a virtual machine is in paused mode, its Guest OS window is grayed out.

To continue running the virtual machine do one of the following:

- Click the **Start** button on the toolbar.
- Click **Continue** from the **Actions** menu.
Switching to Full Screen

You can run a guest operating system in full screen when the guest OS window occupies the whole screen with Mac OS X and the Parallels Desktop controls being hidden. To see Mac OS X Dock and Parallels Desktop application menu while in full screen, press Ctrl+Option(Alt).

You may choose the type of animation that is displayed when switching to full screen and back. For details please refer to Setting Parallels Desktop Preferences section, Appearance tab (page 211).

Switching Between Modes

If you want to switch to full screen while running a guest OS, do one of the following:

- Click the Full Screen mode toolbar button.
- Choose Full Screen from the View menu.
- Press the appropriate hot key combination, by default, it is Option(Alt)+Return(Enter).

To return to window mode:

- Press the appropriate hot key combination, by default, Option(Alt)+Return(Enter).
- Press Ctrl+Option(Alt) to view Parallels Desktop application menu and select another display mode from the View menu.

Hot key combinations are defined on the Keyboard tab of the Preferences. For details see the Keyboard Tab (page 214).
Switching to Coherence

Coherence is a new mode in which you can run the virtual machine. For a complete description of Coherence mode see Overview of Coherence Mode (page 138).

To switch a running virtual machine to Coherence mode do one of the following:

- Click the icon on the toolbar.
- Choose Coherence from the View menu.
- Press the appropriate key combination, by default, Shift+Ctrl+Option(Alt). Hot keys are defined on the Keyboard tab in Preferences.

To switch a virtual machine back from Coherence to other mode:

- Select OS window from the View menu.
- Select Full screen from the View menu.
- Select VM Configuration from the View menu to switch to Configuration Page.
- Press the appropriate key combination, by default, Shift+Ctrl+Option(Alt).

If your virtual machine is configured not to show the Windows task bar in Coherence mode (see the Customizing View (page 111) topic), to open Windows Start menu, click the virtual machine icon in the Dock.
Running Virtual Machine

Running Windows Guest OS

There is a number of special features for the virtual machines with Microsoft Windows 2000/XP/2003/Vista guest operating systems provided by Parallels Tools. When running such a virtual machine, you can do the following:

- Switch between different view modes: Full screen, Coherence, Guest OS window.
- View running Windows applications in the Dock and in the Applications menu, Running section.
- Drag and drop files between Mac OS X and Windows applications. For details and options available for drag-and-drop operations please see the Shared Folders (page 163) topic in the Editing Virtual Machine Configuration section.
- When in full screen, view the Dock and Parallels Desktop menu by pressing the Control+Option (Alt) keys.
- Resize the guest OS window by dragging its lower right corner with the resolution being automatically adjusted.
- Work in Coherence mode when you see Windows applications windows directly on Mac OS X desktop.
- Use the same hot key combinations in the Windows guest OS as you would in Mac OS X (refer to the Keyboard Tab (page 214) topic in the Setting Preferences section). See also Keyboard Shortcuts in Virtual Machine (page 219).

Creating Aliases for Favorite Applications

You can add a Windows application to Favorite applications:

2. Right-click the application icon in the Dock.
3. Choose Add to Favorites from the shortcut menu. An alias for the application appears on the Mac OS X desktop. Favorite application appears also on the Applications menu of Parallels Desktop in the Favorites section.
4. Right-click the application icon in the Dock and choose Keep in Dock to create an alias for application in the Dock.
Create the icons in the Dock or aliases on Mac's desktop to all your favorite Windows applications. Clicking such an alias starts the virtual machine and then, the Windows application in it. The virtual machine starts in Coherence mode right away.

**Smart Select**

In the virtual machine you can open Mac OS X applications. The list of Parallels Shared Applications is created during the installation of Parallels Tools. The list includes your Mac OS X applications and is available when you choose All Programs -> Parallels Shared Applications from the Windows Start menu. You can select any application from the list and start it.

Right-click your document in Mac OS X or Windows and choose any available Mac OS X or Windows application from the Open With list.

You can also choose the default application for opening files of a certain type both in Mac OS X and in Windows. When you start any Windows application for the first time you will be prompted to decide if you want to set this application as a default application for opening files (with supported extensions) in Mac OS X.

**Note.** SmartSelect feature is enabled only if the Global sharing option is selected. The Global sharing option can be found on the Shared Folders tab in Configuration Editor.

**Troubleshooting problems with file sharing in Windows Vista**

User Account Control (UAC) is a new security component of Windows Vista. When turned on, it doesn't allow some operations with Windows files being performed from Mac OS X. So, for example, when in Mac OS X you are trying to copy a Windows file you will see the warning like the one below.

![Warning message]

To turn off UAC in Windows Vista do the following:

1. Open the Windows Start menu, open Control Panel.
2. Click the User Accounts icon.
3. Click the Turn User Security Control (UAC) on or off link.
4. Clear the check box for the Turn on User Account Control to make your computer more secure option.
Accelerated 3D-Graphics Support

The current version of Parallels Desktop support OpenGL and Direct X. After installation of Parallels Tools in the Windows 2000/XP/2003/Vista guest operating systems, you can run many 2D or 3D graphics applications and games.

**Running OpenGL applications**

You don't need to configure the virtual machine for running OpenGL applications and OpenGL games.

**Running DirectX applications**

To run DirectX applications and games you have to enable DirectX support in the virtual machine, see the Video Options (page 165) topic.

Customizing View

You can customize the Parallels Desktop main window and set several options for Coherence mode using the **Customize View** dialog. For this: choose **Customize** from the **View** menu. The dialog has two tabs: **Main Window** and **Coherence**.
Main Window Options

To open the Main Window tab choose Customize from the View menu.

On the Main Window tab you can change the position of the Parallels Desktop toolbar and choose another set of the toolbar buttons.

- **Toolbar placement** option controls the position of the Parallels Desktop toolbar. By default, the toolbar is located on the right side of the Parallels Desktop window. You can move it to the top, or to the left.
- **Show toolbar** option lets you specify whether you want the toolbar to be displayed with the Parallels Desktop window.
- **Icon set** option lets you choose the set of icons for toolbar buttons. You can choose one of several options. See also the Toolbar (page 45) topic. Alternatively, you can create your own set of icons for toolbar buttons. See the topic below in this section.

Adding New Icon Set for Toolbar Buttons

In addition to available several sets of icons for toolbar buttons you can create your own icon set and add it to the available sets.

For this, do the following:

1. Right-click the Parallels Desktop bundle located in the folder: Applications/Parallels/. Choose Show Contents from the shortcut menu.
2. Choose Contents -> Resources -> Iconsets.
3. In the Iconsets folder there are several folders, among them: Modern and Standard. Copy one of the folders and give a new name to the copy of the folder. This name will appear in the Icon set list in the Customize View dialog.
4 Open the new folder. For each toolbar button there are three files, each contains a 32X32 icon in PNG format. One file contains an icon of the button in disabled state, the second - in enabled state, and the third - in clicked state. For example, for the Pause button there the following files: `tb_pause_enabled.png`, `tb_pause_disabled.png` and `tb_pause_clicked.png`.

Replace the icons for all or the selected buttons. Use only PNG format. Do not change the names of the files. Do not add or remove any files: the number of files must not change.

5 The new icon set will appear in the View -> Customize dialog, on the Main Window tab and on the Appearance tab in Configuration Editor.

**Coherence View Options**

To open Coherence options choose Customize from the View menu.

Options on the Coherence tab are available only if the guest OS supports Coherence mode. For details see Overview of Coherence Mode (page 138). These options are also available on the Coherence Options tab in Configuration Editor. If you change them on the Coherence tab, they automatically will be changed on the Coherence Options tab and vice versa.
Windows Taskbar:

- **Show.** Select this option if you want Windows taskbar to be displayed on the screen while you run a virtual machine in Coherence mode. If you clear the check box, you still will be able to open the Windows Start menu by right-clicking the virtual machine icon in the Dock and choosing the **Start** menu from the VM's shortcut menu.

- **Relocate automatically.** This option is enabled only when the above option is selected. If the **Relocate automatically** option is selected, Parallels Desktop automatically relocates the Windows taskbar if its position interferes with the Dock’s position and finds the best position for the task bar (always shows the entire bar even when several displays are used).

Working area:

- **Exclude Dock.** Select this option if you do not want Windows applications to occupy the screen area already occupied by the Dock.

- **Use multiple displays.** Select this option if you are using more than one displays. It will let you expand Coherence mode to several displays, that is, to have guest Windows applications on the specified displays. If this option is off, then Coherence will take place on one display only.
Parallels Tools Center

**Note.** Parallels Tools Center is available in Windows guest OSes only (see Parallels Tools Overview (page 85) for tool descriptions and availability table).

Parallels Desktop allows you to control the status of Parallels Tools in the Windows guest OSes. The **Parallels Tools Center**, which is installed along with Parallels Tools, allows you to:

- check the status of various tools;
- temporarily disable and enable each tool separately (for those tools that can be stopped without interfering with the guest OS execution);
- configure specific tool (for tools that have options).

The window of Parallels Tools Center is organized as a set of tabs, each tab contains settings for an individual tool. Parallels Tools Center contains tabs only for tools that you have installed in your guest OS (in case you performed custom installation of Parallels Tools).

Parallels Tools Center is started automatically upon guest OS startup; its icon is placed into the guest OS system tray.

**Opening Parallels Tools Center**

To open Parallels Tools Center:

- Click Parallels yellow icon 🍭 in guest OS system tray.
- Choose All programs from the Windows Start menu, choose Parallels -> Parallels Tools.

**Applying changes:**

After you have made the desired changes on the tab, do the following:

- Click Apply to activate changes and proceed to the next tab.
- Click OK to activate changes and hide the Parallels Tools Center.

**Stopping and Restarting Parallels Tools Center**

You can stop Parallels Tools Center temporarily if needed. When Parallels Center is stopped, only Network, Video, Mouse synchronization, Coherence and Shared Folders tools continue functioning (if available for the particular guest OS).

To stop Parallels Tools Center:

1. Right-click the Parallels Tools Center icon in the status area and choose **Exit**.
2. To confirm stopping, click **Yes**. To cancel, click **No**.
Restarting Parallels Tools Center

To restart Parallels Tools Center after it was stopped:

- Locate the `ParallelsToolsCenter.exe` file in the default folder:
  
  C:\Program Files\Parallels\Parallels Tools\
  
  Double-click the file to start Parallels Tools Center.

- From the Windows Start menu, choose **All programs -> Parallels -> Parallels Tools**.

Clipboard Synchronization Tool Options

![Clipboard Synchronization Tool Options](image-url)
Status:

- **Enabled** shows the current status of the Clipboard Synchronization Tool. To temporarily disable this tool, clear this check box. You can enable the Clipboard Synchronization Tool by selecting this option later.

Current clipboard content:

- This field displays the current clipboard contents that can be scrolled.
- The **Clear** button empties the clipboard contents.

Description:

- Displays the short description of the tool. For a complete description see the Parallels Tools Overview (page 85).

Activating changes:

After you have made the desired changes on the tab, do one of the following:

- Click the **Apply** button to activate changes.
- Click the **OK** button to activate changes and hide the Parallels Tools Center.

### Time Synchronization Tool Options

![Time Synchronization Tool Options](image)

The **Time Synchronization** tool allows guest OS to keep the same system time as the primary OS. Without this tool the guest OS system time may differ from the primary OS system time.

To synchronize the guest OS system time with the primary OS, select the **Enabled** checkbox and set the desired value in the **Synchronization interval** field.

This tool also allows you to maintain a constant difference between the guest OS system time and primary OS system time. To use this feature, enable the Time Synchronization, select the **Keep time difference** checkbox, and set the desired current time for the guest OS. The Time Synchronization will calculate the last advance value at the moment when guest OS time is set and will maintain it.
Status:

- **Enabled** check box shows the current status of the Time Synchronization Tool. To temporarily disable this tool, clear the check box.

**Note:** If you installed other time synchronization software, please stop it before installing Parallels Tools in order to avoid potential conflicts.

Advanced options:

- **Synchronization interval, sec.** defines the period of time between two synchronization operations. Use scroll buttons to set the desired value or type it directly into the field. The available range is from 10 to 3600 seconds.

  To synchronize the guest OS system time with the primary OS time:
  
  1. select **Enabled**,
  2. set the desired value of the synchronization interval in the **Synchronization Interval** field.

- **Keep time difference between primary and guest OS** option allows you to maintain a constant difference between the time in the guest OS and the time in Mac OS X.

  To use this feature:
  
  1. select **Enabled**,
  2. select the **Keep Time Difference** option,
  3. in the guest OS, set the desired time.

  The Time Synchronization Tool will calculate time difference automatically and will maintain it.

Description:

- Displays the short description of the tool. For a complete description see the Parallels Tools Overview (page 85).
Video Driver Options

Status:
- **Enabled** check box shows the tool's current status but is not available for editing.

Description:
- Displays the short description of the tool. For a complete description see the Parallels Tools Overview (page 85).
Mouse Synchronization Tool Options

Status:
- **Enabled** check box shows the tool's current status. Clear the check box to temporarily disable the tool.

Description:
- Displays the short description of the tool. For a complete description see the Parallels Tools Overview (page 85).
Network Driver Options

Status:

Enabled check box shows the current status of the Parallels Network Adapter Driver. When this check box is selected, Parallels Network Adapter Driver is active. We recommend that you use this driver. However, you can disable it to use the native Realtek RTL8029 driver by clearing the Enabled check box. Drivers can be changed without restarting the guest operating system, but your network connection may be temporarily lost.

Description:

- Displays the short description of the tool. For a complete description see the Parallels Tools Overview (page 85).
Disk Compacting Tool Options

Status:

- The table displays the list of volumes located on the expanding virtual hard disks connected to your virtual machine and formatted to Windows file systems. Volumes formatted to other file systems are not displayed even though they are located on the expanding virtual hard disks. In the table you can select the volumes to be processed by the Disk Compacting Tool.

- **Execute all stages at once.** Select this option if you want to perform both stages of the compacting at once. See the description of the two stages of the compacting process in the Compacting Virtual Disk (page 231) topic.

- **Start** button starts the process of preparing the virtual hard disks for compacting.

Description:

- Displays the short description of the tool. See the complete description and guidelines in the Compacting Virtual Disk (page 231) topic.

**Note.** Compacting of virtual disks cannot be performed if the virtual machine has the Undo disks option enabled or if it has snapshots.
## Shared Folders Options

![Parallels Tools Center](image_url)

### Status:
- **Enabled** check box shows the tool's current status but is not available for editing.

### Advanced Options:
- **Place shortcut on the desktop** option controls the presence of the Parallels Shared Folders shortcut on the guest OS desktop.

### Description:
- Displays the short description of the tool. For a complete description see the Parallels Tools Overview (page 85).
Favorite Applications Tool

Favorite Application Tool provides possibility to start favorite Windows applications directly from Mac OS X.

**Status:**
- **Enabled** check box shows the tool's current status but is not available for editing.

**Description:**
- Displays the short description of the tool. For a complete description see the Parallels Tools Overview (page 85).

For more details on how to configure favorite applications see the Starting Favorite Windows Applications from Mac OS X (page 101) topic.
**Coherence Tool**

Available only for Windows 2000/2003/XP/Vista guest operating systems, Coherence Tool provides the integration of guest OS applications and Mac OS X. For details see Overview of Coherence Mode (page 138).

**Status:**
- **Enabled** check box shows the tool's current status but it is not available for editing.

**Description:**
- Displays the short description of the tool. For a complete description see the Parallels Tools Overview (page 85).
Changing Configuration at Runtime

Although the Configuration Editor (page 155) cannot be accessed while the virtual machine is running, you can connect or disconnect certain devices at runtime or switch some of them for using other media.

Generally, the following virtual devices can be connected or disconnected at runtime:

- CD/DVD-ROM drives
- Floppy disk drive
- Network adapter
- Parallel and serial ports
- Sound device
- USB device
- Shared folders

Only devices enabled in the virtual machine configuration can be connected or disconnected at runtime.

The devices configurable at runtime can be configured in the following ways:

- by using commands from the Devices menu in the menu bar;
- by clicking a device icon on the status bar and choosing command from a device shortcut menu;
- (for CD/DVD-ROMs, floppy drives and shared folders only) by dragging and dropping the image file (shared folder) on the appropriate device icon on the status bar.
Connecting a CD/DVD-ROM Drive

If you start a guest operating system with the CD/DVD-ROM drive enabled, you can connect or disconnect the drive and change the media it accesses at runtime.

Note: If the guest OS was started with the CD/DVD-ROM drive disabled, you should shut down the guest OS first, then enable the CD/DVD-ROM drive in the Configuration Editor and start up the guest OS.

To control the CD/DVD-ROM drive at runtime use Devices menu on the menu bar.

If you have several CD/DVD-ROM drives connected to your virtual machine, in the Devices menu they are listed in the same order as they were connected. The first CD/DVD-ROM drive will be CD/DVD-ROM 1, the second will be CD/DVD-ROM 2, and so on.

To disable all CD/DVD-ROM drive operations while running the guest OS choose CD/DVD-ROM -> Disconnect from the Devices menu.

To reconnect the CD/DVD-ROM drive again choose CD/DVD-ROM -> Connect from the Devices menu.

To change media accessed by the CD/DVD-ROM drive

Do one of the following:

- Drag and drop an image file (or CD icon) to the CD/DVD-ROM drive icon on the status bar.
- Choose the CD/DVD-ROM -> Connect to and CD/DVD-ROM -> Connect image commands from the Devices menu.
- Right-click (Ctrl-click) the CD/DVD-ROM icon on the status bar (page 47) and choose the appropriate command from the device shortcut menu.
Connecting a Floppy Drive

If you start a guest operating system with the floppy drive enabled, you may connect/disconnect it and replace the image file it accesses at runtime.

Note: If the floppy drive is disabled, you should shut down the guest OS first, then enable the floppy in the Configuration Editor (select the Enabled check box in the Floppy Options (page 168) tab) and power on the virtual machine.

To connect or disconnect the floppy drive:

- Choose Floppy -> Connect or Floppy -> Disconnect from the Devices menu.

To connect or replace the image file accessed by the virtual floppy do one of the following:

- Choose Floppy -> Connect image command in the Devices menu; locate the image file and select it.
- Right-click (Ctrl-click) the floppy drive icon on the status bar (page 47) and choose the Connect image command from the device shortcut menu.
- Drag and drop an image file onto the device icon on the status bar.

Connecting a Network Adapter

If a network adapter is enabled in your virtual machine configuration, you can connect/disconnect it while running the guest OS.

Note: If the network adapter is disabled, shut down the guest OS first, then enable the network adapter in the Configuration Editor (select the Enabled check box in the Network Adapter Options (page 175) tab) and power on the virtual machine.

To connect or disconnect the network adapter, do one of the following:

- Choose Network from the Devices menu, then select the Connect or Disconnect command.
- Right-click the network adapter icon on the status bar (page 47) to display the shortcut menu and choose appropriate command.
Connecting a Serial Port

If a serial port is enabled in your virtual machine configuration, you can connect or disconnect the port while running the guest OS.

Note: If serial port is disabled, shut down the guest OS first, then enable the serial port in the Configuration Editor (select the Enabled check box in the Serial Port Options (page 179) tab) and start the virtual machine.

To connect or disconnect the serial port, do the following:

- Click the Devices menu; select COM (from 1 to 4 depending on how many serial ports are enabled), then select the Connect or Disconnect command.
- Right-click the serial () port icon on the status bar (page 47) to display the shortcut menu, and choose appropriate command.

Connecting a Parallel Port

If a parallel port is enabled in your virtual machine configuration, you can connect or disconnect the port while running the guest OS, and connect printer or an output file.

Any printer connected to your Macintosh computer, including a network printer, can be connected to the virtual machine via parallel port.

Note: If the parallel port is disabled, shut down the guest OS first, then enable the parallel port in the Configuration Editor (select the Enabled check box in the Parallel Port Options tab (page 178)) and start the virtual machine.

If a parallel port is enabled in your virtual machine configuration, you can:

- disconnect the port,
- connect output file,
- connect a printer.

To disconnect the parallel port, do the following:

- Click the Devices menu; select appropriate parallel port (from 1 to 3 depending on how many parallel ports are enabled), then select Disconnect.
- Right-click the parallel () port icon on the status bar (page 47) to display the shortcut menu, and choose Disconnect.

To connect a printer or a output file to the port, do one of the following:

- Click the Devices menu; select Parallel port (from 1 to 3 depending on how many parallel ports are enabled), then select Connect to parallel.txt or a desired printer from the list of printers connected to your Macintosh computer.
- Right-click the parallel () port icon on the status bar to display the shortcut menu, and choose the output file or an appropriate printer from the list.
Connecting a Sound Device

If a sound device is enabled in your virtual machine configuration, you can connect or disconnect it while running the guest OS.

Note: If the sound device is disabled, shut down the guest OS first, then enable the sound device in the Configuration Editor (select the Enabled check box in the Sound Options (page 180) tab) and start up the guest OS.

To connect or disconnect the sound device, do one of the following:

- Click Sound from the Devices menu, choose Activate to connect the sound device (or select Mute to disconnect).
- Right-click the sound device icon 🎧 on the status bar (page 47) to display the shortcut menu and choose appropriate command.
Connecting USB Devices

If the USB controller is enabled in the virtual machine configuration, you can connect or disconnect USB peripherals at runtime. Please refer to Using USB Devices in a Virtual Machine (page 133) for general information.

**Note:** If the USB controller is disabled, shut down the guest OS first, then enable the USB controller in the Configuration Editor (select the **Enabled** check box in the USB Options (page 181) tab) and start the virtual machine.

Parallels Desktop automatically detects all USB devices plugged into your Macintosh computer. To view the list of USB devices currently available on a computer choose the **USB** from the **Devices** menu or click the USB controller icon (⏏️) in the status bar. The devices that are currently connected to the virtual machine appear in the list as selected, that is, with the mark to the left. You cannot use a USB device in Mac OS X while it is being used by the virtual machine.

You may configure your virtual machine to automatically connect USB devices when they are plugged, or not connect them automatically. Refer to the USB Options (page 181) topic in the Editing Virtual Machine Configuration section.

**Warning.** Do not connect Macintosh USB devices, such as USB mouse or USB keyboard to the virtual machine. If this happened, shut down or restart the guest OS to disconnect them.

Note that a USB microphone is connected to a virtual machine in a special way. See below in this section.

**Auto-Connection**

If the **Connect USB device automatically** option in the USB Options (page 181) tab is turned on, any USB device when plugged in will be connected automatically to your virtual machine.

To disconnect any USB device from virtual machine and make it available in Mac OS X:

1. Choose **USB** from the **Devices** menu.
2. Select the USB device with the mark in the list.
The device will be disconnected from the virtual machine, and the mark against the device will disappear while the device will stay in the list - now it can be used in Mac OS X. When you unplug the device, it will disappear from the list.

**Manual Connection**

If the **Connect USB device automatically** option in the USB Options (page 181) tab is turned off, to connect a USB device to the VM do the following:

- Plug in a USB device into your Mac.
- Click the USB controller icon in the status bar (or choose **USB** from the **Devices** menu) to display the list of all USB devices available on your Macintosh computer.
- Choose the desired USB device in the list and click it to connect. The device will appear on the list with a check mark.

Note that only 8 USB 2.0 devices can be connected simultaneously.

To disconnect any USB device from the virtual machine and make it available in Mac OS X:

- Choose **USB** from the **Devices** menu.
- Select the USB device with the mark in the list.

**Connecting a Microphone**

A USB microphone appears in the list of USB devices connected to your Macintosh computer (in the **Devices -> USB** menu and in the shortcut menu for the USB controller ( ) but it should be connected by the guest OS means (only then it will be visible to your guest OS).

**Connecting Shared Folders**

If shared folders are enabled in your virtual machine configuration, you can connect or disconnect a particular shared folder or all shared folders at once.

**Note:** If the shared folders are disabled, shut down the guest OS first, then enable the Shared folder in the Configuration Editor (select the **Enabled** check box on the Shared Folders Options (page 163) tab) and start the virtual machine.

To connect or disconnect a shared folder, do one of the following:

- From the **Devices** menu; select **Shared Folders**, then select the appropriate folder from the list of folders defined in the virtual machine. If the selected folder had no a check mark (was disconnected), a check mark will appear against its name, indicating that the folder becomes connected. To connect or disconnect all folders at once choose **Connect All** or **Disconnect All**.
- Right-click the shared folders ( ) icon on the status bar to display the shortcut menu. Choose the appropriate shared folder from the list or choose **Disconnect All** or **Connect All**.
Ejecting CD/DVD

In any guest OS press the **Eject** key on the keyboard (the triangle with the line underneath).

In Windows guest OSes you may use also the following method:

- Click **Start -> My Computer**, then right-click (or Ctrl-click) the desired CD/DVD-ROM drive, and choose **Eject** from the context (shortcut) menu.

Using USB Devices in a Virtual Machine

The current version of Parallels Desktop emulates the 8-port USB 2.0 and 2-port USB 1.1 controller. This means that up to eight 2.0 USB peripherals can be connected to a virtual machine simultaneously. This number does not include an USB keyboard, USB mouse, and USB microphone that will be connected in any case even if the virtual machine doesn't have a USB controller.

Parallels Desktop lets you connect USB devices to virtual machines automatically when they are plugged in. See the USB Options (page 181) section to learn how to turn this option on. And see the Connecting USB Devices (page 131) section to learn how to connect a USB device to a virtual machine at runtime both automatically and manually.

Setting up a Printer in Virtual Machine

There are four basic ways of setting up printing in a virtual machine:

- Use any of the printers connected to your Macintosh computer via a parallels port of your virtual machine.
- Set up a USB printer.
- Set up a printer via Apple's Bonjour Printer wizard. This way is available in Windows guest OSes only.
- Use a network printer.

How to configure a virtual machine for printing is described in the topics below.
Sharing a Mac Printer

You can set up any printer connected to your Macintosh computer for use in the virtual machine. Printer will be available via a virtual machine's parallels port.

1. Open the virtual machine configuration in Configuration Editor. Make sure that the configuration includes a parallel port; if necessary, add it. See Adding a Parallel Port (page 195).

2. Open the **Parallel Port Options** tab, and make sure that the **Enabled** option is selected. Select **Connect at startup**, if you want the printer to be automatically captured on the virtual machine startup. Select the **Use printer** option. Click **OK** to close Configuration Editor.

3. Start the guest operating system.

4. In the guest OS, no matter what type of printer you have, install either the HP Color LaserJet 8500 PS, or Apple Color LW 12/660 PS printer driver.

**Warning.** Do not install the driver from the installation CD, supplied with your printer, in the virtual machine.

To add a printer in the Windows guest OS:

1. Start the Windows guest operating system and log in as administrator.

2. Open the Windows Start menu, select **Settings**, then select the **Printers and Faxes** (or **Printers**) item.

3. Open the Add Printer wizard:
   - In Windows 95/98/NT/ME/2000/2003 double-click the **Add printer** icon.
   - In Windows XP click the **Add a printer** link.

4. In the Add Printer wizard:
   - In Windows 2000/XP/2003:
     - click **Next** in the wizard's first dialog,
     - in the **Local or Network Printer** dialog, click **Local printer attached to this computer**.
   - In Windows 98/ME:
     - click **Next** in the wizard's first dialog,
     - for the **How is this printer attached to your computer?** select the **Local printer** option.
   - In Windows 95/NT:
     - click **Local printer**.

5. Continue the general installation procedure and install either HP Color LaserJet 8500 PS or Apple Color LW 12/660 PS driver.
Setting Up a USB Printer

To setup a USB printer:

1. Open the virtual machine configuration in the Configuration Editor (page 155), and make sure that the configuration includes a USB controller; if necessary, add it. See Adding a USB Controller (page 198).

2. Open the USB Options tab, and make sure that the Enabled option is selected. Select the Autoconnect at startup if you want the printer to be automatically captured by the virtual machine. Click OK to close Configuration Editor.

3. Start the guest operating system.

4. Plug in the USB printer as a USB device. See the Connecting USB Devices (page 131) topic.

5. Install the native driver for the printer in the guest OS.

Setting Up a Printer via Bonjour

Note. This way of configuring a printer is available only in Windows guest OSes.

To set up a printer using the Bonjour Printer wizard:

1. Start your Windows virtual machine and log in.

2. In the virtual machine, download the Bonjour for Windows installation package from the Apple site (http://www.apple.com/macosx/features/bonjour/).

3. Install Bonjour for Windows by launching the BonjourSetup.exe file from the folder to which it was downloaded.

4. Start the Bonjour Printer wizard either by clicking its icon on the desktop or by selecting Start -> Programs -> Bonjour -> Bonjour Printer wizard.

5. Follow the installation steps until the Install Bonjour Printer window appears.

6. In the Install Bonjour Printer window, select Generic in the Manufacturer list and then Generic / Postscript in the Model list for any printer model you are going to use.

7. Follow the rest of installation steps.
Setting Up a Network Printer

Before installing a network printer in a guest OS make sure that your primary OS and the virtual machine meet the following requirements:

- Networking in your primary operating system is configured.
- Virtual machine configuration includes the network adapter that is connected to a real network adapter of your computer. See the Network Adapter Options (page 175) of your virtual machine; make sure that the **Enabled** and the **Connect at startup** options are selected in the **Device Status** group. In the **Emulation** group the **Bridged Ethernet** option should be selected and the real network interface should be chosen in the **Network Adapters** list.
- Networking in the guest OS is configured.
- User account from which you will setup the printer has permission to access the network printer.

In a Linux or FreeBSD Guest Operating System

Make sure that the following components are installed in your guest Linux or FreeBSD system:

- Common UNIX Printing System (CUPS). Installation instructions can be found at CUPS site ([http://cups.org/documentation.php](http://cups.org/documentation.php));
- Samba service. Installation instructions can be found at Samba site ([http://us4.samba.org/samba/docs/man/Samba-HOWTO-Collection/install.html](http://us4.samba.org/samba/docs/man/Samba-HOWTO-Collection/install.html));
- A Web browser, since we consider controlling CUPS via web interface;

Also you have to know the root password.

To add a network printer in a Linux or FreeBSD guest OS:

1. Start your Linux or FreeBSD guest operating system.
   In a terminal, type the command:

   ```
   /etc/init.d/cups start
   ```

3. Start a Web browser and open either the IP address of your virtual machine or
   ```
   http://127.0.0.1:631.
   ```

4. Select Printers in menu. Click the Add printer button below the list of available printers (if any).

5. Enter the root password when prompted.

6. In the Add New Printer screen enter the information for easy identification of the printer: a descriptive printer name, location, and description.

7. In the Device for <Printer Name> screen select the Windows Printer via Samba.

8. In the Device URI for <Printer Name> screen specify the path to the network printer in the following format:

   ```
   smb://<computer name>/<printer name>
   ```

9. In the Model/Driver for <Printer Name> screen select the model of your printer.

10. CUPS performs installation. If installation is successful, the "Printer <name> has been added successfully" message is displayed.
In a Windows Guest Operating System

To add a network printer in a Windows guest OS:

- Start the Windows guest operating system and log in the proper account.
- Open Windows Start menu, select Settings and then the Printers and Faxes (or simply Printers) item.
- Open the Add Printer wizard:
  - In Windows 95/98/NT/ME/2000/2003 double-click the Add printer icon.
  - In Windows XP click the Add a printer link.
- In the Add Printer wizard:
  - In Windows 2000/XP/2003:
    - click Next in the wizard's first dialog,
    - in the Local or Network Printer dialog, click A network printer, or a printer attached to another computer.
  - In Windows 98/ME:
    - click Next in the wizard's first dialog,
    - for the How is this printer attached to your computer? select the Network printer option.
  - In Windows 95/NT:
    - click Network printer / server.
- Continue general network printer installation.
This chapter is dedicated to different aspects of working in Coherence mode. The chapter also provides overview of Coherence mode options and includes some helpful tips on its configuring.

Coherence mode is available for Windows 2000 /XP /2003 / Vista guest operating systems with Parallels Tools installed.

In This Chapter

Overview ....................................................................................................................................... 139
Coherence Mode Options........................................................................................................... 142
Overview

When you switch the running virtual machine with one or more applications open into Coherence mode, you will see the Windows applications windows along with open Mac OS X application windows on Mac OS X desktop. On the picture below, you can see the Windows-style window of Paint application on Mac OS X desktop. By default, both Windows taskbar and Mac OS X Dock are present on the screen. The Dock contains the icon of Paint and the Parallels Desktop icon appearing as the virtual machine’s live screen shot with Parallels logo.

If any of Windows application windows is active, you will see Parallels Desktop menu on the menu bar on the top of the screen.
The current version of Parallels Desktop provides more deep integration between guest OS applications and Mac OS X than only visible integration:

- Windows file systems are accessible from Mac OS X and vice versa.
- Transparent file associations in both systems let you open Windows files by Mac OS X applications and Mac OS X files by Windows applications.
- The same default browser and email client can be used in both systems.
- The Dock displays Windows and Mac OS X applications icons.
- Windows Start menu can be accessed from the Dock.

**Switching to Coherence Mode**

Only a running virtual machine can be switched to Coherence mode. Do one of the following:

- Click the icon on the toolbar.
- Choose Coherence from the View menu.

Default hot keys for switching a virtual machine to Coherence mode are: Shift+Control+Option.

Refer to the Switching to Coherence topic (page 108) for complete list of switching options.

**Using Dock in Coherence**

Right-click the Parallels Desktop icon in the Dock to view its shortcut menu. You can select Windows Start menu from the shortcut menu.

As you start a Windows application, its icon appears in the Dock. This is the default option. When application is closed, or the virtual machine is stopped, the application icon disappears from the Dock.

Right-click the Windows application icon in the Dock to open its shortcut menu. Choose Keep in Dock if you want the icon to stay in the Dock even when application is closed. Choose Add to Favorites to create an alias for the application on Mac OS X desktop. Clicking a Windows application icon in the Dock or an alias on the desktop starts the virtual machine in Coherence mode and the application in the virtual machine automatically.

**Windows Taskbar**

By default, Windows taskbar is present on the Mac OS X desktop when you run the virtual machine in Coherence mode. You can select not to show the Windows taskbar in Coherence, refer to Coherence Options (page 161).

If there is no Windows taskbar on the screen, you can access the Windows Start menu in one of the following ways:

- clicking the Parallels Desktop icon in the Dock,
- right-clicking the Parallels Desktop icon in the Dock and choosing the Windows Start menu from the shortcut menu.
You can choose the option to relocate Windows taskbar automatically depending on the Dock's position on the screen. Refer to the Coherence View Options (page 113). Then, if the Dock is at the bottom of the screen, taskbar will be located to the left or right or at the top of the screen. Also the task bar is placed to the best position on the screen where the entire bar will be visible.

**Using Application Switcher**

You can switch between any of the running Mac OS X and Windows applications by using Application Switcher.

1. Press Command+Tab on the keyboard, you will see the Application Switcher bar across the desktop with all applications running in both Windows and Mac OS X.
2. Select the application by clicking its icon in the bar. Parallels Tools Center is selected in the picture below.

For troubleshooting when using Application Switcher see Keyboard Shortcuts in Virtual Machine (page 219).

**Smart Select**

When you install Parallels Tools in the virtual machine, the list of Parallels Shared Applications is created. The list includes your Mac OS X applications and is available when you choose All Programs -> Parallels Shared Applications from the Windows Start menu. You can select any application from the list and start it.

Right-click your document in Mac OS X or Windows and choose any available Mac OS X or Windows application from the Open With list.

You can also choose the default application for opening files of a certain type both in Mac OS X and in Windows. When you start any Windows application for the first time you will be prompted to decide if you want to set this application as a default application for opening files (with supported extensions) in Mac OS X.

**Multiple Displays Mode**

You can use several displays while working in Coherence mode and expand Coherence mode on the selected number of displays.
Coherence Mode Options

This topic contains overview of Coherence mode options.

**Startup Options**

You can configure your virtual machine to start up right in Coherence mode. The Startup Mode option can be set on the Booting Options tab of the Configuration Editor. For details see the Booting Options (page 157) topic.

**Animation Options**

You can set up animation on switching to Coherence Mode. For this select the Animate Coherence Transition option on the Animation tab in the Preferences window. For details see Animation Tab (page 213).

**View and Working Area Options**

Coherence view options let you customize Coherence Mode for the virtual machine. You can specify whether to display Windows taskbar in this mode or not. If you select the Relocate automatically option, Windows taskbar will be automatically placed in other than the Dock's position.

Working Area options allow you to exclude the Dock from the area that may be occupied by the guest OS applications and to expand the Coherence mode to using several displays.

The same options are also available on the Coherence Options tab in Configuration Editor. If you change them on the Coherence tab, they automatically will be changed on the Coherence Options tab and vice versa.

For more complete information see the Coherence Options (page 161) or Coherence View Options (page 113) topic.

**Sharing Internet Applications**

Options of this group provide the Internet applications sharing in both Windows and Mac OS X: The same default browser, ftp and email client can be used in both systems. These options can be set on the General tab of the Preferences window. Refer to the General Tab (page 206) topic.

**Mac Sharing Options**

Transparent file associations in both systems let you open Windows files by Mac OS X applications and Mac OS X files by Windows applications. The Global Sharing and Local Sharing options that control drag-and-drop and Smart Select operations can be set on the Shared Folder Options tab in Configuration Editor.

These options can be found on the Shared Folders Options tab of the Configuration Editor. For more information see the Shared Folders (page 163) topic.
Windows Sharing Options

Select the Share Windows Drives option to provide access from Mac OS X to Windows disks. If you select the Mount shares on Mac desktop option, you will be able to see Windows disks in the Finder.

Note. Only virtual hard disks can be mounted; removable USB storage devices, external floppy disks and CD/DVDs can not be mounted.

These options can be found on the Shared Folders Options tab of Configuration Editor. For more information see the Shared Folders (page 163) topic.

Virtual Machine Security Levels

When you set a particular security level for the virtual machine, this automatically enables or disables certain options on the Coherence and Shared Folders tabs in Configuration Editor. And vice versa, when you change options on these tabs, the Security level slider on the Security Options tab may indicate the changed level of overall security.
This section explains what are snapshots, how to create them and how to use them. The section also describes how to use the Undo disks feature.

**Note.** You cannot create snapshots or use Undo Disks feature for a virtual machine that uses the Boot Camp partition.

**In This Chapter**

Overview of Snapshots ................................................................. 145
Making a Snapshot ............................................................................... 146
Snapshot Manager ............................................................................... 147
Reverting to the Last Snapshot ........................................................ 149
Working with Undo Disks ................................................................. 150
Overview of Snapshots

Snapshot is a state of the virtual machine saved at a certain moment. Snapshots can be saved when the virtual machine is running as well as when it is stopped, paused or suspended.

**Warning.** Generally, you can take a snapshot at any time. But it is recommended that before you take a snapshot, you complete all the operations of installing, downloading, and writing to external devices. Also, you should complete or cancel any transactions performed via the virtual machine in external databases.

Consider the following scenarios:

- Make successive backups as snapshots and thus save space on the hard disk of your Macintosh computer.
- Configure software that requires a lot of configuring stages. Since at each stage you can select alternative settings, you may want to explore which settings to select. Create snapshots at branching points.
- In developing process, mark milestones as snapshots. If something goes wrong, you can always revert to the previous state or create a branch of snapshots starting the particular milestone snapshot.

**Note.** Snapshots cannot be created for the virtual machine that uses the Boot Camp partition.

Every snapshot includes the following additional information:

- Date and time when this snapshot was created.
- User-defined name of the current snapshot.
- A screen shot of the guest OS.

**Snapshots Files**

When the first snapshot is saved, the following objects are created:

- snapshots.xml - This file stores the information about virtual machine snapshots.
- The Snapshots folder - Snapshot files are placed into this folder.

Virtual disk difference files (for the snapshots created for the virtual machine) are located in appropriate .hdd bundle files.

A default location for these objects is the folder where the virtual machine configuration file is located.
Making a Snapshot

Snapshots can be taken when the virtual machine is running, paused or stopped. Making a snapshot when the virtual machine is running doesn't stop the virtual machine.

To make a snapshot

1. Start Parallels Desktop.
2. In the Select Virtual Machine dialog select a virtual machine and click the Select button.

   If you want to make a snapshot of the virtual machine in stopped state click the button on the toolbar or choose Make snapshot from the Actions menu.

   If you want to make a snapshot of the running virtual machine, start the virtual machine by clicking the Start button. When you decide that it is time to save the state, click the button.
3. The following dialog appears:

   ![Snapshot Parameters dialog](image)

   Provide a name and a short description for the snapshot.
4. Wait while the state of virtual machine is being saved.
Snapshot Manager

Snapshot Manager enables you to view snapshots created for the virtual machine and select a snapshot to go to it or to edit its properties.

The Snapshot Manager window is divided into three areas:

- The Snapshots tree area in the upper part of the window.
- Snapshots property pane, that is located below the snapshots tree area. User can edit the property of the specific snapshot selected in the tree.
  This pane also contains snapshot command buttons: Go to and Delete.
- The pane that contains two dialog buttons used to perform operations on the entire snapshot tree: New and OK.
  Click the New button to create a new snapshot.
  Click OK to close Snapshot Manager and save changes (if any) to the virtual machine snapshots tree.
Snapshots Tree Pane

The snapshots tree for the virtual machine is presented in the upper pane of the Snapshots Manager. Snapshots are represented by their scaled screen shots (taken at the moment of saving the snapshot). We will refer to tree snapshots as to nodes.

The first node represents the root of the snapshots system - the initial state of the virtual machine used as the "reference point". The root node can be deleted only with all the snapshots created for the virtual machine. While at least one snapshot exists, the root snapshot exists.

All other snapshots of the same virtual machine are descendants of the root snapshot. The first snapshot contains "differences" with respect to the root snapshot. The second successive snapshot contains differences with respect to the first snapshot. If at some moment you want to return to one of the previous snapshots, and after working with it, create another snapshot, a new branch of snapshots will be created.

A node that represents the current state of the virtual machine is marked with a flag. At runtime, this node is represented by a live screen shot of the guest OS, that is updated every 5 seconds.

Snapshots Property Pane

Once a snapshot is selected in the Snapshot tree, its properties are displayed in the following fields:

- Created - indicates the date and time when snapshot was created.
- Name - Displays the default or user-specified name.
- Description - Contains the user-defined short description provided at the moment when snapshot was created. The field is available for editing.

Deleting Snapshot

1. Select a snapshot in the tree.
2. Click the Delete button.

If you deleted an intermediate snapshot (not the last), the information it contained is merged to the snapshot that followed it.

Going to the Chosen Snapshot

1. Select a snapshot in the tree.
2. Click the Go to button.
3. You will be prompted to decide what do you want to do with the current state of the virtual machine - save as a snapshot or lose all the changes made since the last snapshot.
Reverting to the Last Snapshot

In the current version of Parallels Desktop you can revert the virtual machine only to the last snapshot. All changes made to the virtual disks and configuration will be lost.

For this do the following:

1. Click the button on the toolbar or choose Revert to snapshot from the Actions menu.
2. You will see the following message:
   
   ![Warning]
   
   If you revert to the last snapshot you will lose all the changes you have made to your data since the last snapshot was taken. Do you want to proceed?

   ![Yes No buttons]

3. Click OK to proceed. Click No if you do not want to revert the virtual machine to the last snapshot.
Working with Undo Disks

The **Undo Disks** feature allows users either commit or reverse the changes, that were made during the current virtual machine session to its virtual disks. The current version of Parallels Desktop allows applying this option only to all disks of the virtual machine at once.

**Warning.** Please remember that not all operations can be undone even if you turned on the Undo disks feature. Operations performed via the virtual machine, for example, changes made to Mac OS X files cannot be discarded, transactions performed in the network database cannot be canceled.

You can enable the **Undo Disks** feature on the **Advanced** tab of **Options** in Configuration Editor. For details see Advanced Options (page 158).

When you set this option, you also have to choose the action performed on the virtual machine shutdown: **Apply Changes, Discard changes, Ask me what to do.** So, each time you close the virtual machine, depending on the action selected, the changes will be committed, or dismissed, or you will be asked what to do in this particular case.

- If the **Discard changes** action is chosen, on the virtual machine closing, each virtual hard disk will be rolled back to its initial state which it had at the virtual machine startup.
- If the **Apply changes** action is chosen, all changes will be saved on the virtual machine disks at virtual machine shutdown.

**Note.** The virtual machine with the **Undo disks** feature enabled cannot be compressed, and its disks cannot be compacted.

Although the **Undo Disks** feature uses snapshots functionality, snapshots cannot be created for the virtual machine with **Undo Disks** enabled, and, vice versa, if the virtual machine have at least one snapshot, the **Undo Disks** option cannot be enabled.

**Note.** The **Undo Disks** option cannot be set for the virtual machine that uses the Boot Camp partition.
Using Mouse in a Virtual Machine

If Mouse Has Right Button

By default, right button of Macintosh mouse is configured to perform the same functions as the left button (if your mouse has the right button at all). You may configure your Mac mouse in such a way that its right button will function as a "right" button:

1. Go to the Apple System menu, select System Preferences, and in the Hardware section click Keyboard&Mouse.

2. In the Keyboard&Mouse dialog, open the Mouse tab and select the Secondary Button option for the right button.
If Mouse Does Not Have Right Button

If your mouse does not have a right button, do one of the following:

- Use the Ctrl+click combination to select objects.
- By default, Ctrl+Shift+click combination is defined to replace right-click. You may set other combination on the Preferences -> Keyboard tab (page 214).
- Use "click with delay": Click and hold the mouse button until the shortcut menu is displayed. To set the preferred delay, choose Preferences from the Parallels Desktop menu. On the Keyboard tab, click More Options in the Mouse Right Click section. In the appearing dialog select the Delayed Right Click option and set the preferred delay time, using the slider. Click OK to apply the settings.

By default, this method is disabled. You can enable it on the Keyboard tab of the Preferences window.

Note. On MacBook and MacBook Pro you may also click the small Enter key that is to the right of the right CMD key on your keyboard. In Windows guest OSes this Enter key on Macintosh keyboard is similar in function to the Menu key on the Windows keyboard.

Networking in a Virtual Machine

Parallels Desktop allows three types of networking in a virtual machine:

- Shared Networking (NAT)
- Bridged Ethernet
- Host-only networking

This section describes all these types of networking and the ways of configuring them.
Shared Networking (NAT)

By default, virtual machines created during Express or Typical OS installation use Shared Networking (NAT) mode for network connections. In this mode your virtual machine can access the Internet while being invisible to other computers on the network (except your Macintosh computer). This mode is recommended because it doesn't require any additional configuring. Your virtual machine will share whatever network connection your computer uses at the moment.

This mode is preferred in the following cases:

- your computer accesses the Internet via a modem or another non-Ethernet device,
- as a mobile user, you access the Internet from Internet cafes, hotel rooms and on flights,
- you want to access the Internet in a virtual machine but you are concerned about security,
- you have problems with Bridged Ethernet mode.

Parallels NAT adapter installed along with Parallels Desktop provides Shared networking support in Mac OS X. IP addresses for the virtual machines are provided by Parallels DHCP server connected to the Parallels NAT adapter.

Configuring Shared Networking for a Virtual Machine

Open Configuration Editor for the virtual machine and on the Network Adapter Options (page 175) tab select the Shared networking option.

If you want your virtual machine to have an IP address from the specific range, then:

- Choose Preferences from Parallels Desktop menu. On the Network (page 209) tab, specify a range of IP addresses to be assigned to the virtual machines and your primary OS in the Enable DHCP Scope for Shared Networking group.
- Note that this scope of addresses must be different from the scopes of all other networks your Macintosh computer has access to.

Bridged Ethernet Networking

If your virtual machine uses the Bridged Ethernet type of connection to the network, virtual machine appears on the network as a stand-alone computer with its own IP address and network name.

To configure your virtual machine to use Bridged Ethernet mode:

1. Open Configuration Editor for the virtual machine and on the Network Adapter Options (page 175) tab select the Bridged Ethernet mode in the Emulation group
2. Choose the proper network adapter from the list. The Default Adapter option is recommended. It connects to the built-in Ethernet or AirPort of your Macintosh computer whichever is currently active.
3. Configure network options in the guest operating system.
Note. If your Macintosh computer uses AirPort with WEP Enterprise, it may be impossible for the virtual machine to get its own IP-address. Use other type of network connection.

If you encounter problems when using Bridged Ethernet mode or have special security concerns, consider Host-Only Networking.

**Host-Only Networking**

Parallels Desktop provides a closed network accessible only to Mac OS X and virtual machines running on it. The Mac OS X is connected to this network via the Parallels Host-Guest adapter installed along with Parallels Desktop.

IP addresses for machines in a host-only network are provided by Parallels DHCP server connected to Parallels Host-Guest adapter. DHCP server is started automatically whenever you launch Parallels Desktop.

Configuring Host-only Networking

Open **Configuration Editor** for the virtual machine and on the Network Adapter Options (page 175) tab select the **Host-only networking** option.

If you want your virtual machine to have the IP address from the specific range, then:

- Choose **Preferences** from the Parallels Desktop menu. In the Network (page 209) tab, specify a range of IP addresses to be assigned to the virtual machines and Mac OS X in the **DHCP Scope for Host-only Networking** group.

Note. This scope of addresses must be different from scopes of all other networks your Macintosh computer has access to.
Editing Virtual Machine Configuration

The configuration of an existing virtual machine can be changed in Configuration Editor. This section describes how to edit the configuration.

To open Configuration Editor do one of the following:

- On the Configuration Page click any device in the list of available virtual hardware or click the Configuration link.
- Choose Virtual machine from the Edit menu.

If your virtual machine is configured to start up immediately when you select it in the Select virtual machine dialog or when you click its alias, to open Configuration Page do one of the following:

- Start Parallels Desktop, while pressing the Cmd key in the Select virtual machine dialog, highlight the desired virtual machine and click the Select button.
- While pressing the Cmd key, double-click the virtual machine alias.

To add a device to the configuration click the Add button. To remove a device from the list, select it on the list and click the Remove button if it is enabled for the selected device. For details see the Adding and Removing Devices (page 182) section.
General Options

The **Options** section of Configuration Editor includes the following three tabs: **General**, **Booting** and **Advanced**.

**Note.** Configuration Editor is available only when the virtual machine is stopped.

On the **General Options** tab you can view and edit the following settings.

**Virtual Machine Name** field shows the name of the machine that has been specified when virtual machine was created. The name can be changed. The name should be descriptive, and should have no more than 50 symbols. The name of the virtual machine is displayed on its Configuration Page (page 42).

**OS Type** and **OS Version.** Here you can see what operating system is installed in the virtual machine (or was declared if you didn't install any OS).

Always choose the operating system correctly. If OS specified on this tab is not the one actually installed in your virtual machine, this may cause problems varying from slow performance to machine failure.

**Description.** Type any comments that you consider important about the virtual machine. This description is displayed as a help tag when you move the cursor over the virtual machine name in the **Select virtual machine** dialog. See the Main Window (page 40) topic.
Booting Options

On the **Booting Options** tab of Configuration Editor you can select the booting sequence, that is, the order in which the virtual machine will try to boot from different devices.

**Note.** Configuration Editor is available only when the virtual machine is stopped.
You can choose one of the three pre-defined sequences - [Floppy, Hard Disk, CD-ROM], [Hard Disk, CD-ROM, Floppy], [CD-ROM, Hard Disk, Floppy]. During startup, the virtual machine checks the first device (or media) of the boot sequence and tries to boot from it. If the media is not found or is not bootable, the virtual machine will proceed with the next device in the boot sequence, and so on.

**Note**: Please make sure that the boot disk (hard disk, CD-ROM, floppy disk) is available and configured correctly. If you don't have any boot device on your virtual machine (in case of a new blank virtual machine), after you start it, you will see the error message “No boot device is available”. Stop the virtual machine and correct the configuration.

**Flags:**

- **Start VM automatically when it is opened.** Select this option if you want the virtual machine to start automatically once you have selected it in the Select virtual machine dialog.
- **Exit application on VM shutdown.** If this option is selected, Parallels Desktop will be closed automatically when you shut down your virtual machine.
- **Startup Mode** option The pop-up list includes the following values: Default, Windowed, Full Screen, Coherence. When either of Windowed, Full Screen or Coherence mode is selected, the virtual machine, upon start, automatically switches to specified mode. If Default is selected, the virtual machine will start up in the same mode, in which it was turned off.

**Advanced Options**

On the **Booting Options** tab of Configuration Editor you can select the booting sequence that is the order in which the virtual machine will try to boot from different devices.

**Note.** Configuration Editor is available only when the virtual machine is stopped.
Advanced Options tab contains various options that affect the performance of the virtual machine.

Emulation Flags:

- **Acceleration level.** At each acceleration level, certain performance optimization techniques (specific to the guest OS) are enabled. We recommend selecting the High level. If you notice incorrect guest operating system behavior while running with high acceleration, shut down the OS and lower the acceleration level. Note that without acceleration at all (Disabled level) any virtual machine runs slowly.

- **Enable Intel VT-x Support** option is available for changing if you have an Intel processor with VT-x in your Mac. By default, VT-x support is enabled. See Intel Virtualization Technology (VT-x) Support (page 14) to learn about VT-x support in Parallels Desktop. If you are running a guest OS while VT-x support is enabled, it is indicated in the About Parallels Desktop window (see the More Information (page 51) section).

Virtual Machine Performance:

- **Virtual machine.** Choose this option to significantly increase the speed of virtual machine operations maybe at price of slowing down your Mac OS X applications.

- **Mac OS X.** Choose this option to provide better performance of Mac OS X.

Undo disks

- **Undo disks** option allows you to define the virtual machine disks as Undo disks. The current version of Parallels Desktop allows applying this option only to all disks of the virtual machine at once.

  It means that the initial state of the virtual machine disks will be saved at the machine's startup, and while you work with the virtual machine, all changes are being written to a temporary file. When you turn off the virtual machine, the changes will be applied to its hard disks, or discarded, or you will be prompted to decide whether to apply or discard the changes - it depends on the action you choose.

  - If you selected the Undo disks option, choose one of the actions be performed on the virtual machine closing: Discard Changes, Apply changes, Ask me what to do.

**Note.**

1. If you selected the Undo disks option for the virtual machine, you cannot create snapshots for this virtual machine.

2. The option cannot be set for the virtual machines that use a Boot Camp partition.
Security Options

This tab describes the overall level of security set for the virtual machine. Using the slider you can change the overall level of security, thus changing other settings associated with specific security level on other tabs of Configuration Editor (on the Shared Folders Options tab in the current version of Parallels Desktop).

There are three security levels available:

- **High.** This level indicates greater virtual machine isolation from Mac OS X than other levels.
- **Medium-high.** Shared folders are allowed and access to Windows disks from Mac OS X side.
- **Medium.** Indicates the high level of integration between Mac OS X and Windows.

The Set Default button sets the security level to the default position at **Medium-High**.

For more information on the meaning of the options involved refer to Shared Folders Options (page 163).
Coherence Options

The **Coherence Options** tab of Configuration Editor allows you to configure the Coherence options for Windows 2000/XP/2003/Vista guest OSes only. For other guest OSes you will see the message: "Feature is not available for this type of guest operating system".

**Note.** Configuration Editor is available only when the virtual machine is stopped.

These options are also available on the **Coherence** tab of the **Customize View** window: choose **Customize** from the **View** menu. If you change the options on the **Coherence Options** tab, they will be changed automatically on the **Coherence Options** tab in the **Customize View** dialog and vice versa.
Windows Taskbar:

- **Show.** Select this option if you want the Windows taskbar to be displayed on the screen while you run the virtual machine in Coherence.

- **Relocate automatically.** This option is enabled only when the above option is selected. If it is selected, the taskbar will be automatically relocated to the top of the screen when the Dock is located at the bottom of the screen, and to the right when the Dock is located to the left. Also, the taskbar will be placed to the best position where the entire bar will be visible.

Working area:

- **Exclude Dock.** Select this option if you do not want Windows applications to appear in the screen area occupied by the Dock.

- **Use multiple displays.** Select this option if you are using more than one display. It will allow you to extend coherence to several displays, that is, to move the guest Windows applications to other displays.

When using several monitors, arrange how you will see applications when moving them from one display to another. For this, in the Mac OS X menu select: **System Preferences -> Displays -> Arrangement.** Arrange the displays in the Displays dialog using drag-and-drop operation.
Shared Folders Options

Options in this section control virtual machine's shared folders and files sharing between the guest Windows and Mac OS X operating systems. Also, options on this tab can be used to set up Smart Select and transparent file associations.

The **Shared Folders** tab of Configuration Editor has options for Windows 2000/XP/2003/Vista guest OSes only. For other guest OSes you will see the message: "Feature is not available for this type of guest operating system".

**Note.** Configuration Editor is available only when the virtual machine is stopped.
Global and Local sharing options

With both Global sharing and Local sharing options disabled, only basic drag-and-drop operations (by file copying) can be performed. Such operations are completely safe. For example, you drag the text file from the Mac OS desktop to Microsoft Word open in your virtual machine to edit this document. A copy of the file is created on the desktop in your virtual machine. When editing is complete, and you want to close the document and save changes, changes will be saved to a file on the desktop in your virtual machine. You have to drag this file back to Mac OS desktop to replace the original file by its copy that has been edited.

- **Global sharing.** Select this option to enable Global Sharing for drag-and-drop and SmartSelect operations. This shares all files on your computer including removable disks for using by Windows guest operating system. Such operations differ from the basic drag-and-drop operations - no copies are created. For example, you drag a text file from the removable disk on Mac to Microsoft Word toolbar (if a document is open) or to the Word's empty working space to edit the text. When you close the file and save changes, they will be saved to the original document on the removable disk - not to a copy in the virtual machine.

- **Local sharing.** Select this option to enable Local Sharing for drag-and-drop and Smart select operations. This shares files for using by Windows in your home folder only. You will be able to perform the drag-and-drop operations with the files from your home folder, while for other files, only basic drag-and-drop operations by file copying will be available.

When the Local sharing option is disabled, only the basic drag-and-drop operations are available for the files from your home folder.

When the Global sharing option is disabled, only the basic drag-and-drop operations are available for the files outside your home folder.

User-Defined Folders

The User-defined folders option when selected, allows using shared folders in the virtual machine.

The User-defined folders list displays all the shared folders defined in this virtual machine. The Name column shows name of the folder in the guest OS, the Path column shows the same folder in the file system of your Mac, and the Mode column shows the read/write mode specified for the folder.

Below the list, there are the following buttons:

- **Add** button opens the Add Shared Folder dialog for creating a new shared folder. See the Using Shared Folders (page 200) section for detailed description of the procedure.

- **Delete** button removes the selected shared folder.

- **Edit** button opens the Edit Shared Folder dialog where you can edit the shared folder properties.

Windows Sharing Options

- The Share Windows drives option allows access from Mac OS X to the guest Windows files and folders. If the check box is cleared, no Windows drives can be mounted on Mac OS X desktop.
- **Mount shares on Mac desktop** option allows mounting Windows drives (disks or partitions) on Mac OS desktop when the **Share Windows drives** option is selected. The Finder will display the virtual machine's Windows hard disks and their contents.

- Note. Removable storage like external USB floppy drives, USB disks and CD/DVD discs cannot be mounted. [SHOULD BE DELETED] Note. Windows network shares can not be mounted.

  **Note.** Windows network shares can not be mounted.

### Video Options

The **Video Options** tab of Configuration Editor lets you set different fixed screen resolutions for the virtual machine and enable DirectX support in the virtual machine.

**Note.** You also can resize the virtual machine window as you would do with any other application window by dragging its right corner. Resolution is being changed automatically in Windows (starting Windows 2000) and in most Linux operating systems.

Configuration Editor is available only when the virtual machine is stopped.

- **Enable custom screen resolutions** option allows using different screen resolutions for the virtual machine.

- **Screen Resolutions** list displays all the custom resolutions defined for this virtual machine. The check mark near a resolution means that this resolution will be available for selection in the virtual machine. The resolutions that have not check marks will be unavailable for selection.
- Add button opens the Add Screen Resolution dialog for creating a new resolution. See the Custom Screen Resolutions (page 202) topic for detailed description of this process.

- Delete button removes the selected screen resolution.

- Edit button opens the Edit Screen Resolution dialog where you can make changes in the screen resolution properties. See description of this dialog in the Custom Screen Resolutions section.

- Enable Direct 3X support. Select this option to support accelerated 3D graphics in the virtual machine.

  **Note.** If your applications is incompatible with Direct X, turn this option off.

### Memory Options

The Memory Options tab of Configuration Editor lets you define the amounts of RAM and video memory to be used by the virtual machine.

**Note.** Configuration Editor is available only when the virtual machine is stopped.
Main Memory. The Main Memory parameter defines the amount of virtual memory (RAM) to be used by the virtual machine. You can choose any value from 4 to 1500 MB. We advise you not to exceed the recommended maximum because this is the limit of the physical RAM that your system can reserve for virtual machines without affecting the performance of Mac OS X. If the specified amount is not enough for normal performance of your virtual machine, the memory will be swapped to disk, thus slowing down both the guest OS and Mac OS X.

To set the amount of memory that this virtual machine can use do one of the following:

- drag the slider,
- use the scroll buttons,
- type the value directly into the field. (Only multiples of 4 are allowed).

The recommended maximum value is specified below the slider. This value can be adjusted on the Memory tab (page 208) in the Preferences window.

Video Memory

Use the slider to set the amount of video memory that the virtual machine's video card can use. While you move the slider, below the slider you can see the maximum screen resolution available with this video memory.

The recommended maximum value is specified below the slider.
Floppy Options

The Floppy Options tab of Configuration Editor lets you enable the floppy drive in the virtual machine and connect it to the image file.

**Note.** Configuration Editor is available only when the virtual machine is stopped.

To get information on floppy disk images used by Parallels Desktop read the Floppy Disk Images (page 21) topic.

**Device Status**

- **Enabled** option. To temporary disable floppy drive operations without deleting the floppy drive from the configuration, clear the Enabled check box.

  **Note:** If you start the virtual machine with the floppy drive disabled, you cannot change this option when the virtual machine is running.

If the floppy drive is enabled, it can be connected or disconnected when the virtual machine is running. A floppy image connected to the drive can be replaced by other floppy image or disconnected at runtime.
- **Connect at startup** option. Select it to start the guest OS with the floppy image connected.

**Emulation**

- **Image File.** To connect a floppy disk image to the virtual floppy drive, specify the name of the floppy disk image in this field. You may use **Browse** button to locate the file.

- **Recreate** button. With Parallels Desktop you can create a blank floppy image. Type the file name and the path in the **Image File** field and click the **Recreate** button. The size of a floppy disk image equals 1.44 MB. The default extension for a floppy disk is `.fdd`. 
Hard Disk Options

The **Hard Disk Options** tab of Configuration Editor lets you specify the type of hard disk to be used in the virtual machine.

**Note.** Configuration Editor is available only when the virtual machine is stopped.

The current version of Parallels Desktop allows virtual machines to use hard disk images in `.hdd` format and Boot Camp Windows partition. Read the Supported Types of Hard Disks (page 19) topic to learn about disk formats and other options. You can connect up to four IDE devices (hard disks or CD/DVD-ROM drives) to a virtual machine. In the Configuration Editor each hard disk is listed separately and has a number.

---

**Device Status:**

- To temporarily disable operations with this hard disk without deleting it from the configuration, clear the **Enabled** check box.

**Emulation:**

- **Use Image file.** For any guest operating system you can replace the virtual hard disk image used by the virtual machine by another image. If you replace an image file for the system disk, make sure that the same operating system is installed on a new image. If you replace a data disk, make sure that the file system on a data disk will be compatible with the operating system.
- **Use Boot Camp.** This option is enabled only for virtual machines with Windows XP as the guest OS. Select this option to use the existing Boot Camp Windows XP partition instead of virtual hard disk. At any time, you can switch back to using a disk image instead of Boot Camp Windows partition by selecting the **Use image file** option. Refer to the Using Boot Camp Windows Installation (page 250) topic.

- **Recreate** button deletes an old hard disk and creates a new blank one.

If you want to replace the current hard disk with a new one, do the following:

1. Click the **Recreate** button.

2. **Recreate Hard Disk** dialog appears. You can specify **Virtual hard disk size** and whether the disk should be expanding or plain. Select **Expanding** if you want the hard disk to be in expanding format; otherwise, the disk will be created in plain format.

![Recreate Hard Disk](image)

3. Select **Split Disks** if you want to make the access to the data on disk faster.

4. Click **Create**.

5. Click **Yes** to confirm that you are going to create a new disk instead of the old one. A new blank disk is now connected to your virtual machine.
Hard Disk Advanced Options

The Advanced Options tab of Hard Disk section in Configuration Editor lets you set the hard disk connection option and compact the disk.

Note. Configuration Editor is available only when the virtual machine is stopped.

Attachment Options:

- **Connect to** field. Choose the IDE channel from the pop-up menu to connect the HDD image. If you want the virtual hard disk to be the startup disk, select IDE 0:0.

  Note, that if you set two startup drives at once - virtual hard disk (IDE 0:0) and CD/DVD-ROM (IDE 0:1) - the guest OS will try to boot according to the sequence set on the Booting Options (page 157) tab under the General Options.

Optimization:

- **Compact** button. If the selected disk is in expanding format, the Compact button starts the process of the disk compacting. See the Compacting Virtual Disks (on page 231) topic for information on this feature. The Compact button is disabled for plain virtual disks.
CD/DVD-ROM Options

The CD/DVD-ROM options tab of Configuration Editor lets you configure a virtual machine's CD/DVD-ROM drive. It can be connected to a real CD/DVD-ROM drive of your computer as well as to a CD/DVD .iso image. The information on using CD/DVD images in Parallels Desktop can be found in CD/DVD Real Discs and Their Images (page 20) topic.

Note. Configuration Editor is available only when the virtual machine is stopped.

Up to four IDE devices (hard disks and CD/DVD-ROM drives) can be connected to a virtual machine currently. This means, that there cannot be more than four hard drives and CD/DVD-ROM drives together, that is, it doesn't matter how many of IDE devices are hard drives and how many are CD/DVD-ROM drives.

Device Status:

- If you wish to temporary disable a CD/DVD-ROM drive without removing it from the configuration, clear the Enabled check box.

  Note: If you start the operating system with the CD/DVD-ROM drive disabled, you cannot change this option when the virtual machine is running.

If the CD-DVD-ROM drive is enabled, it can be connected or disconnected at runtime. Media that the CD/DVD-ROM drive can access may also be changed.
If the CD/DVD-ROM drive is enabled, you can select the **Connect at startup** check box to start the guest OS with the CD/DVD disc inserted.

**Emulation:**

- If you have a physical CD/DVD-ROM drive on your computer, you can use it in the virtual machine. In this case, select the **Use CD/DVD-ROM** option, the name of the physical CD/DVD-ROM drive (for example, \D:) will be shown in the **CD/DVD-ROM Drives** drop-down menu and available for selection.

  **Note:** To be able to connect the virtual machine's CD/DVD-ROM drive to a real CD/DVD-ROM drive, you must have system privileges to access the real device. Otherwise, the real CD/DVD-ROM drive will not appear in the list of available devices even though it is installed on your computer.

- If you want to use a CD/DVD image (for example, the .iso file), select the **Use image file** option. As you select it, another field appears below. Specify the path to and name of your CD/DVD image file or click the **Browse** button and locate the CD/DVD image file.

**Attachment Options:**

- Choose the IDE channel to connect to CD/DVD image in the **Connect to** list. If you want the CD/DVD-ROM to be the startup drive select **IDE 0:1** in the list.

  **Note:** If you set two startup drives at once - hard disk (IDE 0:0) and CD/DVD-ROM (IDE 0:1) - the guest OS will try to boot according to the sequence set on the Booting Options (page 157) tab of the **General Options**.
Network Adapter Options

The **Network Adapter Options** tab of Configuration Editor lets you choose the type of networking in the virtual machine. In the current version of Parallels Desktop a RTL8029 (NE2000 compatible PCI card) network adapter is supported.

**Note.** Configuration Editor is available only when the virtual machine is stopped.

In a Linux guest OS, to access an external network in the virtual machine, load a `ne2k-pci` driver into the Linux kernel. It is included by default, however, if you are going to recompile the kernel, remember to select the `ne2k-pci` component. In a FreeBSD guest OS you need to have the `if_ed.ko` module loaded.
Device Status:

- If you wish to temporarily disable network support in the virtual machine without deleting the network adapter from configuration, clear the Enabled check box. When the Enabled check box is selected, the options and fields for configuring the network become active.

- If network adapter is enabled, you can select Connect at startup check box to start the guest OS with network adapter connected.

Emulation:

In the Emulation group, you can select the type of network adapter to be used in your guest OS.

- Select Shared networking if you want to provide Network Address Translation (NAT) feature to your virtual machine. Your virtual machine will share whatever network connection is used by your host computer. See Shared Networking (NAT) (page 153) to learn how to configure this type of networking.

- Bridged Ethernet networking is intended to access local network and Internet using physical Ethernet adapter of your computer. A virtual machine is treated as a separate computer and should be configured the same way as a real one.

If you select the Bridged Ethernet option, the drop-down list below will show a list of all physical network adapters available on your computer. Choose one of them to connect to your virtual adapter. See Bridged Ethernet Networking (page 153) to learn more about this type of networking.
- Select **Host-only networking** if you don't want your virtual machine to be accessible from outside your Macintosh computer, or if the network interfaces of your Mac are off. With this option chose, your virtual machine will be connected to the host computer and other virtual machines, but it will be disconnected from the Internet. For how to configure a host-only network see the Creating Host-Only Network (page 154) topic.

**Advanced Options**

This tab allows you to specify a network driver to be used in your guest OS. In the current version of Parallels Desktop a RTL8029 driver for the Ethernet adapter is supported. It is already selected in the **Type** field.

You can find native Realtek RTL8029 drivers for various guest OSes in the Parallels Tools (page 84) package.

A **MAC address** is generated automatically, but it can be changed manually. If you decide to change it, please make sure that the number is unique inside your network.
Parallel Port Options

The Parallel Port Options tab of Configuration Editor lets you choose the type of emulation for a parallel port. Parallels Desktop allows up to three parallel ports to be connected to a virtual machine.

Note. Configuration Editor is available only when the virtual machine is stopped.

### Device Status:
- If you wish to temporarily disable operations with a parallel port without deleting it from the configuration, clear the Enabled check box. If the parallel port is enabled, it can be connected or disconnected at runtime.

  **Note:** If you start the operating system with the parallel port disabled, you cannot change this option when the virtual machine is running.

- If you have enabled a port, you can select the **Connect at startup** check box to start the guest OS with this port connected.

### Emulation:
- **Use Printer.** Select this option to connect printer via virtual machine's parallel port.
  - **Printer** input field. If the Use printer option is selected, you can choose a printer from the list of printers available for the Macintosh computer, including network printers.
  - **Use output file** option. Select this option to emulate a parallel port by using an output file. The new output file with the default name is created in the virtual machine folder.
Serial Port Options

The Serial Port Options tab of Configuration Editor lets you choose the type of emulation for a serial port. Parallels Desktop allows up to four serial ports to be connected to a virtual machine.

**Note.** Configuration Editor is available only when the virtual machine is stopped.

**Device Status:**

- If you wish to temporarily disable operations with a serial port without deleting it from the configuration, clear the **Enabled** check box.

  **Note:** If you start the operating system with the serial port disabled, it can not be connected or disconnected when the virtual machine is running.

- If you have enabled the port, you can select the **Connect at startup** check box to start the guest OS with this port connected.

**Emulation:**

Parallels Desktop provides two ways of serial port emulation:

- **Use socket** option.

  If you have selected **Use socket**, the **Socket Name** field appears containing a default socket name. Use it or type a new name in the following format: `/tmp/<socket>`. Where `<socket>` is a file name.

  In the second field select the role at this end of the socket.
- **Use output file** option.

  You can attach the existing file using the **Browse** button or create a new one. The new file is created in the virtual machine folder.

### Sound Options

The **Sound Options** tab of the Configuration Editor allows setting the sound device parameters.

**Note.** Configuration Editor is available only when the virtual machine is stopped.

Parallels Desktop virtualizes the Realtek AC’97 compatible sound card.

**Device status:**

- **Enabled** option allows using the sound device in the virtual machine. If the sound device is enabled, it can be connected or disconnected when the virtual machine is running. However, if you want to temporarily disable the operations with the sound device without deleting it from the configuration, clear the **Enabled** check box.

  **Note:** If you start the operating system with the sound device disabled, you cannot change this option at runtime.
To start the guest OS with the sound device activated, select the **Activate at startup** check box.

**Emulation:**

- The **Output Device** field contains a list with the **Default Audio** and **Null Device** items. It is recommended to choose the **Default Audio**. **Null Device** is the choice for situations when the sound card is required by one of the guest OS applications, but you want to mute the sound.

- For **Input Device** we recommend that you select the **Default Audio** option. **Null Device** is the choice for situations when you want to mute sound while the sound card is required by the guest OS'es applications.

**Note.** If you are not satisfied with the quality of the sound produced, a special AC'97 sound driver (page 85) is available for Windows 95/98/ME/NT/2000 guest OSes and for OS/2 and eComStation guest OSes. You can install it instead of the standard one.

**USB Options**

The USB Options tab of Configuration Editor allows you to specify whether USB devices will be connected to the virtual machine automatically or not.

**Note.** Configuration Editor is available only when the virtual machine is stopped.
Device Status:

- **Enabled** option allows using USB devices in the virtual machine. If a USB controller is enabled, USB devices can be connected to the virtual machine or disconnected from it at runtime. However, if you want to temporarily disable USB operations without deleting the USB controller from the configuration, clear the **Enabled** check box.

  **Note:** If you start the operating system with the USB controller disabled, you cannot change this option when the virtual machine is running.

Connection Options:

- **Connect USB devices automatically.** Select this option if you want the running virtual machine to capture new USB devices when they are plugged to your Macintosh computer. Clear the check box for this option if you don't want USB devices to be automatically connected to the virtual machine when they are plugged into the computer. In this case you can connect any of them when the virtual machine is running, as described in Connecting USB Devices (page 131).

If USB controller is removed from the configuration, such Macintosh USB devices as a keyboard, mouse, microphone still will be connected to the virtual machine. A virtual machine may have only one USB controller. Use the **Add** button to add a USB controller if you have removed it by any reason.

### Adding and Removing Devices

Adding new devices to a virtual machine is easier than connecting new devices to a real computer. Removing or disconnecting devices is also easy. The following virtual devices can be added to the configuration or removed from it:

- virtual hard disks and CD/DVD-ROM drives (there can be only 4 IDE devices);
- a floppy drive;
- a network adapter;
- up to four serial ports;
- up to three parallel ports;
- a sound device;
- a USB controller.

### Add Hardware Assistant

New devices are added using Add Hardware Assistant. The assistant allows adding of only one device at a time.

**Note:** To be able to connect any virtual device to a real one, you should have system privileges to access the real device. Otherwise, the real device will not appear in the list of available devices even though it is installed on your computer.

To add a new device to the virtual machine do the following:

1. Open the virtual machine, but do not start it. Stop the virtual machine if it is running.
2 Choose **Virtual Machine** from the **Edit** menu or click any device link on the Configuration Page.

3 Configuration Editor opens. In the lower left part of the **Configuration Editor** window click the **Add** button.

4 Add Hardware Assistant opens and displays the list of virtual hardware that can be added to this virtual machine.

If the virtual machine already has the allowed number of devices of a particular type, such device will not appear in the **Available Hardware** list. For instance, only one floppy drive is allowed.

The assistant allows adding only one device at a time.

Select the desired device and click **Next**.

5 Follow the assistant's windows to configure a new device. You should select the device type and device options when prompted. Options of devices are also described in the Editing Virtual Machine Configuration (page 155) section.

### Adding Hard Disk

To add one more virtual disk to your virtual machine, use Add Hardware Assistant. You may add an existing hard disk image and create a new one. In addition, you can create a new blank .fdd image and connected it to the floppy drive. If you are going to add a new blank virtual disk do not forget to format it to the file system compatible with the guest OS you have in the virtual machine. If you are going to add an existing virtual disk image as a data disk, make sure the file systems are compatible.

The total number of hard disk drives and CD/DVD-ROM drives must not exceed 4.

1 In the **Available Hardware** list, select Hard Disk. Click **Next**.
2 In the next dialog you will see the following three options:

- Create a new virtual disk image.
- Use an existing virtual hard disk image.
- Use Boot Camp

For more details see Using Boot Camp Windows Installation (page 250).

Select one of options and click Next.
3 If you selected the Create a new virtual hard disk option, in the next dialog select the size for a new disk and the format of the disk. For more information, see Formats of Virtual Disks (page 19). Click Next.

Then, specify location for this new virtual hard disk. It is a good idea to place this new disk image to the same folder where the virtual machine (which will use this disk) is located. Click Finish.
4 If you selected the **Use an existing virtual hard disk** option, specify the name and location of an existing image file that you want to use. Use the **Browse [...]** button to locate the file or type its pathname directly into the field. Click **Finish**.

5 If you selected the **Boot Camp** option, Boot Camp partition will be added as a hard disk to your virtual machine. If the virtual machine doesn't have any hard disk, Boot Camp is added as [0,0] disk. If there is already a virtual disk, Boot Camp will be added as a data disk. Click **Finish**.
Adding CD/DVD-ROM Drive

The total number of hard disk drives and CD/DVD-ROM drives must not exceed 4.

To add a CD/DVD-ROM drive to a virtual machine, open Configuration Editor and click Add.

1 Add Hardware Assistant displays the device list, select CD/DVD-ROM drive and click Next.
2 Choose whether you want to use a real CD/DVDs or images of discs.

3 If you chose to use a real CD/DVD-ROM drive, select what real drive you want to use. By
default, the option Connect the CD/DVD-ROM at startup is turned on. Clear the check box for
this option if you want to have the drive enabled, but want to connect it later, when the
virtual machine will be running.

Click Finish to exit the assistant.
4 If you chose to use a CD/DVD image, select an image to be connected to the drive. Later, you can disconnect it and connect another one. If the Connect CD/DVD-ROM at startup option is on, the selected image will be connected at the moment you turn on the virtual machine. If the check box for the option is cleared, the drive will be Enabled, but the image will be disconnected at startup.

Click Finish to exit the assistant.
Adding Network Adapter

A virtual machine can have up to 5 network adapters simultaneously; Macintosh computers allow using multiple adapters, each for connecting to a different network.

To add a network adapter to the virtual machine, use Add Hardware Assistant.

1. On the device list select Network Adapter option. Click Next.
2 The current version of Parallels Desktop offers the following three options: Shared Networking (recommended), Bridged Ethernet, Host-only Networking. For details on these networking options refer to the Networking in a Virtual Machine (page 152) topic.

3 If the Bridged Ethernet option was chosen, the assistant prompts you to specify what adapter must be used. Select an adapter from the list. The Default Adapter value means that virtual machine will use the same adapter your Macintosh uses. The Connect cable at startup option means that virtual machine will be connected to the adapter at the moment the virtual machine is started.
No matter what networking option was chosen, Add Hardware Assistant displays the generated MAC address. The field is editable, but it is not recommended that you change the Mac address.

Click **Finish** to exit the assistant.
Adding Serial Port

To add a serial port to the virtual machine, use Add Hardware Assistant.

1. On the device list select **Serial Port** option. Click **Next**.

2. Choose a **Serial port** option. You can use an output file for the serial port or a socket.
3 If the **Use an output file** option was chosen, the assistant prompts you to specify a location for the file. The default folder is the folder where this virtual machine configuration file is located. You can edit the field directly or use the **Browse [...]** button to select other than default location.

4 If the **Use a socket** option was selected, the assistant prompts you to specify a socket name and its role. The **Connect the serial port at startup option** is selected by default. Clear the check box for the option if you want to have the serial port **Enabled** but not connected at startup. You will be able to connect it later.
Click **Finish** to exit the assistant.

**Adding Parallel Port**

To add a parallel port to the virtual machine, use Add Hardware Assistant.

1. On the device list select **Parallel Port** option. Click **Next**.

![Add Hardware Assistant](image)

2. For the parallel port you have two options: connect it to output file or to a printer.
   
   If you choose the **Use an output file** option go to the Step 4.
If you choose the **Use a printer** option proceed to the next step.

3 Choose a printer from the list of printers available on your computer. Choose *Default* to use the printer that is set as the default in Mac OS X. Select the **Connect at Startup** option if you want the printer to be connected at the virtual machine startup. Click **Finish** to exit the assistant.
If you selected the Use output file option, specify a location for the parallel port output file. The default folder is the folder where this virtual machine configuration file is located. You can edit the field directly or use the Browse [...] button to select other than default location.

The Connect the parallel port at startup option is selected by default. Clear the check box for the option if you want to have the parallel port Enabled but not connected at startup; you will be able to connect it later.

Click Finish to exit the assistant.
Adding a USB Controller

A virtual machine may have only one USB controller. If you removed it by any reason, you can add it to the configuration.

To add an USB controller to the virtual machine, use Add Hardware Assistant.

1. On the device list select **USB Controller** option. Click **Next**.
2 Select Yes if you want USB devices to be connected to the virtual machine automatically when they are plugged into the computer. Leave the check box cleared if you don’t want the USB devices to be automatically connected to the VM.

Click Finish.

Removing Devices

Most virtual machine devices can be removed from the configuration. Memory, Options, Shared Folders, and Video cannot be removed.

Note. Any device, except memory, can be disabled in the Configuration Editor (page 155) without removing it from the configuration. Clear the Enabled check box for the desired device.

To remove a device:

1 Open the virtual machine which device you want to remove. Open Configuration Editor by choosing Virtual Machine from the Edit menu or by clicking the device link on Configuration Page.

2 Select the device you want to remove in the left pane of the Configuration Editor window.

3 Click the Remove button.

Note. If you accidentally remove the wrong device, click Cancel in Configuration Editor. Once you click OK, the device will be removed.
Using Shared Folders

Shared folders are folders in Mac OS X file system that are also visible to the guest OS. These folders can be used for exchanging files between the primary OS (Mac OS X) and the virtual machine or between several virtual machines. In Mac OS X shared folders appear as usual folders, while in the guest OS they are objects of the network neighborhood.

Using shared folders is possible in the following guest OSes:


Setting Up a Shared Folder

Setting up a shared folder requires two steps:

1. Make sure that Parallels Tools are installed in your guest OS. See Installing Parallels Tools (page 84) for detailed descriptions on how to do so in a particular guest OS. We recommend that you perform the typical installation, but if you perform a custom installation, make sure the Shared Folders tool is selected.

2. Add a shared folder(s) to your virtual machine configuration.

See below for detailed instructions.

Adding a Shared Folder

1. To open the Configuration Editor, choose Virtual Machine from the Edit menu.

2. In the Configuration Editor, select the Shared Folders tab (see the Shared Folders (page 163) topic). Select the Enable Mac sharing option.

3. Click the (Add) button.

4. In the Add Shared Folder dialog:
   - Specify a name for the folder which will appear in your guest OS in the Name field.
   - Specify a folder in your Mac OS X file system that will be shared in the Path field.
   - If you want to restrict writing to this folder from inside the guest OS, select the Read Only option. You will be able to save files to this folder in the Mac OS X only.
- Make sure the **Enabled** check box is selected and click **OK**.

![Add Shared Folder dialog](image)

5. Click **OK** in the **Configuration Editor**.

6. Start your virtual machine and view shared folders in the guest OS.

To edit a shared folder properties, select a shared folder in the list and click the ![Edit](image) button. Edit the folder properties in the **Edit Shared Folder** dialog.

To delete a shared folder, click the ![Delete](image) button. If you occasionally deleted the shared folder you really need, click the **Cancel** button in Configuration Editor.

**Viewing Shared Folder in Guest OS**

There are two ways to view the contents of the shared folders in the guest OS.

**Easy Way**

Shared Folders Options (page 123) tab in **Parallels Tools Center** contains the **Place shortcut on the desktop** option. If it is selected, viewing the contents of shared folders is simple:

- Click the **Parallels Shared Folders** icon on the desktop of a running virtual machine.

**General Way**

1. In the virtual machine, open Windows Explorer.

2. In Explorer, select **My Networks Places -> Entire Network** and find the **Parallels Shared Folders**.

3. Click the **Parallels Shared Folders** to view the list of shared folders available in your virtual machine.
Note that you can save files to a shared folder from inside the virtual machine only if this shared folder is not a Read Only folder.

**Custom Screen Resolutions**

Virtual machines, like real computers, may have displays with different resolutions. You may use standard screen resolutions, such as 640x480, 800x600, etc, but with virtual machines you have one more degree of freedom - non-standard screen resolutions. Use them if you want the virtual machine window to occupy greater or smaller part of your display screen.

Procedure of defining custom resolution is different for each type of guest OSes.

**In Windows Guest OSes**

For Windows guest operating systems (starting from Windows 2000 and later), Parallels Tools make it possible to change screen resolution at runtime, simply by dragging the right corner of the Guest OS window. For earlier Windows guest operating systems, this way of changing screen resolution is not available.

Parallels Desktop allows you to define up to 10 different resolutions for a Windows virtual machine by using Configuration Editor. You can change resolution when the guest OS is running. Note that the lowest screen resolution available is 800x600.

**Adding a Screen Resolution**

1. Open the virtual machine's Configuration Page and click any link to open the Configuration Editor.
2. In the Configuration Editor, select Video in the Devices list.
3. In the Screen Resolutions tab (see Video (Screen Resolutions) (page 165) ), make sure the Enable custom screen resolutions option is selected.
4. Click the Add button to open the Resolution Properties dialog.
5. In the Resolution Properties dialog:
   - set the desired resolution options in the Width, pixels and Height, pixels fields;
   - select the Enabled check box if you want this resolution to be available for selection in the guest OS;
click OK.

6 Click OK in Configuration Editor.

Changing Screen Resolution in Virtual Machine

To change screen resolution:

- Start your virtual machine.
- Select the preferred resolution as it is usually done in your guest OS. The guest OS will prompt you to select one of the resolutions available in the Video (Screen Resolutions) (page 165) tab for which the Enabled option is selected.

If you have defined a non-typical resolution and do not see it in the list of available resolutions in the running guest OS, this means that your guest OS can not use this resolution.

In Linux Guest OSes

To run a Linux virtual machine with a non-standard resolution do the following:

1 In a terminal, generate xorg.conf modeline by executing

   gtf <width> <height> <refresh>

   Note. For LCD displays, used in notebooks, the refresh should be no more than 60.

   The output string may look for example as follows:

   Modeline "1440x900_60.00" 106.47 1440 1520 1672 1904 900 901 904 932 -HSync +Vsync

   "1440x900_60.00" is the mode name; 1440 is width, 900 is height, and 60 is refresh of the new mode that were given to the gtf.

2 Open xorg.conf and paste the output of gtf to the Monitor section. The Monitor section looks as below:

   Section "Monitor"
   Identifier "monitor1"
   VendorName "Generic"
   ModelName "1024x768 @ 70 Hz"
   HorizSync 31.5-57.0
VertRefresh 50-70

# TV fullscreen mode or DVD fullscreen output.
# 768x576 @ 79 Hz, 50 kHz hsync
ModeLine "768x576" 50.00 768 832 846 1000 576 590 595 630

# 768x576 @ 100 Hz, 61.6 kHz hsync
ModeLine "768x576" 63.07 768 800 960 1024 576 578 590 616
  Modeline "1440x900_60.00" 106.47 1440 1520 1672 1904 900 901 904 932 -HSync +Vsync
EndSection

3 In xorg.conf, locate the Screen section, the Display subsection, and string that begins with the "Modes" keyword. It contains modes list. Insert name of the new mode in the beginning of the modes list.

**Note.** Make sure, that "Depth" property of the subsection "Display" equals to "DefaultDepth" value defined in section "Screen".

4 If you use Macintosh computer of ordinary size, just restart X Server.

5 If you use MacBook or MacBook Pro, you have to take one more step. In the "Device" section change the driver from "fbdev" to "vesa". Now, save the changes and restart your virtual machine.
This chapter provides the information on how to change the configuration of particular virtual machines and how to set user preferences affecting virtual machines available for this user or affecting all virtual machines on the computer.

In This Chapter

Setting Parallels Desktop Preferences ................................................................. 205
Creating Floppy Disk Images ........................................................................... 217
Using Parallels Explorer .................................................................................... 218
Keyboard Shortcuts in a Virtual Machine .......................................................... 219
Multi-User Access to a Virtual Machine ............................................................ 222
Cloning a Virtual Machine ................................................................................. 224
Deleting a Virtual Machine ................................................................................ 227
Backing Up Virtual Machines ............................................................................ 230
Maintaining Virtual Hard Disks ......................................................................... 230

Setting Parallels Desktop Preferences

To edit user preferences choose Preferences from the Parallels Desktop menu. The Memory and Network preferences affect all users that work on the Macintosh computer and all virtual machines. The other preferences may be different for each user.
General Tab

Default folder for virtual machines:

/Users/UserName/Documents/Parallels

Perform action when virtual machine is running:

On application quit: Suspend
On Stop button: Stop
On Pause button: Pause

Shared web applications:

Web pages: Default
E-mail: Default
FTP: Default
Settings on this tab can be different for each user of your computer.

**Default folder for virtual machines.** A default location where Parallels Desktop saves files of the new virtual machine. It is possible to specify another location for a new virtual machine when using OS Installation Assistant in *Typical* or *Custom* mode.

**Perform action when virtual machine is running:**

Options of this group define virtual machines behavior when you click the Macintosh close button 🗑️ for the Parallels Desktop window or when you stop/pause the virtual machine.

- **On application quit.** Select an action that you would like to be performed when you quit application. If you are not sure if you want to stop or suspend virtual machines, select the *Ask me what to do* option.
- **On Stop button.** Select an action to be performed on stopping virtual machines.
- **On Pause button.** Select an action to be performed on pausing virtual machines. See the Suspending/Resuming Virtual Machine topic to learn about suspending /resuming virtual machines.

**Shared web applications**

Options of this group define applications to be used to open similar Mac OS X and Windows files and the Internet links.

- **Web Pages.** Choose the *Open in Mac OS X* option to use Mac OS X default browser to open all web pages. Choose the *Open in guest OS* option to open all web pages in the guest OS default browser. Choose the *Default* option if you want to open web pages found in the guest OS in the guest OS default browser, and to open web pages found in Mac OS X in Mac OS X default browser.
- **E-mail.** Similar options to use with e-mails.
- **FTP.** Similar options to use for FTP operations.
Memory Tab

On this tab, you can adjust the maximum amount of physical memory (RAM) the system reserves for all the simultaneously running virtual machines on your Macintosh computer. This value will affect running virtual machines of all users of your computer.

Adjust memory limit

- **Automatically.** Select **Automatically** to let Parallels Desktop calculate the reserved memory taking into account the following values:
  - the total amount of memory your Macintosh computer has,
  - the amount of memory your Mac OS X requires in average,
  - the number of virtual machines running at the moment.

The resulting amount of memory will be shared between all simultaneously running virtual machines. Memory for a particular virtual machine is set on the Memory tab (page 166) in the **Configuration Editor**.
- **Manually.** Select **Manually** to set the amount of memory reserved for virtual machine by using the slider. Memory amount must be in multiples of 4.

**Enable virtual memory preallocation**

This option allows preallocation of virtual memory for the virtual machine as a 1.5 GB temporary file on hard disk of your Mac when you start up Parallels Desktop. This ensures that the virtual machine will get the required amount of memory if you decide to increase it without restarting Parallels Desktop.

**Network Tab**
Parallels Desktop provides several types of networking in a virtual machine, particularly, host-only networking and shared networking (NAT). The **DHCP** tab is intended for specifying ranges of IP addresses to be assigned to virtual machines and primary OS in these two types of networking:

- **Enable DHCP Scope for host-only Networking** option allows using Parallels DHCP server for host-only networking. With this option on, you can set DHCP scope IP addresses, a range of IP addresses assigned by Parallels DHCP server for virtual machines running in the host-only network. Methods of configuring different types of host-only network are discussed in the Host-Only Networking (on page 154) topic in this chapter. If the check box is cleared, the DHCP server will not assign IP addresses.

- **Enable DHCP scope for shared Networking** option allows using Parallels DHCP server for shared networking. With this option on, you can set a range of IP addresses assigned by Parallels DHCP server for virtual machines in the shared networking (NAT) mode. Configuring of the shared networking is discussed in the Shared Networking (NAT) (on page 153) topic. If the check box is cleared, the DHCP server will not assign IP addresses.

**Note.** These two scopes must not contain the same IP addresses.

The **Start** address and **End** address values determine the first and the last IP addresses with the first address usually assigned to the DHCP server itself. The second address is usually given to Mac OS X. Other addresses are assigned to virtual machines. The scope **Start** address and **End** address should belong to the same subnet.

**Note.** Before changing any of the DHCP scopes in this tab make sure that there is no virtual machine running in host-only networking mode. To check the networking mode of a running virtual machine: point to the network adapter icon in the status bar and see the **Mode** on the help tag.
Appearance Tab

![Preference settings for appearance tab]
These preferences can be different for each user of your computer.

**Show applications in Dock.** Select *Coherence Only* if you want icons of Windows 2000/XP/2003/Vista application icons to appear in the Dock when you run the virtual machine in Coherence mode. Select *Always* if you want icons to appear whenever you run the virtual machine. Choose *Never* if you don't want to place application icons into the Dock. See also Running Windows applications (page 109).

**Dock Icon.** This option defines what type of icon will be placed in the Dock for Parallels Desktop application. The following types of icons are available: *Live Screenshot*, *System*, *Start menu*.

**Full Screen.** The *Change Mac OS X resolution* option allows changing Mac OS X resolution for displaying guest OS in full screen. Select this option when running a guest OS for which there is no Parallels Tools, otherwise, the guest OS when switched to full screen will have the same resolution as in window mode (and, actually, the same size, with wide black borders).

**Hidden Messages.** Click the *Restore* button to reactivate all suppressed messages. Parallels Desktop informs you about certain operations or situations by displaying appropriate messages. As a rule, a message dialog has message text and the *Do not show this message again* check box. If you select this option, next time when the same situation occurs, the message will not be displayed.

The system does not allow you to suppress messages that report potentially dangerous situations.
Animation Tab

- **Full Screen transition.** This option allows you to set the desired type of animation effect (or none) on switching Parallels virtual machine to full screen and back.
  
  The values available: Disabled, Fade, Zoom, Reveal, Slide, Warp, Cube, Switch, and Flip. Use the Animation Speed slider below to make the animation slower or faster.

- **OS Window transition.** This option allows you to set the desired type of animation effect (or none) on switching From OS Window view and back. The values available: Disabled, Fade, Zoom, Reveal, Slide, Warp, Cube, Switch, and Flip.
  
  - **Animate Coherence transition.** Select this option to turn on animated transition to Coherence and back to OS Window view. Clear the check box if you don't want any animation on switching to Coherence.
  
  - **Animate suspend and resume.** Select this option to turn on animation on suspend and resume. Clear the check box if you don't want any animation on suspend and resume.
  
  - **Animate Snapshots actions.** Select this option to turn on animation on snapshot actions. Clear the check box if you don't want any animation on snapshots actions.
  
  - **Animation Speed.** This slider allows you to speed up or slow down the animations. All animations set on this tab will be affected.
Keyboard Tab

![Keyboard Tab Image]

- **Release Input**: Ctrl, Alt, Shift, Custom
- **Toggle Full Screen**: Ctrl, Alt, Shift, Custom, Enter
- **Toggle Coherence**: Ctrl, Alt, Shift, Custom
- **Mouse Right Click**: Ctrl, Alt, Shift, Command, + Click
- **Remapping keys**: Remap CMD+ZXCVAF
- **Translate Num Enter to Alt Gr**
Hot key combinations can be different for each user of your computer.

**Release Input**

This key combination is used for releasing the keyboard and mouse input when it is captured in the virtual machine window. The default hot keys are: Ctrl+Option(Alt).

**Note.** You can release the mouse and the keyboard input from the virtual machine without pressing the hot key combination if you install the Parallels Tools. See Installing Parallels Tools (page 84) section to learn if this package is available for your guest operating system.

**Toggle Full Screen**

This combination is used to switch a virtual machine to the full screen and back. The default hot key is Option(Alt)+Return(Enter).

**Note.** See the Switching to Full Screen (page 107) topic for information on running virtual machine in full screen mode.

**Toggle Coherence**

These keys are used to switch Parallels Desktop virtual machine to Coherence and back. For details refer to the Coherence Tool (page 125). Default key combination is Ctrl+Option(Alt)+Shift.

**Mouse Right Click**

This is the key combination to emulate mouse right-click for a mouse that does not have the right key. The default hot key is Ctrl+Shift-click.

Click More Options to emulate right-click by delayed right click. Preferred delay is specified by the slider. Both methods of emulation can be turned on at the same time.
See also Keyboard Shortcuts in a Virtual Machine (on page 219) for more information on right-click emulation.

**Translate Num Enter to Alt Gr.**

On Mac books you may need to use Alt Gr key (right Alt key) which is absent on the keyboard. Select this option to use the Enter key on the Numeric keypad as Alt Gr key.

**Remapping Keys**

There are the following options:

- **Do not remap.** This option leaves traditional for Mac OS X hot keys combinations for Mac OS X only. In the guest OS, use hot key combinations standard for this operating system. For example, use Ctrl+C in Windows guest OS to copy to clipboard and Cmd+V to paste it in Mac OS X and Cmd+C in Mac OS X to copy and Ctrl+V in Windows to paste it.
- **Remap Cmd+ZXCVAF.** Turn this option on to use the same keys in the guest operating systems as in Mac OS X for similar operations.
- **Swap Cmd/Ctrl.** In the Windows guest OS use Cmd key on Mac keyboard as Ctrl key.

See also Keyboard Shortcuts in a Virtual Machine (on page 219).

**Defining New Key Combinations**

Each key combination must include at least one special key (Ctrl, Option(Alt) or Shift).

To define a new key combination, do the following:

1. Select check boxes for one or more special keys.
2. To add a custom key (other than Ctrl, Option or Shift):
   - select the Custom check box,
   - press the desired key on the keyboard, it appears on the blank button to the right,
   - click OK to apply the changes.
Creating Floppy Disk Images

A blank floppy image can be created in the following ways:

- Clicking the **Recreate** button on the Floppy Options tab of the Configuration Editor. See Floppy Options (page 168).
- Using **Add Hardware Assistant** to add a floppy drive to a virtual machine. See the Add Hardware Assistant (page 182).

Image of a real diskette can also be created in several ways:

- You may use an external USB floppy drive to create a floppy disk image in Mac OS X (see Creating a FDD Image of a Floppy Disk below in this topic).
- If in addition to Parallels Desktop and Macintosh computer, you have a PC with Parallels Workstation for Windows or Linux, you may create an .fdd image of a real diskette using the **Parallels Image Tool**, then transfer this image file to the Macintosh computer.
- Parallels Desktop can also read images of floppies created by WinImage or VMware applications. You only have to change the file extensions from .img and .ima to .fdd.

Creating a FDD Image of a Floppy Disk

To create an .fdd image of a diskette do the following:

1. Plug in a USB floppy drive into your Macintosh computer and insert the diskette which image you want to create.
2. Open **Finder -> Applications -> Utilities -> Disk Utility**.
3. In the Disk Utility window, select the diskette in the left pane and click the **New Image** button.

4. In the opened dialog specify:
   - the name of the image in the **Save As** field,
   - where to save the image in the **Where** field,
   - select **Read/Write** in the **Image Format** drop-down list,
   - and **None** for the **Encryption**.
Then click **Save**.

5. Find the ready `.dmg` image of the diskette. Right-click (Ctrl-click) it and select **Get Info** from the shortcut menu. In the **Name & Extension** group change the file extension from `.dmg` to `.fdd`. Press **Enter**.

6. When you are prompted to confirm that you want to change the extension of the file, click the **Use .fdd** button.

### Using Parallels Explorer

The current version of Parallels Desktop includes Parallels Explorer - the tool for browsing the contents of the virtual machines. Parallels Explorer finds Parallels and third-party virtual machines on your computer and displays them as folders so that you can see the files and folders on the virtual machine disks and copy/move/rename files and folders and copy or move them to Mac OS X or another virtual machine.

Parallels Explorer is installed during the Parallels Desktop installation.
Keyboard Shortcuts in a Virtual Machine

How to Press F1-F12 and Others Function Keys in MacBook and MacBook Pro

To press F1–F12 in your virtual machine please press Fn+(F1–F12) key combination instead.

If you want to press Ctrl+Alt+Del key combination in a virtual machine, use one of the following techniques (see also Shutting Down and Resetting a Virtual Machine (page 104)):

- select Actions -> Send Key -> Ctrl+Alt+Del in menu,
- press Ctrl+Option(Alt)+Del while the keyboard input is captured inside a virtual machine window.

If you want F1–F12 keys to be recognized as they are, do the following:

1. Go to the Apple System menu -> System Preferences -> Keyboard & Mouse in the Hardware section.
2 In the Keyboard&Mouse window, select Keyboard tab and check option **Use F1-F12 keys to control software features.**
Using Mac System Keyboard Shortcuts in a Virtual Machine

Macintosh keyboards have a number of system keys, and problems may arise when you use these keys in a virtual machine. For instance, the F9 – F12 keys are reserved for Dashboard & Expose operations, whereas F11 can be used in Windows Internet Explorer for full screen mode. To use these keyboard shortcuts in a virtual machine, do the following:

1. Go to the Apple System menu, open System Preferences, and click Universal Access in the System section.
2 In the Universal Access window select Enable access for assistive devices option.

Multi-User Access to a Virtual Machine

By default, Parallels Desktop places a new virtual machine to the home folder of the user created it. This folder is specified on the Common tab of the Preferences dialog (see the (page 156)General Tab topic in this chapter).

If you want to provide an access to a virtual machine for other users:

1 Copy all the components of the virtual machine, in particularly:
   - virtual machine folder,
   - configuration file (.pvs),
   - hard disk image(s) (.hdd),
   - saved state file (.sav) (if any),
- CD/DVD image file (.iso) (if any),
- floppy disk image file (.fdd) (if any),
- serial and parallel port output files (.txt) (if any)

to the User/Shared folder of your Mac.

2 Set proper access rights to all of the copied files and the virtual machine folder. For this:
- right-click on a file and select Get Info item in the context menu,
- in the Info window, click Ownership & Permission to open that part of the screen,
- for the You can option set Read & Write,
- click Details,
- for the Other option select Read & Write.
A complete copy of a virtual machine can be created using the **Clone Virtual Machine Assistant**. The clone includes as many virtual hard disks as were connected to the original machine. By default, the assistant places new files (copies of original files) into a new folder, but you may specify an existing one. Copies of virtual hard disks and configuration file are always placed to the same folder.

Same name devices of the cloned virtual machine are connected to the same name drives or same name disk images as the devices in the original machine. If in original virtual machine CD/DVD-ROM drive is connected to an `.iso` CD/DVD disc image file, in the cloned virtual machine the CD/DVD-ROM drive is connected to the same image file. The same is true about the floppy drive. However, for serial/parallel ports, if such were used in the original virtual machine, new output files are created.

If the original virtual machine has snapshots, the cloned virtual machine will have the same structure of snapshots.

If a network adapter was enabled in the original configuration, for a clone, a new MAC address is generated.

Before cloning a virtual machine, make sure the following conditions are met:

- The virtual machine is open, but the guest OS is not running. If it is running, the **Clone** command in the **File** menu is disabled.
- It is not a blank virtual machine. Blank virtual machines can not be copied.

To make a clone of a virtual machine:

1. Open the virtual machine you want to clone.
2 Select **File -> Clone** in the menu. The Clone Virtual Machine Assistant starts. Click **Next**.

3 In the next step, **Prepare to clone**, you have to specify a folder for the cloned virtual machine. The name and path suggested by the assistant are made by adding "Clone of" at the beginning of the original virtual machine name and path. You can type another folder name. Remember that a virtual machine name should be no longer than 50 characters. Virtual machine files will have the same name as the folder.

Click **Finish** to start copying the machine.
While the virtual machine is being copied, the **Copying in progress** dialog indicates the current state of the process. If everything is OK, the assistant informs you that copying has been completed successfully, and a new machine is ready. Click **Exit** to close the assistant.

A cloned virtual machine is open, and you can start it.
Deleting a Virtual Machine

Virtual machines can be deleted manually, however, we recommend that you use the Delete Virtual Machine Assistant that finds all the files that make up the virtual machine and all files connected to it.

The assistant helps remove the following virtual machine files:

- configuration file,
- virtual hard disks connected to the virtual machine,
- snapshots,
- ISO images of CD/DVD discs connected to the virtual machine (if any),
- floppy disk image (.fdd) connected to the virtual machine (if any),
- output files of serial and parallel ports (if any),
- folder where virtual machine files are stored.

The assistant can delete an open virtual machine that meets the following conditions:

- Its guest OS is not running. If it is running, the Delete command in the File menu item is disabled.
- The virtual machine is not opened by another instance of Parallels Desktop.
- The virtual machine is not blank.

To delete a virtual machine:

1. Open the desired virtual machine.
2. Select Delete in the File menu. The Delete Virtual Machine Assistant window appears. Click Next.
3 The assistant finds all files related to the virtual machine and displays the list of them on the List of Files dialog. The configuration file, virtual hard disk, output files of serial and parallel ports, and the home folder are pre-selected for deleting. However, .iso and .fdd images are not listed, because they can be used by other virtual machines. If you want to delete them too, select them for deleting on this dialog.

Note. Make sure you are not going to delete the virtual hard disk that is also used by other virtual machine.

Review the selection and click Delete.
4 The assistant removes the selected files from Mac's hard disk. If operation was successful, the next dialog appears.

The virtual machine is considered as successfully deleted if all the selected components or all selected components except the home folder (if it was chosen for deleting) have been removed. If the home folder contains any other files, the folder will not be deleted.

Click **Exit** to close the assistant.
Backing Up Virtual Machines

Most people don't seriously consider regular backups as a necessity until they have experienced a significant data loss. You have to create your own backup strategy to protect yourself from data loss. Virtual machines are vulnerable to crashes as well as physical computers.

So you can back up your virtual machine by one or several of the following methods:

- By copying virtual machine files manually.
- By cloning the virtual machine with the help of Clone Virtual Machine Assistant. Give the descriptive name to a clone and save in a location specially designated for backups.
- Also take into account the risk of data loss to crash of physical computer, and periodically save copy or clone on an external drive or on another computer.
- Make successive backups by creating snapshots for the virtual machine. This works as differential backups and will save disk space on your Macintosh computer. Please remember that snapshots cannot be used without the virtual machine they were created for.
- Decide what you really need to back up. Maybe you need to back up the data only, not the entire virtual machine. Back up your data with Parallels Explorer. This will save disk space on your Macintosh computer or on other preferred backup storage place. For details see Parallels Explorer User Guide.

Maintaining Virtual Hard Disks

Expanding virtual disks files grow in size as you work with them even if you delete unnecessary and temporary files periodically. Plain disks become defragmented. Two built-in utilities help to maintain virtual disks.

- **Disk Compacting Tool** cleans up the unused disk space on expanding virtual hard disks and cuts off the cleaned free space thus reducing the sizes of virtual hard disk image files in Mac OS X. We recommend that you use Disk Compacting Tool on your virtual machines from time to time to save space on the host hard disk. For more information refer to the Compacting Virtual Disk (page 231) topic.

  **Note.** The Disk Compacting Tool does NOT process plain virtual disks.

- **Parallels Compressor.** For Windows 2000 and later versions. Deletes temporary and unnecessary files, empties the Recycle Bin, performs disk defragmenting and disk compacting. Options can be selected. For details on Parallels Compressor, see the Using Parallels Compressor (page 233) chapter.

  **Note.** Both utilities cannot process virtual disks if the virtual machine has the **Undo disks** option enabled or if it has snapshots.
Compacting Virtual Disks

Compacting can be performed only for expanding disks no matter whether they are single-file disks or split disks. For more information on disks format refer to Virtual Hard Disks (page 19).

Note. Compacting of virtual disks cannot be performed if the virtual machine has the Undo disks option enabled or if it has snapshots.

In general, the compacting procedure consists of two stages:

1. A preparatory stage, performed in the guest OS. This stage is supported only for Windows 95 /98 /NT /ME /2000 /XP /2003 /Vista guest OSes only after Parallels Tools (page 85) are installed. All types of partitions: FAT 16, FAT 32, and NTFS, can be processed. During this stage, the unused space is being cleaned.

2. A compacting stage performed in Mac OS X. This procedure removes clean unused space from the virtual disk file (only space available at the end of the file). This is available for virtual machines with any other guest operating system and is performed from Configuration Editor.

Two-Stage Disk Compacting in Windows Guest OSes

To compact disks in Windows 95 /98 /NT /ME /2000 /XP /2003 /Vista guest OSes:

1. When the virtual machine is running, open the Parallels Tools Center by clicking its icon on the status bar.

2. In the Parallels Tools Center, open the Disk Compacting Tool tab.

3. On the Disk Compacting Tool Options tab, the table in the Status group displays the list of volumes (disks and partitions) that can be compacted. Select the volumes you want to compact. Note that compacting will be more efficient, if you select all partitions on the virtual disk.

If you want to perform both stages of compacting at once, select the Execute all stages at once option.

Click Start. All the selected disks will be processed one-by-one.

4. The first stage (that is cleaning unused space) may take a significant time.

5. If you have selected the Execute all stages at once option, the second stage starts immediately after the first. The Disk Compacting Tool pauses the virtual machine, and Parallels Desktop compacts the virtual disk files in Mac OS X. The Compacting virtual hard disk dialog is displayed. Click Cancel to stop compacting, in this case, the sizes of virtual disk files will not be reduced.

When the process of compacting is successfully completed, click OK.

6. If you have NOT selected the Execute all stages at once option.

When the first stage of processing disks is complete, you will be prompted to proceed with the second stage.

You may select to perform the second stage of compacting later. See One-Stage Disk Compacting below.
One-Stage Disk Compacting

The one-stage disk compacting is used as a second stage of disk compacting procedure for Windows guest OSes (described above) or as the only one disk compacting procedure available for other guest OSes. This disk compacting procedure is performed in the primary operating system; it doesn't clean unused space, it only "cuts off" unused space from the image file, thus reducing its size in the primary OS.

To perform disk compacting:

1. When the virtual machine is stopped, click the Hard Disk link on the Configuration Page.
2. Then click the Compact button on the Advanced tab of the Hard Disk Options. While compacting is being performed, the Compacting virtual hard disk dialog is displayed.
3. If there are several hard disks that you want to compact, repeat Steps 1-2 for each expanding-type virtual disk.
Parallels Compressor™ is an easy-to-use Parallels tool which will help you keep your virtual machines efficient for many purposes.

**Note.** Parallels Compressor is not available for the virtual machines that use the Boot Camp partition. The Run Parallels Compressor menu command is disabled.

Parallels Compressor allows users to:

- Effectively clean up disk space in a virtual machine.
- Significantly reduce the size of virtual hard disks files.
- Efficiently use the resources of a physical hard disk.

**Warning.** Compressing of virtual machine cannot be performed if the virtual machine has the Undo disks option enabled, or if it has snapshots. Compressing is also unavailable for the virtual machines with plain disks.

If, nevertheless, you want to compress the virtual machine that has snapshots, delete all the snapshots with Snapshot Manager before you start compressing the virtual machine's disks. For more information refer to Snapshot Manager (page 147).

To compress the virtual machine with Undo disks, first disable the Undo disks feature in Configuration Editor, for details refer to Working with Undo Disks (page 150) topic.

**In This Chapter**

- How Does Parallels Compressor Process a Virtual Machine ............................................. 234
- Requirements for the Guest Operating System................................................................. 235
- How to Run Parallels Compressor .................................................................................. 235
- Options of Parallels Compressor.................................................................................... 237
- Compression in Automatic Mode .................................................................................... 241
- Parallels Compressor Wizard ....................................................................................... 244
- Further Reducing the Disk ............................................................................................. 249
How Does Parallels Compressor Process a Virtual Machine

Compressor processes a virtual machine in the following way:

- Deletes unnecessary files on the current system.
- Defragments expanding virtual disks and cleans up unused space.
- Compacts expanding disks.

The actions performed on your particular virtual machine depend upon the running mode:

- In **automatic** mode Parallels Compressor compresses only the current system disk performing the pre-defined set of actions.
- In **manual** mode you are able to choose disks to compress and actions to perform.

More about running modes and other Compressor properties can be found below in the Options of Parallels Compressor (page 237) section.

**Steps of the Compression Procedure**

Parallels Compressor is designed to perform the most efficient compression of a virtual machine. The procedure consists of two steps:

- a preparatory step performed in the guest operating system (deleting temporary and unnecessary files, defragmenting virtual disks and cleaning unused disk space);
- a compacting step (reducing the size of the virtual disk file) performed in the primary operating system.
Requirements for the Guest Operating System

Parallels Compressor supports the following guest operating systems:

- Windows Vista Ultimate, Enterprise, Business
- Windows Server 2003 Standard Edition SP0, SP1
- Windows Server 2003 Enterprise Edition SP0, SP1
- Windows Server 2003 Web Edition SP0, SP1
- Windows Server 2003 Small Business Edition SP0, SP1
- Windows XP Professional Edition SP2
- Windows XP Home Edition SP2
- Windows 2000 Professional SP4
- Windows 2000 Server SP4
- Windows 2000 Advanced Server SP4

In other guest operating systems we recommend using the Disk Compacting Tool. For the description of the procedure refer to Compacting Virtual Disks (on page 231).

How to Run Parallels Compressor

Before Starting Parallels Compressor

Before starting Parallels Compressor perform the following steps:

1. Back up your virtual machine by cloning it or by copying its hard disk files to a safe location.

   This will allow you to restore your VM in case you do not like the results of the compression.

   Warning. The result of virtual machine compression is irreversible.

2. Make sure your virtual machine configuration includes the CD/DVD-ROM drive.

   If it does not:
   - turn off the virtual machine,
   - open the Configuration Editor (page 155),
   - add a CD/DVD-ROM drive into the configuration. Refer to Adding and Removing Devices (page 182) for details,
   - on the CD/DVD-ROM Options tab make sure that the Enabled check box is selected.
How to Start Parallels Compressor

To start Parallels Compressor:

1. Power on the virtual machine you want to compress.
2. Log in to the guest operating system as a user with administrator rights.

   *Note.* To run Parallels Compressor in a virtual machine you must have administrator rights in the guest operating system.

3. Select *Actions* -> *Run Parallels Compressor* from the menu.

Running Parallels Compressor

Parallels Compressor has the following running modes:

- *automatic,* the default mode. In this mode Compressor uses the default compression options.
- *manual,* Parallels Compressor runs as a wizard which helps you select the options of virtual machine compression.

When you start Parallels Compressor, the ISO file with Compressor is connected to the virtual CD/DVD-ROM and displays the dialog box with a time indicator. The time indicator shows the time remaining until Parallels Compressor will run in automatic mode (timeout is about 10 seconds).
To run Parallels Compressor:

- in **automatic** mode, don't do anything, just wait until the timeout expires. Detailed information about running Compressor in this mode is given in the Compression in Automatic Mode (page 241) topic.

- in **manual** mode, press the ESC key or click the **Manual Mode** button on the dialog box before the timeout expires. Detailed information about running Compressor in this mode is given in the Parallels Compressor Wizard (page 244) topic.

**After Compressing Is Finished**

When Parallels Compressor finishes its work, it disconnects the ISO with Parallels Compressor from the virtual machine and restores the previously existed connection. If the connection is not restored automatically:

- select **Actions / Cancel Parallels Compressor** in the menu.

**Note.** Do not perform this command when Parallels Compressor is running. If the ISO file is disconnected during the process, the virtual machine may behave unpredictably.

Also refer to Further Reducing Disk Size (page 249) to get an idea of what else you can do to compress virtual hard disks.

**Options of Parallels Compressor**

This section describes in detail all the options of Parallels Compressor available in **manual** mode.
Running Modes

Parallel Compressor has two running modes:

- **Automatic.** Default running mode. In automatic mode, Compressor performs *Express Compression* without prompting the user to confirm operations.
- **Manual.** Compressor runs as a wizard which helps you choose various compression options.

Once launched, Compressor displays the dialog box with a time indicator showing the time remaining until Compressor will run in automatic mode.

To run Compressor in *automatic* mode don't do anything, just wait.

To run Compressor in *manual* mode press the ESC key or click the *Manual mode* button before the timeout expires.

Command-line keys for Compressor

The current version of Parallels Compressor has the following keys:

- `/A` - to start the program in automatic running mode;
- `/G <cmdline>` - to start third-party defragmentation tool instead of the tool used by Parallels Compressor, `<cmdline>` stands for the path and name of such tool;
- `/H` - to open the Help panel with the list of available keys;
- `/S` - to run Compressor in completely non-interactive mode ("silent mode").

Comments to command-line format

- The program name and key are separated by a space.
- If spaces are used in the `<cmdline>`, enclose the expression in double quotes as follows:

  ```
  ParallelsCompressor /G"C:\Program Files\...defrag.exe"
  ```
- There is no space between the key and its parameter as in the example above.

Express and Advanced Modes

When launched in manual mode, Parallels Compressor prompts you to choose the compression mode for processing a virtual machine:

- **Express** compression. Recommended for all users. In this mode, the compression is performed at the *High* level. That means, all compression tasks will be executed except for *Clean up Drivers Cache*, which is skipped by default. During Express compression, only one virtual disk is processed, the current system disk.
- **Advanced** compression. Recommended for advanced users only. In Advanced compression mode, the wizard lets you select options: particular logical disks, desired compression level, and tasks to execute.
Selecting Logical Disks for Compression

A virtual machine may have several virtual disks, some of them can be partitioned. In Advanced mode you can select one or more logical disks for compression.

In the **Select Logical Disks** dialog box, Compressor displays the list of virtual machine's disks.

The following virtual machine's disks cannot be processed by Compressor:

- virtual disks in plain format,
- virtual disks with snapshots,
- *Undo* disks.

If all the selected disks cannot be compressed, Parallels Compressor displays the message that the compression cannot be performed, and stops. If, at least one of the selected virtual disks can be processed, Compressor will perform the requested operations.
Compression Levels

Parallels Compressor supports three levels of compression: Low, Medium, High. Each level suggests the execution of certain tasks. The wizard displays the complete list of such tasks.

The complete list includes the following tasks:

- Truncate Page file (recreates the system page file of smaller size);
- Clean Up Temporary System Files (deletes temporary files used by the system for acceleration of operations);
- Clean Up System Cache (deletes temporary data stored by the system on disk to increase performance);
- Empty Recycle Bin (permanently removes previously deleted files from the Recycle Bin);
- Clean Up Temporary Internet Files (cleans up the Internet Explorer cache, deletes cookies, history, address bar, temporary files);
- Disable Hibernate file (disables hibernate file which stores the virtual machine memory when the virtual machine is turned off);
- Compact virtual disk(s) (reduces the size of disk in primary operating system);
- Clean Up Temporary Setup Files (deletes installation files used by MS Office and other programs);
- Clean Up System Media Files (deletes temporary files used by Media Player);
- Clean up Drivers Cache (empties the cache for the most popular drivers. If you are going to install new hardware, clear this check box);
- Clean Up System Restore Information (deletes data related to the last successful system loading).

By default, tasks are assigned to the compression level in the following way:

- High level: all tasks on the list (those marked by ☐, ☐, ☐)
- Medium level: all tasks marked by ☐ and ☐
- Low level: only tasks marked by ☐

The desired level of compression can be chosen with the help of a slider which has three positions: Low, Medium, High. For each task on the list there is a check box. When the slider is at the High position all tasks are selected. Moving the slider from the High to Medium position, clears check boxes for tasks marked by ☐; moving the slider to the Low position clears check boxes for tasks marked by ☐ and leaves selected only those tasks which are suggested for execution at the Low level (☐).

Additionally, with any level chosen, you can add or remove tasks by selecting or clearing corresponding check boxes. To restore the selection of tasks default for the chosen level, click the Set as default button.

Note. The check box for the Compact virtual disk(s) task cannot be cleared; this task is mandatory for each level.

In Express compression mode (or in automatic mode) all tasks are executed as suggested by the High level, only the Clean up Drivers Cache task is skipped.
**Advanced** compression allows users to select any set of tasks.

### Compression in Automatic Mode

In automatic mode Compressor uses the following default options:

- only one virtual system disk is being processed (if the virtual machine has several system disks, the current system disk will be compressed);
- compression is performed at the High level (page 240), and all compression tasks will be executed, except for **Clean up Drivers Cache**, which will be skipped.

**Note.** During the process, Compressor displays several dialog boxes. Although they are used for information purposes, you can click **Cancel** at any time to stop Compressor or click the **Help** button to get necessary information.

1. Compressor displays the **Execution in progress** dialog box that informs you what tasks are being executed.
2 The next dialog box informs you that Compressor is going to restart the virtual machine.

![Parallels Compressor dialog box]  

Parallels Compressor has finished the first step of virtual machine compressing. Please restart your virtual machine to let Parallels Compressor to execute the rest of selected tasks. After restart of virtual machine, the wizard starts automatically.

Click Restart if you want to perform the final step now. Click Cancel if you are going to perform it later.

3 Compressor restarts the virtual machine.

4 After the restart, it displays the dialog box with the time indicator which shows the time remaining until Compressor will continue the execution of compression tasks.

![Parallels Compressor dialog box]
If you click the **Manual mode** button before the timeout expires, you can postpone the execution of the remaining tasks. In this case you will see the dialog box shown below. Click **Next** at any time to let Compressor continue the operation.

5 Compressor resumes the execution of the compression tasks and informs you of the tasks currently being performed in the **Execution in progress** dialog box.

6 When Compressor successfully finishes its work, you will see the following dialog box.

Click **Finish** to exit Parallels Compressor.
Parallels Compressor Wizard

In manual mode, Compressor starts as a wizard.

1. The wizard displays the Welcome dialog box. If you’d like to skip the Welcome dialog box next time you run the wizard, select the Skip introduction next time check box. Click Next to continue.

2. Choose mode of virtual machine compression. At this step, the wizard detects the type of the guest operating system and prompts you to choose between Express and Advanced compression (page 238). If you choose Express compression, the wizard will use the default compression options.
If you choose **Advanced** compression, you will be able to select certain options of compression.

![Parallels Compressor - Parallels](image)

**Choose mode of virtual machine compression**

Please choose mode of virtual machine compression

- **Express compression**
  - This mode lets you get a compressed virtual machine in less time.

- **Advanced compression**
  - This mode lets you customize the process of virtual machine compression by selecting certain tasks.

3 **Select Logical Disk(s).** The wizard determines what hard disks are available in your virtual machine. Please refer to the Selecting Logical Disks for Compression (page 239) topic if you are not sure what types of disks are supported. The selected disks of unsupported types will not be compressed.
Use check boxes to select a disk or disks. Click Next. If you selected Express compression in the Step 3, skip Step 4 and Step 5.

4 In the Choose Compression Level dialog box choose the Compression level (page 240). There are three levels: High, Medium, Low.

To choose the level, place the cursor over the level slider and smoothly move the slider to the desired level or just click the levels consecutively starting from High until the slider reaches the desired level. For each level certain tasks are suggested by default, but you can select check boxes for tasks you want to be executed and clear the check boxes for tasks you don't want to be executed. You can also click the Select all button to select all tasks or click Clear all to clear all check boxes. Click Set as default to restore the default selection of tasks for the chosen level.

The check box for the Compact virtual disk task is always disabled.

Click the Compress button. The wizard starts execution of the selected tasks, and you can see the progress of the operation.
If you cleared the check box for the **Truncate page file** option, the wizard skips **Step 5** and **Step 6**.

5 **Preparing to restart.** Depending on the tasks you have selected on the previous step, the wizard may require to restart the computer.

Click **Next** to restart your virtual machine.
If you click **Cancel**, the process of virtual machine compression will be resumed automatically the next time you start your virtual machine.

6 When the restart is completed, the wizard is ready to resume the execution of tasks. Click **Next**.
7 On the wizard's next dialog box, you can see the progress of operations. If you have chosen **Express** compression, the wizard performs the disk compacting without prompting you to confirm this operation.

8 Disks compacting is the final step of compression.

Click **Yes** to perform the operation. Click **No** to skip disk compacting.

![Parallels Compressor dialog box](image)

9 Now, compression of the virtual machine is completed.

Your virtual machine is compressed, and its expanding disks are significantly reduced in size. Click **Finish** to exit Parallels Compressor.

![Parallels Desktop Uninstaller](image)

### Further Reducing the Disk

After you have used Compressor to process your virtual machine, you can reduce the virtual machine's size even further for storage purposes.

If you are going to share the virtual machine hard disk files (that is to copy to another computer or to transfer them over the network), then the smaller its disks are, the better. Once Compressor has completed its work, turn off the virtual machine. Running the virtual machine after compression has been completed will increase the size of its system disk file (the system page file increases as the virtual machine is running). As the virtual hard disk is just a file on your computer, you can archive it with WinZip or WinRAR, whatever you prefer. The size can be reduced by 50% or more.
This chapter provides all the information necessary to use Boot Camp partition with Windows XP or Windows Vista installation via Parallels Desktop.

**In This Chapter**

Overview ........................................................................................................................................ 251
Creating a Virtual Machine for Boot Camp .................................................................................. 252
Booting via Parallels Virtual Machine ....................................................................................... 254
Booting via Boot Camp ............................................................................................................... 255
Overview

In the current version of Parallels Desktop you can use your Boot Camp Windows XP (SP2) or Windows Vista partition as a bootable disk or as a data disk in virtual machines.

**Warning.** If you installed other than Windows XP (SP2) or Windows Vista operating system in Boot Camp, you may damage this installation trying to use it via Parallels Desktop virtual machine.

**Using Boot Camp partition as a data disk**

To use the Boot Camp Windows partition as a data disk, add it as a hard disk to an existing Windows XP or Windows Vista virtual machine respectively. Add the disk with the help of Add Hardware Assistant (page 182). Windows XP and Windows Vista operating systems will automatically recognize it as a new disk.

**Using Boot Camp partition as a bootable disk**

If you install Parallels Desktop on the Macintosh computer with Boot Camp Windows XP/SP2 or Windows Vista partition, and Parallels Desktop detects that there are no virtual machines on the computer, it automatically creates a new virtual machine for this Boot Camp partition which is placed to the following location:

<Username>/Documents/Parallels/My Boot Camp

- If the Windows partition is mounted to Mac's desktop, Parallels Desktop attempts to recognize the operating system installed on the partition and creates appropriate virtual machine for the recognized OS.
- If the Windows partition is not mounted to the desktop, or if Parallels Desktop cannot recognize the operating system, it creates a virtual machine for Windows XP. If you really have Windows Vista installed on the Boot Camp partition you have to change the type of the guest OS for the virtual machine from Windows XP to Windows Vista in Configuration Editor.

Alternatively, you can create a new virtual machine for Windows XP or Vista with Boot Camp partition as a bootable disk or replace a bootable virtual disk by Boot Camp Windows partition in an existing Windows virtual machine with the help of Configuration Editor.

**Note.** It is important to specify the type of the guest OS in the virtual machine correctly, in accordance with the operating system installed on the Boot Camp partition.

When you boot into Boot Camp Windows, Parallels Desktop creates one more configuration for boot loader and installs Parallels Tools. Using Boot Camp Windows XP via virtual machine may require to re-activate Windows XP.

After that, you can use Boot Camp as usually to boot into the Windows partition, or you can boot into it via Parallels virtual machine, see Booting via Parallels (page 254).

**Using "Custom Boot Camp" configurations**
(For advanced users only). The current version of Parallels Desktop for Mac now experimentally supports so-called Parallels custom configurations. A custom configuration allows using several hard disk partitions (grouped as "Custom Boot Camp disks") and can be created manually by editing any virtual machine's configuration file. For more information please refer to FAQs on Parallels web site: http://www.parallels.com/products/desktop/faq/.

Limitations for Parallels virtual machines using Boot Camp partition

Parallels virtual machine using Boot Camp Windows partition either as a bootable volume or as a data disk has a number of limitations:

1. It cannot be suspended or paused.
2. Such a virtual machine cannot have snapshots, and the **Undo disks** feature cannot be enabled for it.
3. Compression or compacting cannot be performed for the Windows on the Boot Camp partition.

Creating a Virtual Machine for Boot Camp

To create a new virtual machine for using Boot Camp Windows XP/SP2 or Windows Vista partition do the following.

1. Boot into Mac OS X.
2. Open Parallels Desktop, select **New**.
3. When OS Installation Assistant starts, select **Custom** mode of OS installation.

4. When prompted to select virtual hard disk option, select **Use Boot Camp**.

5. Then proceed as described in the Custom Installation (page 67).
Booting via Parallels Virtual Machine

To boot into Boot Camp Windows partition the virtual machine for the first time do the following:

1. Start your Macintosh computer, boot into Mac OS X.
2. Start Parallels Desktop and open the virtual machine created for using the Boot Camp partition.
3. You may be prompted to authenticate using your Mac's administrator account.
4. Start the virtual machine.
5. For a short time, you will see the black screen and a choice of available configurations on it. Proper configuration will be chosen automatically.
6. You'll see Windows guest OS starting up. You may notice problems with the mouse and keyboard; do nothing, just wait until they become enabled.
7. Windows XP may require re-activation because of hardware change.
8. Windows Vista will restart automatically.
9. You may be prompted to enter your Windows username and password. You must log in as user with administrator rights.
10. The installation of Parallels Tools starts automatically. When installation is complete, the guest operating system will be automatically restarted.
11. After restart of the guest operating system, the mouse and keyboard will work fine.

**Warning.** In case you met unexpected error (not related to the guest OS) while working with virtual machine using Boot Camp Windows installation, please close and start again this Parallels virtual machine before you try to boot via Boot Camp as usual.

After that, when booting into Boot Camp Windows partition via virtual machine, you have to follow only Steps 1-5; there should be no problems with keyboard and mouse.

**Note.** It is not possible to suspend a virtual machine connected to Boot Camp.

**Troubleshooting Windows XP missing drivers**

If when booting into Boot Camp Windows XP via virtual machine, you get the following message: Parallels Desktop cannot find necessary drivers to configure your Boot Camp partition. Please refer to Help> Parallels Desktop Help>Using Boot Camp Windows Installation for troubleshooting, try the following:

1. Boot into Windows XP via Boot Camp.
2. Insert Microsoft Windows installation disc which was used for this Windows installation.
3 Locate the folder i368 on the disc and open it. Copy the following files: driver.cab and any of spN.cab files (sp1.cab or sp2.cab, etc depending on service package installed) to the folder: C:\Windows\Driver Cache\i386.

Booting via Boot Camp

After you installed Parallels Desktop, and booted for the first time into the Boot Camp Windows partition via virtual machine, you can continue booting into this partition as usually, via Boot Camp. Parallels Tools installation doesn't affect Windows operating system itself, it only helps you work with this operating system via virtual machine.

1 Start your Macintosh computer, perform the usual actions required to boot into Boot Camp.
2 You'll see Windows starting up.

Troubleshooting

When booting into Boot Camp, you may get the black screen with the choice of two configurations:

- Parallels
- Windows XP or Windows Vista

You may get an error message about a computer disk hardware configuration problem.

To troubleshoot a problem:

1 Restart your Macintosh computer and boot into Mac OS X.
2 Start Parallels Desktop. Start the virtual machine which uses Boot Camp Windows installation as a bootable disk.
3 Wait while the guest OS is fully loaded and running. Shut it down.
4 Restart your Macintosh computer.
5 Try to boot via Boot Camp again. This time, booting must be successful.

Anyway, you can connect this partition as a data disk to any Windows XP or Windows Vista virtual machine.
Using Parallels Transporter

Parallels Desktop for Mac has built-in Parallels Transporter™. Parallels Transporter is an easy-to-use Parallels application which helps you migrate information from a physical or virtual computer to a Parallels virtual machine on your Macintosh computer. This chapter contains an overview of Parallels Transporter usage scenarios.

For more detailed information see *Parallels Transporter User Guide*.

**In This Chapter**

Migration Scenarios ........................................................................................................257
Setting up the Environment .................................................................................................258
Migration Scenarios

Migrating from a remote computer

For this operation you use Parallels Transporter on the Macintosh computer and Parallels Transporter Agent on a PC.

The volume where Parallels Transporter Agent is installed is called an active volume. The operation is supported for the active volumes with the following operating systems: Microsoft Windows 2000/XP/2003/Vista. Only to the listed operating systems Parallels Transporter can apply necessary changes to make images of active volumes bootable in a Parallels virtual machine.

Parallels Transporter has two migration modes:

- **Express.** Allows quick migration of one active volume. As a result, you will get a ready-to-use Parallels virtual machine which would have the guest operating system installed and all the applications and data you used on that volume.

- **Advanced.** Allows migration of several volumes at once. In one migration session only one active volume (if selected so) can be made bootable, and a new virtual machine will be created for it. Other volumes will be migrated as data disks if they have file systems recognizable by Transporter Agent.

If you want to use a migrated disk as a boot volume (system disk) in your virtual machine you must provide an installation CD for the operating system that runs on the active volume of the source computer (you can also use an ISO image of such installation CD). Parallels Transporter may need to re-install a few drivers, because hardware on the source computer and default hardware in a virtual machine are different.

**Warning.** If you migrate a volume with Windows OS installed on it and want to use its image as a bootable virtual disk, please note that there may be activation problems. OS migrated to a virtual machine detects that the hardware was changed and may require re-activation.

Parallels Transporter Agent enables you to migrate data from non-active volumes of a source computer and creates images of those volumes. A resulting image can be connected as a data disk to a virtual machine with an operating system compatible with the file system on that image. Disk images of non-active volumes with supported operating systems can be made bootable (in a Parallels virtual machine) later.

Migrating from a third-party virtual computer

You can use Parallels Transporter for converting a third-party virtual computer into Parallels virtual machine (Express and Advanced modes), and for converting a third-party virtual disk to Parallels virtual machine or disk (Advanced mode). If you select to convert the entire third-party virtual computer, the configuration of the resulting Parallels virtual machine will be the similar to the original one. This operation is supported for VMware virtual machine and Microsoft Virtual PC.
You also can process an already existing non-bootable Parallels virtual disk image (result of migration from a system volume of a remote PC), so that this image can be used as a bootable volume in a Parallels virtual machine (Advanced mode only).

**Migrating from a remote computer locally**

The operation can be performed on the remote source PC with one of the supported operating systems.

You must download proper Parallels Transporter package for PC and install both Parallels Transporter and Transporter Agent on a boot volume. You can migrate one or several volumes in one session (Advanced mode) and one active volume in Express mode. As a destination, you can specify an external USB drive on the same computer in case you don’t have local network to transfer the images right to your Macintosh computer.

---

**Setting up the Environment**

Parallels Transporter is installed along with Parallels Desktop, it is located in the Home Folder/Applications /Parallels folder on your Macintosh computer. It can be launched from the menu: **File -> Import**.

For scenarios involving migration from a PC the following package is required:

- for PC with Windows installed - Parallels-Tsp-2.0.XXXX-Win.exe.


Each package contains Parallels Transporter and Parallels Transporter Agent for PC. Depending on what scenario will be used, install Parallels Transporter Agent or both on a source PC. Before you start migration make sure that Macintosh and PC computers are connected by network cable and see each other over the network. Check that you have enough free disk space on the host computer to allocate to the resulting images.

**Warning.** Although Parallels Transporter Agent can be successfully installed on Boot Camp partition with Windows XP and Vista, migration from this partition cannot be performed successfully.

For more detailed information please refer to Parallels Transporter User Guide, a PDF file that can be found in the Applications/Parallels folder.
Troubleshooting and Limitations

This chapter describes how to troubleshoot known issues.

In This Chapter

Getting Technical Support ............................................................... 259
Reporting a Problem to Parallels Team ............................................. 260
Installing Ubuntu Linux 6.0.6 Server .............................................. 261

Getting Technical Support

If you have problems using Parallels Desktop, please first view Parallels Desktop FAQs http://www.parallels.com/en/support/faq/

Our friendly technical support team is ready to help. Describe your problem and submit a FREE support request to Parallels support team (www.parallels.com/en/support/).

To discuss your problem online, visit Parallels Forum (http://forums.parallels.com/).

Telephone support is available on a per incident fee basis. For more information please visit the web page of Parallels support team (www.parallels.com/en/support/).
Reporting a Problem to Parallels Team

To help improve the quality of Parallels Desktop, you may send problem reports to Parallels Software International Inc. In the case of a fatal error inside a virtual machine, Parallels Desktop automatically opens the Report a Problem window prompting user to send a report. You may also send a report on your own if you notice incorrect virtual machine behavior.

Automatically Generated Reports

When a fatal error occurs in a virtual machine, Parallels Desktop automatically generates a virtual machine status report and attaches a console screen shot to it. After that, the Report a Problem window opens, and you can fill out the form and send the report to Parallels Software International, Inc. The Report a Problem window contains the following elements.
The Technical data field shows the name of the .txt status report file that has been generated for the error. The status report holds information on the product version, product activation data, primary and guest OSes information, processor status, and so on. You can update the data if necessary. Click View to open the report in the text editor.

The Session screenshot field holds the name of the session screenshot (in .png format). To view the screenshot click the View button.

You may add a short description of the error situation in the Problem description box (the description will be added to the report text file when you click the OK button).

To send the report to the Parallels corporation:

1. Click the OK button in the Report a Problem window.
2. Launch your e-mail client application, create a new letter and attach two files to it: status report and the session screenshot. They are located in the following folder:
   /Library/Parallels/bugreports/
   and named as follows:
   parallels-yyyy.mm.dd-hh.mm.ss.<txt/png>
3. Send the e-mail to the following address:
   reports@parallels.com

Creating a Report Manually

If you notice an unusual virtual machine behavior, create a problem report. For this, select Report a Problem in the Help menu. Parallels Desktop generates a report which contains technical data collected at the moment when the Report a problem command was invoked. If a guest OS was running at the moment, screenshot of the guest OS window was made.

To send the report follow the above instruction.

### Installing Ubuntu Linux 6.0.6 Server

Ubuntu Linux 6.0.6 Server when installed in a virtual machine in a standard way can not load the default kernel. You have to perform some additional steps after the guest OS installation is complete.

Perform an initial installation of Ubuntu Linux 6.0.6 Server in a virtual machine, follow these steps:

1. With OS Installation Assistant create a typical virtual machine with Linux as the OS Type and Other Linux Kernel 2.6 or Debian Linux as the OS Version.
2. Insert the installation CD/DVD in the default CD/DVD-ROM drive, or connect its image to the virtual machine.
3. Install the Ubuntu Linux 6.0.6 Server. Do not disconnect the installation CD/DVD or its' image!
4. Shut down the virtual machine.
Additional steps include the following:

1. In Configuration Editor on the Options -> Booting Options tab, set the boot sequence to [CD-ROM, Hard Disk, Floppy]. On the Network Adapter Options tab set the adapter to the Bridged Ethernet mode. Click OK to close Configuration Editor.

2. Start up the Ubuntu virtual machine. It will boot from the CD/DVD or its image. At the prompt enter the following command:
   ```
   rescue
   ```
   Select language of communication, enter host name to configure network when prompted. Wait until kernel components are loading...

3. In the Enter rescue mode dialog select the option: `/dev/discs/disco/part1` (root file system). In case you used for disk partitioning and formatting other than default options, select an option for the partition with root file system.

4. Then on the same dialog, select the option: `execute a shell in /dev/discs/disco/part1`. When prompted, click Continue to confirm the operation.

5. At the shell prompt enter the following command:
   ```
   apt-get install linux-686
   ```

6. Wait while 686 kernel is being installed. When it is finished, to exit the shell prompt enter the following command:
   ```
   exit
   ```

7. In the Enter rescue mode dialog select the option: `reboot the system` and stop the virtual machine.

8. Disconnect the installation CD/DVD from your virtual machine. Open Configuration Editor and set the boot sequence to [Hard Disk, CD-ROM, Floppy] to let the virtual machine to boot from the virtual hard disk.

9. Start the virtual machine. After booting is complete, log in Ubuntu Linux 6.0.6 Server.
Index

A
Acceleration level • 158
Accessing shared folders • 201
Activating Parallels Desktop • 30
Adapter
  Network adapter • 121, 152, 190, 209
  Parallels Network adapter • 85, 88, 93
  Realtek driver • 85, 88, 209
  RTL8029 adapter • 85, 88, 93, 95
Adding
  CD/DVD-ROM drive • 187
  custom screen resolution, adding • 202, 203
  favorite Windows application icon to the
    Dock • 101, 109
  hard disk • 183
  hardware devices • 182, 183
  network adapter, adding • 190
  parallel port • 195
  Parallels Desktop icon to the Dock • 29
  serial port • 193
  shared folder • 200
  USB controller • 198
Address
  IP address • 152, 209
  MAC address • 175, 190
  MAC address in a cloned virtual machine • 224
Administrator passwords • 58
Alias
  for custom virtual machine, creating • 67
  for favorite Windows application • 101, 109
  for Parallels Desktop, creating • 29
  for typical virtual machine, creating • 62
  for virtual machines, creating • 40
  using aliases for virtual machines • 101
Animation
  animation speed, setting • 213
  Animation tab • 213
  modes • 213
  om snapshot actions • 213
  on switching to Coherence • 142, 213
  on switching to full screen • 107, 213
  when suspending and resuming • 213
Appearance tab • 211
Application Switcher • 139
Assistant
  Add Hardware Assistant • 182
  Clone Virtual Machine Assistant • 224
  Delete Virtual Machine Assistant • 227
  OS Installation Assistant • 57, 75, 78, 252, 261
  Automatic update check • 33
B
Backing up virtual machines • 230
Bonjour
  setting up a Bonjour printer • 135
Boot Camp
  Boot Camp option • 20
  booting via Boot Camp • 255
  booting via virtual machine • 255
  creating virtual machine for • 252
  custom configuration • 251
  using Boot Camp partition • 250
  Boot sequence, changing • 75, 78, 157
  Bridged Ethernet networking • 152, 153, 175
  Browsing virtual machines • 218
C
Capturing keyboard and mouse • 83
CD/DVD-ROM drive
  adding a CD/DVD-ROM drive • 187
  CD/DVD-ROM drive options • 173
  connecting a CD/DVD-ROM drive • 127
Changing
  administrator password • 58
  configuration at runtime • 126
  default folder for virtual machines • 206
  icon set of the toolbar • 112
  media, changing • 126
  screen resolution (Linux) • 203
  screen resolution (Windows) • 202
  toolbar position • 45
Clipboard Syncronization Tool • 116
  installing clipboard synchronization tool
    (OS/2) • 95
  installing clipboard syncronization tool
    (eComStation) • 93
Cloning virtual machine • 224
  Coherence mode • 138
animation on switching to • 142, 213
Application Switcher • 139
Coherence, options • 142, 161
SmartSelect • 139
switching to Coherence • 108
Coherence tool • 125
Compacting virtual hard disks • 230, 231
Compressing virtual hard disks • 235
Compression
  automatic compression • 241
  compression levels • 240
  compression options • 237
Compressor • 230, 233
  compressing procedure • 234
  compression levels • 240
  preparing to run • 235
  running automatically • 241
  running modes • 238
Configuration Editor • 42, 48, 155
Configuration of a virtual machine
  creating virtual machine configuration • 40, 42, 44, 56
  definition • 17
  editing • 155
Configuration Page • 40, 42, 48, 155
Configuring
  Mighty Mouse, configuring • 151
  virtual machines, configuring • 55
  X Window System in FreeBSD • 81
Connecting
  CD/DVD-ROM drive, connecting • 127
  CD/DVD-ROM image, connecting • 173
  floppy disk drive, connecting • 128
  microphone (USB) • 131
  network adapter, connecting • 128
  parallel port, connecting • 129
  printer via parallel port • 132
  serial port, connecting • 129
  sound device, connecting • 130
  USB device, connecting • 131
Converting
  third-party images • 257
CPU
  emulated in virtual machine • 14
  required on host computer • 23
Creating
  custom virtual machine • 67
  floppy disk images • 217
  typical virtual machine • 62
  virtual hard disks • 170
  virtual machine • 53
  virtual machine in Boot Camp • 252
Custom Boot Camp configuration • 252
Custom virtual machine • 67
Customizing views • 111
D
Data disk (Boot Camp partition) • 250
Default appearance • 213
Default folder for virtual machines storage • 206
default key combinations • 214
Deleting virtual machines • 227
Devices
  adding to virtual machine • 182
  configuring virtual machine • 155
  connecting and disconnecting at runtime • 126
  emulated in virtual machine • 14
DHCP scope • 209
Directory • 62, 67, 206
  default directory for virtual machines • 62, 67, 156, 206
  for cloned virtual machine • 224
  for custom virtual machine • 67
DirectX support enabling • 165
Disabling Parallels Tool Center • 115
Disconnecting
  CD/DVD-ROM drive • 127
  floppy disk drive • 128
  network adapter • 128
  parallel port • 129
  serial port • 129
  sound device • 130
  USB devices • 131
Disk Compacting Tool • 85, 122, 230, 231
Disk format, checking • 19
Disk formats • 19
Disk size, reducing • 249
Dock
  adding favorite Windows application icon to • 101, 109
  adding Parallels Desktop icon to • 29
  viewing from guest OS • 109
Dragging files
  between OSes • 138
DVD-ROM drive
  connecting DVD-ROM drive at runtime • 127
  virtual machine configuration • 173
E
eComStation
installing network driver • 93
installing Parallels Tools • 93
installing sound driver • 93
supported versions • 17
tools • 95
Editing virtual machine configuration • 155
Expanding disks • 19
Exploring virtual machines • 218
Express mode (Parallels Compressor) • 238
Ext2/Ext3 • 257

F
Favorite Windows Applications • 49, 101, 109
creating aliases for • 101, 109
keeping icon in the Dock • 101, 109
starting from Mac OS X • 101
Favorite Applications Tool • 85, 124
FDD • 17, 21
Files
  PVS file • 17
  report with technical data • 260
  SAV file • 17, 105
  screenshot • 52, 260
  sharing files • 200
  snapshot files • 17
  virtual machine files • 17
Flags
  emulation flags • 158
  Exit application on VM shutdown • 157
  Start VM automatically when it is open • 157
Floppy disk drive
  connecting floppy disk drive • 128
  floppy disk options • 168
Floppy disk image • 17, 21, 75, 78
  connecting floppy disk images • 128
  creating a blank floppy disk image • 21, 168, 182
  creating images of real floppy disks • 21, 217
  floppy disk images used by virtual machine • 17, 21
  installing from floppy disk images • 74
FreeBSD
  configuring X Window System • 81
  printing in FreeBSD • 133
  supported versions • 17
Full screen mode
  animation on switching to • 107, 213
  options • 211, 213, 214
  switching to • 107, 213, 214

G
General tab • 206
Getting support • 259
Global file sharing • 200
Guest operating system • 8
  Custom installation • 67
  installing guest operating systems • 74
  supported guest operating systems • 15
  Typical installation • 62
  Windows Express installation • 58

H
Hard disk
  adding hard disk • 187
  compacting hard disk • 122, 231
  connection options • 172
  formats of virtual hard disks • 19
  hard disks in virtual machine • 170
  supported types of hard disks • 19
Hard disk image
  creating new empty hard disk image • 170, 182
  expanding hard disk image • 19
  file type and format of a hard disk image • 19
  plain hard disk image • 19
Hardware Assistant • 182
HDD • 17, 19
Help menu • 11
Hidden messages • 211
Hiding the toolbar • 45
Host computer
  hardware requirements • 23
  software requirements • 23
Host-only networking • 154
Hot keys • 214, 219

I
IDE devices in virtual machine
  CD/DVD-ROM • 173
  hard disks • 170
Installation
  custom installation • 67
  typical installation • 62
  Windows Express installation • 58
Installing
AC’97 sound driver • 89, 90, 92
Clipboard Syncronization Tool (OS/2 and eComStation) • 93
guest operating system • 74
Mouse Syncronization Tool (OS/2 and eComStation) • 93
network driver (OS/2 and eComStation) • 93
network driver (Solaris) • 95
Parallels Desktop • 24
Parallels Tools • 84
sound driver (OS/2 and eComStation) • 93
video driver (Windows 98) • 90
video driver (Windows NT) • 92
Windows 98 • 78
Windows XP • 58
Intel Virtualization Technology (VT-x) • 14
Interface basics • 39
Internet access • 152
IP addresses • 154, 209
ISO images of CD/DVD discs • 17, 20
connecting an ISO Image • 20, 173
ISO images used by virtual machine • 20, 74

J
JFS (Parallels Transporter) • 257

K
Key combinations • 214
Keyboard
capturing and releasing in virtual machine • 83
shortcuts • 214, 219
Keyboard tab • 214

L
Linux
changing in Linux • 203
Parallels Tools for • 90
printing in Linux • 136
supported versions • 15
Linux SWAP (Parallels Transporter) • 257
Local file sharing • 200

M
MAC address
in cloned virtual machine • 224
in virtual machine • 175
Maintaining virtual hard disks • 230
Making screen shots • 52
Making snapshots • 144
Media, changing • 126
Memory
in virtual machine • 14, 166, 208
limit for all virtual machines • 208
required on host computer • 23
video memory • 107, 168
Memory allocation • 208
Memory options • 166
Memory tab • 208
Microphone (USB), connecting • 198
Mighty Mouse • 151
Migration (Transporter) • 258
Mouse • 151
capturing in virtual machine • 83
releasing from virtual machine • 83
Right-click options • 151, 214
synchronization between primary OS and guest OS • 85, 120
Mouse Syncronization Tool • 120
installing (eComStation) • 93
installing (OS/2) • 93
MS-DOS, supported versions • 15
Multi-user access • 222

N
NAT • 153
Network adapter
adding a network adapter • 190
connecting to virtual machine • 128, 175
in virtual machine • 14, 175, 209
network adapter options • 175
Network Drivers, Parallels Tools • 85
Parallels Host-Guest • 154
Network driver
installing (eComStation) • 93
installing (OS/2) • 93
network driver options • 121
Network printer • 136
Network tab • 209
Networking
Bridged Ethernet • 153, 175, 190
Host-only • 154
Shared Networking (NAT) • 153, 175, 209
NTFS (Parallels Transporter) • 257

O
Opening
Configuration Editor • 48
virtual machines • 100
Operating system
guest OS • 8, 23, 53
installing in virtual machine • 56, 57, 75
primary OS • 8
requirements to primary OS • 23
supported guest OSes • 15
Options
Adjust reserved memory • 208
Change Mac OS X resolution in Dock • 107, 202, 211
Connect USB devices automatically • 181
Default folder for virtual machines • 206
Enable Intel VT-x support • 14, 50, 158
Full Screen transition • 107, 213
OS Window transition • 44, 213
Show applications in Dock • 101, 211
OS Installation Assistant • 56
OS Window mode • 44
OS/2
installing Parallels Tools (OS/2) • 93
installing sound driver (OS/2) • 93
supported versions • 15
P
Parallel port
adding a parallel port • 195
connecting a parallel port • 129
parallel port options • 178
Parallels Compressor • 230, 233
compressing procedure • 234
compression levels • 240
preparing to run • 235
running automatically • 241
running modes • 238
Parallels Desktop
activating Parallels Desktop • 30
installing Parallels Desktop • 24
Parallels Desktop menus • 49
Parallels Desktop toolbar • 45
Preferences, setting • 205
starting Parallels Desktop • 29
uninstalling Parallels Desktop • 37
updating Parallels Desktop • 32
Parallels Desktop menu
viewing from guest OS • 109
Parallels Explorer • 218
Parallels Network adapter • 85, 88, 93
Parallels Tools
for OS/2 and eComStation • 93
for Solaris • 95
for Windows 98 • 90
for Windows NT • 92
installing in Linux • 90
installing in Windows • 89
installing Parallels Tools • 56, 57, 58, 84, 85, 89
overview • 85
uninstalling in Linux • 97
uninstalling in Windows • 96
updating • 97
Parallels Tools Center • 115
disabling • 115
restarting • 115
Parallels Transporter
migrating from remote computer • 257
migration scenarios • 257
setting up the environment • 258
Partition
Boot Camp partition • 20, 250
Passwords • 58
Pause virtual machine • 106, 205
Plain disks • 19
Preferences • 205
Preferences for Parallels Desktop • 101, 105, 107, 108, 205
Animation tab • 213
Appearance tab • 211
General tab • 206
Keyboard tab • 214
Memory tab • 208
Network tab • 209
setting up Preferences • 205
Primary operating system • 8
definition • 8
supported primary OSes • 23
Printer
setting up a Bonjour printer • 135
setting up a network printer • 231
setting up a printer in virtual machine • 133
setting up a printer via parallel port • 134
sharing Mac printer • 134
Printing
printing in FreeBSD • 136
printing in Linux • 136
printing in Windows • 136
printing with Bonjour • 135
using parallel port • 132
Processor
emulated in virtual machine • 14
required on host computer • 23
PVS file • 17
Q
Quick install, Windows Vista or Windows XP • 58
R
RAM
in virtual machine • 14, 166
limit for all virtual machines • 208
required on host computer • 23
RAM allocation for Parallels Desktop • 208
RAM options for virtual machines • 166
Reducing disk size • 249
Reiser4 • 257
ReiserFS • 257
Releasing keyboard and mouse • 83
Remapping keys • 214
Removing
  removing devices • 199
  Windows applications from Favorites • 101
Reporting problems • 260
Resetting virtual machines • 104
Resolution Changing Tool • 85
Restore hidden messages • 211
Resuming virtual machines • 105
Right-click options • 151, 214
RTL8029 • 85
Running
  Parallels Compressor automatically • 241
  virtual machines • 99
Running modes (Parallels Compressor) • 238
Runtime, changing configuration at • 126

S
SAV file • 17, 105
Screen animations • 213
Screen resolutions
  adding in Linux • 203
  adding in Windows • 202
  changing in Linux • 203
  changing in Windows • 202
  custom screen resolutions • 202
Screen shots
  for bug reports • 260
  of guest operating system screen • 52
Security options • 160
Selecting disks for compression • 239
Serial port
  adding a serial port • 193
  connecting a serial port • 129
  serial port options • 179
Setting preferences • 205
Shared Folders
  accessing shared folders • 201
  setting up shared folders • 200
  shared folders options • 163
  using shared folders • 200
  viewing in guest OS • 201
Shared Folders Tool • 85
Shared networking (NAT) • 153
Shared web applications • 206
Sharing files • 200
Shortcuts
  in virtual machine • 219
  Mac OS shortcuts in virtual machine • 219
Showing toolbar • 45
Shutting down virtual machine • 104
SmartSelect • 139
Snapshot manager • 147
Snapshots
  making • 146
  managing • 147
  reverting to the last • 149
  Snapshots, working with • 144
Socket • 179
Solaris network driver • 95
Sound device
  connecting sound device • 130
  disconnecting sound device • 130
Sound driver, Parallels Tool • 85
  installing sound driver (eComStation) • 93
  installing sound driver (OS/2) • 93
  installing sound driver (Windows 98) • 90
  installing sound driver (Windows NT) • 92
Sound options • 180
Split disks • 19
Starting
  favorites in Mac OS • 101
  Parallels Desktop • 29
    virtual machine • 102
Startup mode • 157
Startup options • 40, 101, 206
Status bar
  connecting devices to a running VM • 126
  general description • 47
  hiding • 40, 47
Stopping virtual machines • 104
Sun Solaris, supported versions • 15
Support • 259
Supported guest operating systems • 15
Suspending virtual machines • 105
Switching to Coherence mode • 108
Switching to Full Screen mode • 107
Switching views • 111
System requirements • 22

T
Technical overview • 13
Technical support • 259
Third-party images, converting • 257
Time synchronization between guest OS and primary OS • 85, 117
Toolbar • 40
  changing the icon set of • 45, 112
  changing the position of • 45
  hiding the toolbar • 45
  showing the toolbar • 45
Transporter • 9, 256
Troubleshooting • 259
Turn off virtual machine • 45, 104
Typical virtual machines
configuration of typical virtual machines • 55
creating typical virtual machines • 62

U
Undo Disks • 158
options • 158
working with • 150
Uninstalling Parallels Desktop • 37
Uninstalling Parallels Tools • 96
Update check, automatic • 33
Updating Parallels Desktop • 32
automatically • 33
manually • 35
Updating Parallels Tools • 97
USB
adding a USB controller • 198
connecting USB devices • 131
connecting USB microphone • 131
setting up a USB printer • 135
USB options • 181
using USB devices in virtual machine • 133

V
Video driver, options • 119
Video driver, Parallels Tools • 85, 119
Video memory • 166
Virtual hard disk
compacting • 231
creating new empty virtual hard disk • 170
device geometry • 172
disk formats • 19
expanding virtual hard disk • 19
file type of virtual hard disks • 19
hard disk in Virtual Machine • 170
maintaining hard disks • 230
optimization • 172
plain virtual HD • 19
selecting hard disks for compression • 239
Undo Disks option • 150
Virtual machine
creating new devices • 182
aliases for • 101
backing up • 230
booting from Boot Camp • 255
cloning virtual machines • 224
description • 17
creating virtual machines • 53
deleting virtual machines • 227
description • 40, 100, 156
editing device options • 155
exploring • 218
folder for storing • 206
making snapshots • 144
managing virtual machines • 205
multi-user access to • 222
name • 40, 62, 67, 156
networking in • 152
opening • 100
pausing • 106
resetting • 104
resuming • 105
saving state of • 144
shutting down • 104
starting • 102
suspending • 105
typical configurations • 55
using mouse • 151
using USB devices • 133
virtual machine files • 17
virtual machines • 99
Virtual machine technology overview • 13
VT-x support • 14, 51, 158

W
Web applications, sharing • 206
Windows
applications • 101
changing resolution • 202
Express Installation • 58
printing in Windows • 136
supported versions • 15
Windows 98
installing AC97 sound driver • 90
installing video driver (Windows 98) • 90
installing Windows 98 • 78
Windows applications
adding to Dock • 101
adding to Favorites • 101
Coherence mode • 138
Parallels Tools for • 89
removing from Favorites • 101
SmartSelect • 139
Windows NT
installing Parallels Tools (Windows NT) • 92
Windows taskbar
  in Coherence mode • 142
Windows Vista
  creating virtual machine in Boot Camp • 252
  Express Installation • 58
  User Account Control (UAC) feature • 109
Windows XP
  creating virtual machine in Boot Camp • 252
  Express Installation • 58
  using from Boot Camp • 250
X
  X Window System in FreeBSD • 81
  XFS (Parallels Transporter) • 257